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The following documentation updates have been made since the last release of 
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Chapter 1: Overview and Installation 
 

This section contains the following topics: 

Database Design Overview (see page 13) 

Overview (see page 13) 

Before You Install (see page 14) 

Install CA ERwin Data Modeler (see page 15) 
 

Database Design Overview 

Welcome to CA ERwin Data Modeler (CA ERwin DM), the database design tool 

that raises the level of data quality in transactional and data warehouse systems. 

It provides the tools to design and implement databases for transactional 

business, E-commerce, and data warehousing applications. 

You can create and maintain graphical models that represent databases, data 

warehouses, and enterprise data models. CA ERwin DM provides a modeling 

platform where corporate data requirements and related database designs can 

be defined, managed, and implemented across a wide variety of database 

platforms. 
 

A Windows-based graphical user interface is combined with powerful 

entity-relationship (ER) diagramming tools, custom editors to define physical 

database objects, a Model Explorer for a text-based view of model objects, and 

support for the leading SQL and desktop databases. 

Additionally you can use this product to streamline the application development 

process, by allowing different groups (Standards Administrators, Business 

Analysts, Data Modelers, and so on) to perform work independently, while 

collaborating and synchronizing. In this way, different groups can simultaneously 

work on various parts of a model or different model types. 
 

Overview 

CA ERwin DM combines a Windows-based graphical user interface with 

entity-relationship (ER) diagramming tools, and numerous innovative features. 

These features allow you to easily create and maintain your relational database 

and the logical and physical models that describe it. CA ERwin DM works by 

providing a design solution that helps you create a visual blueprint (a data 

model) for your organization. 
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CA ERwin DM is much more than a drawing tool. It not only helps you design a 

logical data model, which captures business rules and requirements, it supports 

the design of a corresponding physical data model for your target server. This 

enables you to forward engineer this physical data model and automatically 

generate physical database structures to your system catalog. 
 

CA ERwin DM supports reverse engineering of existing databases and provides 

both a physical and logical/physical data model so you can maintain an existing 

database, or migrate from your current target server to a different one. 
 

The Complete Compare technology automates model and database 

synchronization by letting you compare the model with the database, displaying, 

and analyzing the differences. This enables you to selectively move the 

differences into the model or generate them into the database. 

 
 

Before You Install 

Review the hardware and software requirements and the list of supported target 

databases in the Release Notes file before you begin the installation. 

Administrative Privileges Required for Installation 

Because the installation process for CA ERwin Data Modeler writes to the registry 

and system folders, the person installing, upgrading, or removing CA ERwin Data 

Modeler must have Administrative privileges. If you run an install without 

Administrative privileges, all files may not be installed or upgraded, and users 

will encounter problems when running the software. 
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Install CA ERwin Data Modeler 

The Installation Wizard makes it easy for you to install, change, or remove CA 

ERwin Data Modeler. 

To install CA ERwin Data Modeler 

1. Insert the installation DVD or double-click the file you downloaded from the 

online CA product page. 

The Installation Wizard opens. 

2. Follow the prompts in the wizard to proceed. If you install from the DVD, you 

are prompted to select the applications you wish to change or install. Click 

Next. 

A License Agreement opens for you to review. 
 

3. Select the option to accept the terms as described in the License Agreement. 

Click Next. 

The wizard asks a series of questions you must answer, including: 

■ Customer Information 

■ Destination folder for the CA ERwin DM files 

4. On the Custom Setup Type screen, review the program features that will be 

installed. You can also evaluate the space needed to install each feature.  

Click Next to continue and then click Install to start the installation. 

The program files are copied.  
 

If you have not already licensed CA ERwin Data Modeler, you can license the 

program when the install process is complete. Follow the on-screen prompts 

to open the License Verification dialog and enter the license key provided 

with the product CD. 
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Chapter 2: Basic Concepts and Features 
 

This section contains the following topics: 

The Application Development Cycle (see page 17) 

Basic Data Modeling Concepts (see page 17) 

Create a Model (see page 25) 

Enhance Your Data Model (see page 29) 

Print a Data Model (see page 36) 
 

The Application Development Cycle 

Most data modeling solutions begin with the gathering of business rules and 

creating logical constructs and continues to the physical design phase followed 

by the implementation of a database that supports one or more applications. CA 

ERwin DM supports this iterative process by supporting multiple platforms, reuse 

of objects, and the ability to synchronize changes between data models across 

the enterprise. 
 

Basic Data Modeling Concepts 

Before creating or working with data models, there are some basic data modeling 

concepts with which you should be familiar. These concepts include: 

■ Model Types 

■ Entities 

■ Tables 

■ Attributes and Columns 

■ Primary Key 

■ Relationships 

■ Foreign Key 
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Model Types 

Multiple model types allow data modelers or data analysts to work with the 

models best suited for their needs. The following model types are available: 

Logical 

A conceptual model that contains objects such as entities, attributes, and key 

groups. 

Physical 

A database-specific model that contains objects such as tables columns and 

datatypes. 

 

Logical/Physical 

A single model that includes both the logical and physical models. 
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Entities 

An entity is a logical object that represents a person, place, or thing about which 

an organization maintains information.  

In the following diagram, the logical data model has the following entities: 

■ CUSTOMER 

■ EMPLOYEE 

■ MOVIE 

■ MOVIE COPY 

■ MOVIE RENTAL RECORD 

■ PAYMENT 

■ STORE 
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Tables 

In the logical model, an entity usually corresponds to a table in the physical 

model. In the physical model, a graphic box represents a table in which data is 

stored in the database. 

 
 

Types of Entities/Tables 

Two types of entities/tables can be drawn in a data model: 

Independent Entity 

An entity whose instances can be uniquely identified without determining its 

relationship to another entity. It is represented as a box with square corners. 

Dependent Entity 

An entity whose instances cannot be uniquely identified without determining its 

relationship to another entity or entities. It is represented as a box with rounded 

corners. 
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When you add an entity, the entity type is determined based on the relationship 

in which it is involved. For example, when you initially place an entity in a model, 

it is represented as an independent entity. When you connect the entity to 

another entity using a relationship, it is determined if the entity is independent or 

dependent based on the relationship type. 
 

Attributes and Columns 

After you have discovered the people, places, and events that define the entities 

in your model, you can begin to define the attributes for each entity. 

Attributes collect information about an entity and columns collect information 

about a table. Logical attributes usually correspond to physical columns in a 

table. 
 

For example, after you create the CUSTOMER entity, you can begin to define the 

individual pieces of information you want to track for each customer, including 

Name, Address, and Phone Number. In the logical model, each of these pieces of 

information is saved as an attribute of the CUSTOMER entity. In the physical 

model, attributes equate to columns in a table. 

 

Note: A row of data is inserted in a table when a record is added to the database 

directly or through an application. 
 

After you create an entity or table, you can add attributes and columns, 

respectively. 

Many easy methods for creating and modifying the properties of these objects 

are provided. The most basic method is to add the name directly in the Diagram 

Window. You can also use a domain to add attributes and columns. 
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Primary Key and Non-Keys 

Entities and tables are drawn as a box with a horizontal line near the top of the 

box. 

The area above the horizontal line is known as the key area because that is where 

the entity's primary key resides. The primary key can be comprised of one or 

more attributes that uniquely identify the entity. 
 

The area below the horizontal line is known as the non-key area because that is 

where all other attributes reside. 

 

Note: A foreign key may appear in either the primary key or the non-key area of 

an entity or table. For more information about foreign keys, see the section 

Foreign Key in this chapter. 
 

Foreign Key 

When you create a relationship between entities, the primary key attributes of 

the parent entity are automatically migrated to the child entity. The designator 

(FK) indicates the name of the migrated key attribute, also known as a foreign 

key. This migration occurs automatically in the physical model. 
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If the foreign key attribute has the same name as an owned attribute in the child 

entity, the two instances are automatically unified into one attribute because it 

assumes that they are the same attribute. The process of combining or unifying 

identical attributes in an entity is called unification. 

Note: The foreign keys display in the physical model by default. To see the 

foreign keys in the logical model, choose Entity Display from the Format menu 

and check the options Show Migrated Attributes and Foreign Key Designator 

(FK). 
 

Relationships 

An important object in a data model is the relationship, which is represented by 

the solid or dashed line that connects two entities or two tables. A relationship 

line connects a parent and a child entity or table. Usually, a symbol appears at 

the child-end of the relationship line. The symbol changes based on the diagram 

notation that you select. 
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Types of Relationships 

Relationships are important because the type of relationship determines how a 

primary key of the parent entity or table migrates to the child entity or table as 

a foreign key. There are two basic types of relationships: 

Identifying Relationship 

An identifying relationship is represented by a solid line and through it the 

primary key of the parent migrates to the primary key area of the child entity 

or table. 

Non-Identifying Relationship 

A non-identifying relationship is represented by a dashed line and through it 

the primary key of the parent migrates to the non-key area of the child entity 

or table. 
 

In an identifying relationship, the foreign key migrates above the line and 

becomes part of the primary key of the child entity (see the Foreign Key section 

of this chapter for more information). In a non-identifying relationship, the 

foreign key migrates below the line and becomes a non-key attribute in the child 

entity. A dashed line represents a non-identifying relationship. 

 

Note: If you want a non-key to migrate instead of the primary key, you can use 

the alternate key migration option. For more information, see the online help. 
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Create a Model 

Now that you have a basic understanding of the workplace and the concepts 

associated with data modeling, you can begin creating a model. 

To create a model 

1. Click New on the File menu. 

The Create Model - Select Template dialog opens. 
 

2. Click Logical/Physical in the New Model Type group box, and select a 

template and target database. Click OK. 

A new Diagram Window opens. 
 

Name Your Model 

When you create a new data model, you should also create a name, or title, for 

the model. This name is used throughout the Design Layer features to identify 

the model by name. If you do not change it, by default “model_n” displays for all 

models. For example, the first model is named “model_1”, the second model is 

named “model_2” and so on. 

To name your model 

1. Click Model Properties on the Model menu. 

The Model Property dialog opens. 
 

2. Enter the name you want to give the model on the General tab. You can also 

add the author's name in the Author field. 

3. Click OK. 

The Model Property dialog closes. 

Note: You can also enable Modeling Features and select Transform Options in 

this dialog. 
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Add Entities 

In the logical model, you can add entities using the ERwin toolbox.  

To add entities 

1. Click the Entity tool in the toolbox. 

The cursor changes from an arrow to the entity symbol. 

2. Click anywhere in the Diagram Window to place the first entity. By default, 

this entity is named E/1. 

Repeat Steps 1 and 2 to create as many entities as needed; they are named 

E/2, E/3 and so on. 
 

3. Click Save As on the File menu to save your model. 

The Save As dialog opens. 
 

4. Enter a name for the model and click Save. 

The model is saved with the .erwin file extension, and the Save As dialog 

closes. 

Note: The entities that you created in the Diagram Window also appear in the 

Model Explorer and Action Log because all three areas of the workplace are 

automatically synchronized. 
 

Edit an Entity Name 

You can edit an entity name by typing directly in the Diagram Window. 

To edit an entity name 

1. In the Diagram Window, click on the entity named E/1. Wait briefly, then 

click again. 

An edit box appears around the name. 
 

2. Enter CUSTOMER over the default entity name and click once outside of the 

edit box. 

The entity is renamed. 
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The entity is renamed. 

Note: You can also edit an entity name in the Model Explorer when you select 

and right-click the entity name. 
 

Add Attributes 

You can add attributes to the entities directly in the Diagram Window.  

To add attributes 

1. In the Diagram Window, click an entity box and press Tab. 

An edit box opens below the entity name with the default name, 

attribute_name. 

 
 

2. Enter the attribute name directly over the default name and click outside of 

the edit box. 

The attribute is added. 

Note: To add another primary key, before clicking outside the edit box, press 

Enter and the edit box opens above the line in the entity. To add a non-key, 

press Tab and the edit box opens below the line in the entity. 
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Create Relationships 

In the following exercise, we will add two relationships: 

■ An identifying relationship between a parent and child entity 

■ A non-identifying relationship between the entities ORDER and PRODUCT 

To create relationships 

1. Click the Identifying Relationship tool in the toolbox. 

The cursor changes from the arrow symbol to the identifying relationship 

symbol. 

2. Click the parent entity to begin setting an identifying relationship between 

the parent and child entity in the Diagram Window. 

3. Click the child entity. 

A highlighted relationship line connects the two entities. 

Note: The relationship line is temporarily highlighted to make it easier to 

view the relationship. The relationship line is highlighted as you create it, or 

any time you select it. 
 

When finished, your model should look similar to the following example: 

 

4. Click the Non-identifying relationship tool in the toolbox. 

The cursor changes from the arrow symbol to the non-identifying 

relationship symbol. 
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5. Click the parent entity and then click the child entity to add a non-identifying 

relationship between them. 

When finished, your model should look similar to the following example: 

 
 

Save Your Model 

To save the changes you made to your model, click Save on the File menu. You 

can open the file again later for editing. 
 

Enhance Your Data Model 

When you design a data model, you can use many of the drawing features to 

enhance its appearance and make it easier to view and understand. 

To prepare a diagram for analysis and presentation, you can: 

■ Enlarge the font size for all entity names so that they are easier to read. 

■ Change the color of all foreign keys to red, so that they are distinguishable 

from other attributes or columns. 

■ Use different fonts and colors to identify new objects from old objects in your 

model. 

■ Resize one or more entity boxes 

■ Align two or more entity boxes 
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Graphic Features 

A diagram has several types of graphic elements that you can enhance with 

color. For example, you can specify text, fill, and line sizes and colors for entities, 

attributes and relationships. 

In addition to these graphic elements, there are many object types that you can 

change globally such as Foreign Keys, Entity Names, and Owned Keys. 

 
 

Customize Object Fonts and Colors 

When you add an object to a diagram, the default font and color for that object 

type is automatically assigned. Use the following procedure to customize the 

default fonts and colors for the objects you create. 

To customize object fonts and colors 

1. Click Default Fonts & Colors on the Format menu. 

The Default Fonts & Colors dialog opens. 
 

2. Navigate the tabs on the dialog to set default color and font information. You 

can also specify font and color properties for all model objects, new objects 

you create, or current objects in the model. 

Note: The tabs that appear vary depending on whether you are working with 

a logical, physical, or logical/physical model. 

Click OK. 

The new default settings are saved and the dialog closes. 
 



Enhance Your Data Model 

 

Chapter 2: Basic Concepts and Features  31  

 

Font and Color Change for Individual Objects 

You can also change the color or font of individual objects in your diagram in the 

following ways: 

■ Select the object, then click an option in the Font and Color Toolbar 

■ Select the object, then right-click and select Object Font & Color on the 

shortcut menu. 
 

Objects Can Inherit Color 

The color of an object can be related to the color it inherits from other objects in 

the diagram. For example, you can choose to have a foreign key attribute or 

column, inherit its font and color from its parent primary key or relationship. 

 

You can also change the color of foreign key columns or attributes so that you 

can easily identify them from owned primary key columns or attributes. 
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Add a Text Block 

You can add text blocks to a diagram to identify or clarify model elements. Text 

blocks can include any text you choose including diagram version numbers, 

notes, titles, and captions. You can add consecutive multiple text blocks by 

pressing the CTRL key before you click the text block tool. When you click again 

in the diagram window, another text block is created. If you add text blocks this 

way, you first create multiple empty text areas and then must return to each text 

area to enter the text. 

To add a text block 

1. Click the Text icon on the Drawing Objects toolbar. 

The cursor changes from the arrow symbol to the text symbol. 

2. Click the diagram window where you want the text block to appear. 

A new text block is created. 
 

3. Type the text that you want to appear in the text box, and click the diagram 

window outside the text block. 

The text block closes and your changes are saved. 

Note: You can press Tab to include tabs in the text. You can also press Enter to 

include line breaks in the text. In addition, you can copy and paste text in text 

blocks. 
 

Resize a Box 

To enhance the appearance of your data model, you can make all of the entity, 

table, or view boxes uniform in size. You can also emphasize one or two boxes by 

making them larger than the others, or resize any box to meet your presentation 

requirements. 
 

Note: Click Preferences on the Format menu to change the default for this 

option. You can select or clear the Allow manual resize check box on the Layout 

tab of the Format Preferences dialog for this feature. 
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To resize a box 

1. Use the Select tool, and click near the border of the box that you want to 

resize. 

The resize handles appear. 

2. Move the Select tool until you see the cursor shape change into a two-sided 

arrow. 

 
 

Hold down the mouse button and grab the resize handle. Move the cursor to 

adjust the height or width of the box. 

Release the mouse button when you are satisfied with the new dimensions of 

the box. 

The box is resized. 
 

Object Arrangement 

Some of the automatic layout features help you arrange objects in your diagram. 

The alignment toolbar helps you quickly align the object boxes along the top, 

bottom, or sides of the boxes. 
 

The alignment toolbar includes tools to evenly space a set of objects horizontally 

or vertically. 
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Adjust the Object Spacing on the Diagram Window 

Use this automatic layout feature to quickly adjust the horizontal and vertical 

space between objects. 

To adjust the object spacing on the diagram window 

1. Select the objects for which you want to adjust the space. You must select at 

least three objects.  

2. Choose one of the following on the Alignment toolbar: 

 Space Horizontally 

Spaces the objects horizontally. 

 Space Vertically 

Spaces the objects vertically. 
 

Group and Ungroup Objects 

You can group objects to easily maintain and manage your models. For example, 

you may want to group all the entities that you work with by category. When you 

create groups, it also helps ensure that single entities will not be inadvertently 

moved. 

Note: To adjust alignment or spacing within the group, you must first ungroup 

the objects. 
 

To group and ungroup objects 

1. Select the objects that you want to group 

2. Click the Group icon  in the Alignment Toolbar. 

You can now move the group around the model as single object. 
 

3. To return the group to individual movable objects, select the group and then 

click the Ungroup  icon in the Alignment Toolbar. 

You can now move each object individually. 
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Drawing Objects 

You can enhance a model by using the Drawing Objects Toolbar to create the 

following objects: 

■ Rectangle 

■ Rectangle with rounded corners 

■ Ellipse 

■ Line 

■ Polyline (line with many corners) 

■ Polygon 

■ Text box 
 

In any drawing object, you can change text, font, and color properties, by 

double-clicking on the object to open the Drawing Objects dialog. 
 

Add Drawing Objects to a Data Model 

You can add drawing objects to a data model to enhance it or to provide 

meaningful annotations. 

To add drawing objects to a data model 

1. Open the model to which you want to add a drawing object. Click the shape 

icon on the Drawing Objects toolbar, and draw the shape around one or more 

entities. 

The shape is drawn around the chosen objects. 
 

2. Click the arrow on the Apply Background Color tool on the Font and Color 

toolbar. 

A new windows opens to display the available colors. 
 

3. Choose any color to apply to the background of the shape. 

The color is applied to the background of the selected objects. 
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4. Double-click on a drawing object you created. 

The Drawing Objects dialog opens. 
 

5. Click the Text tab and enter your annotation in the text box: 

 

The text appears. 
 

6. Click the Text Properties tab and, select a color for the text, and click OK. 

The dialog closes and you can see the annotation in the drawing object. The 

following is an example of how you can use drawing objects to enhance your 

data model: 

 

7. Click Save on the File menu. 

Your work is saved. 
 

Print a Data Model 

You can print your model at any stage of development to use it as a visualization 

tool. 

To print a data model 

1. Click Print on the File menu. 

The Print dialog opens, and includes an embedded Diagram Window that lets 

you view the data model by page. 
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2. Change any of the following options on this dialog: 

■ Print scaling 

■ Number of pages you want to print 

■ Format options, such as borders and color printing 

■ Page setup options such as margins, headers, and footers 

 

3. Click Print. 
 

Print Only What You Want 

You can use the mouse in the embedded Diagram Window in the Print dialog to 

perform the following tasks: 

Change the print scale 

Drag a page grid line until your model fits in the grid pages exactly how you 

want the model pages to print. You can also enter a value in the Print Scaling 

box. 

Select specific pages for printing 

Hold the CTRL key and click each page you want to print. 
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Set Print Margins 

You can specify margins for all pages of your printed model. 

To set print margins 

1. Click Page Setup in the Print dialog. 

The Page Setup dialog opens. 

2. Click the Margins tab. 
 

3. Enter a value between 0 and 1.5 inches for the left, right, top, and bottom of 

the page. 

4. Click OK. 

The Page Setup dialog closes. 

Note: Margin measurements are considered when displaying the embedded 

Diagram Window in the Print dialog. 
 

Add a Page Header or Footer 

You can add a customized header or footer (or both) to all the pages when you 

print a model. For example, you can print the Model Name, Subject Area, and 

Stored Display at the top of every page and the page number and date and time 

at the bottom of every page. 
 

Keep in mind that if you manually enter incremental information in the Header or 

Footer text box (for example, page number, date, and so on), you cannot 

automatically update the text. 
 

To add a page header or footer 

1. Select Print on the File menu. 

The Print Model dialog opens. 

2. Click the Page Setup button. 

The Page Setup dialog opens. 
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3. Select the Header/Footer tab at the top of the Page Setup dialog. 

In the Header/Footer section. 

■ Click in the Header or Footer text box to specify in which area you want 

to insert the customized text. 

■ Click the appropriate Header/Footer button to automatically insert 

information (grid page numbers) or use the keyboard to insert other 

information (for example, your name). 

Click OK. 

The settings with the current stored display are saved and you return to the 

Print Model dialog. 
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Chapter 3: Understanding the 

Workplace 
 

This section contains the following topics: 

Toolbars (see page 41) 

Workplace Panes (see page 46) 

Property Editors (see page 73) 
 

Toolbars 

There are many task-oriented toolbars that help you quickly 

perform popular tasks. When you pass your cursor over the 

toolbar button, a brief description of the button appears. When 

you click it, the appropriate dialog opens or the task is 

performed. 
 

All of the toolbars are dockable. That means that you can drag 

them to any location in the workplace and they dock along the 

edge of the window. Alternatively, you can let them float freely in 

the window if you prefer. 
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Depending on your preferences, all of the toolbars may be shown 

or hidden. On the View menu, the Toolbars option lists all of the 

toolbars. Select (check) a toolbar to make it visible in the 

workplace and clear (uncheck) to hide it. In the following 

example, you can see that the Transforms toolbar is not selected 

and will not display in the workplace: 

 

 
 

The Main Toolbar 

The Main toolbar is located near the top of the diagram window, 

and contains a group of buttons that you can use to perform 

common tasks. Each toolbar button is a shortcut you can use 

instead of selecting a menu option. The availability of the toolbar 

varies, depending on the object you have selected and whether 

you are working on the logical or physical model. 

When you pass your cursor over a toolbar button, you will see a 

brief description of the button. When you click it, the appropriate 

dialog opens or the task is performed automatically. 
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Font & Color Toolbar 

You can use the Font and Color toolbar to change the font or 

color of objects on the Diagram Window. The toolbar lists all the 

fonts that are available on your workstation. It also has separate 

buttons to modify the color of the text, object, and outline color. 

 

Options include: 

■ Font Style 

■ Font Size 

■ Bold Text 

■ Italic Text 

■ Underline Text 

■ Strikeout Text 

■ Apply Text Color 

■ Apply Background Color 

■ Apply Outline Color 
 

Drawing Objects Toolbar 

You can enhance a model by using the Drawing Objects Toolbar 

to create the different drawing objects. The tools work like many 

other popular point-and-click drawing applications. Just click a 

tool, click in the Diagram Window, and drag the mouse until the 

object is the right size. 

 

Note: You can assign default font and color settings for drawing 

objects. Click Default Fonts and Colors on the Format menu. 

Click the Drawing Objects tab on the Default Fonts and Colors 

editor to select the default setting for drawing objects. 
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Alignment Toolbar 

The appearance of your data model is important to you and the 

others who use it. There are many features that help you 

enhance the appearance of your model. You may already be 

familiar with some of the automatic layout features that help you 

arrange objects in your diagram. 

A toolbar is provided that can help you quickly align the object 

boxes along the top, bottom, or sides of the boxes. The same 

toolbar includes tools to evenly space a set of objects 

horizontally or vertically. 
 

The tools on the Alignment Toolbar speed the process of 

graphically arranging and grouping model objects. 

 
 

You can select multiple diagram objects, and space them to your 

preference. Similarly, the Group tool lets you group multiple 

diagram objects for easy manipulation. 
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CA ERwin Model Manager Toolbar 

The CA ERwin Model Manager toolbar lets you perform 

administrative and workgroup-related tasks in CA ERwin Model 

Manager (CA ERwin MM). A ToolTips description of each toolbar 

button displays when you pause your cursor on it. 

Note: Options on the toolbar become active only after you make 

a connection to the CA ERwin MM database. 

 

Options include: 

■ Open an CA ERwin MM Model 

■ Save an CA ERwin MM Model 

■ Lock/Unlock an CA ERwin MM Model 

■ Manage CA ERwin MM Libraries 

■ Manage CA ERwin MM Submodels 
 

■ Merge CA ERwin MM Models 

■ Refresh a CA ERwin MM Model 

■ Review Changes to a CA ERwin MM Model 

■ Display CA ERwin MM Model Differences 

■ Connect to CA ERwin MM 

■ Set CA ERwin MM Permissions 

■ Synchronize Models 
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The ERwin Toolbox 

The toolbox is the primary set of tools for drawing and editing a 

data model. In the Toolbox, use the Select tool to move objects 

and resize entity and table boxes. The cursor changes shape for 

each task so that you know what action is performed. 

 

You have the option to resize any box to meet your presentation 

requirements. For example, you may want all of the entity, table, 

or view boxes to be uniform in size, or emphasize one or two 

boxes by making them larger than the others.  

The toolbox changes based on the model type (logical or 

physical) and the notation (IDEF1X, IE, or DM). 

For more information about the IDEF1X, IE, and DM notation, 

see the online help. 
 

Workplace Panes 

Each of the following panes within the workplace is dockable and 

floatable, and each contains their own toolbars: 

■ Advisories Pane 

■ Model Explorer 

■ Action Log 
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Each pane also contains a shortcut menu. When you right-click 

on the double lines at the top of each pane or right-click on the 

toolbar found on the pane, a shortcut menu displays the 

following options: 

Allow Docking 

Keep the pane in its current position 

Float In Main Window 

Lets the pane move over to the Diagram Window 

Hide 

Conceals the pane, select this option. To view the pane 

again, select the appropriate pane from the View menu. 

In addition to using the shortcut menu to hide any of these 

panes, you can use one of the following methods: 

■ Clear the appropriate option on the View menu 

■ Click the Close button in the upper left corner of the pane 
 

Advisories Pane 

The Advisories pane is a dockable, floatable window in the main 

workplace. This pane automatically appears when you start the 

program. 
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The Advisories pane displays messages associated with actions 

you perform when working with your model. Each message on 

this pane shows you when a change or edit you make to a 

property is valid and alerts you when the action you have taken 

violates a modeling rule. When alerted, you can immediately 

correct your action instead of searching for the transaction at 

some later time. 

In addition to viewing the valid and violation messages, you can 

obtain details about a specific action that generated the 

message. For example, if you set a property, the Advisories pane 

shows a “Set Property” message. Click the Details button on the 

Advisories toolbar to display the Advisories Details dialog and get 

more information about the property. This feature is particularly 

useful when are working with a large model and you need 

clarification about that particular action. 
 

Model Explorer 

The Model Explorer provides an organized, hierarchical, 

text-based view of your data model and its contents. It provides 

an easy method for creating objects. The Model Explorer enables 

you to create, display, navigate, and modify your model using 

the Model or Subject Area view. 
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The Model Explorer has two panes, Model and Subject Area. You 

can switch to a different pane by clicking the tab at the bottom of 

the Model Explorer: 

 
 

All of the objects in your model are listed in the Model Explorer, 

but display differently based on which pane is active. 

■ The Model pane includes every object in your model 

including subject areas and domains. This is the default 

view. 

■ The Subject Areas pane displays model objects sorted by 

subject area. 
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Dynamic Changes 

Just as you can work on a graphical view of a model in the 

Diagram Window, you can perform the same tasks from the 

Model Explorer using a text-based view of a model. When you 

make changes to an object in the Model Explorer, the graphical 

view of the model is immediately updated with the same change. 
 

For example, if you rename a table in the Model Explorer, the 

new table name replaces the existing table name in the Diagram 

Window and the relevant editors. Similarly, if you make a change 

to the diagram or in an editor, you immediately see the change in 

the Model Explorer. 
 

The Model Explorer Tasks 

In addition to navigating, the Model Explorer provides a whole 

range of useful features that help you easily create and modify 

your data model such as: 

■ Create new objects 

■ Go to objects in the Diagram Window 

■ Open editors to view or change object properties 

■ Delete objects 

■ Rename objects 

Note: To work with the Model Explorer, click the Model Explorer 

option on the View menu. 
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The Model Explorer Shortcut Menu 

When you right-click on an object in the Model Explorer, a 

shortcut menu displays that lists the options available for that 

object, similar to the following example: 

 
 

To control the topological display of Domains, right-click on a 

Domain and select how you want to sort the Domains. 

 

You can also delete an object or invoke the property editor for 

the object. If semantics do not allow the deletion of an object 

(such as a Primary Key object), then the Delete menu item on 

the shortcut menu does not appear. 

If you want to create a new object, and additional information is 

required to complete the creation of that object (such as a 

Relationship), a dialog box appears in which you must enter the 

information required. 
 

The Model Explorer Toolbar 

The Model Explorer contains a toolbar to help you navigate your 

object editing, launch property editors, delete objects, search for 

text, and invoke online help. 
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New Objects 

Just as you can create a new entity, table, or relationship using 

the Toolbox, you can quickly create a new object in the Model 

Explorer. 

To create a new object, right-click on any object and choose New 

from the shortcut menu. For some objects, such as a domain, 

you can drag the object from the Model Explorer onto the 

Diagram Window to create a new attribute or column. 
 

Rename Objects 

Every object in your model is represented in the Model Explorer 

by its name. Just as you can rename an object using on-diagram 

editing in the Diagram Window, you can rename an object 

directly in the Model Explorer. 

To rename objects 

1. Click the object name, and then click again. 

An edit box opens around the object name. 
 

2. Enter the new object name directly in the edit box. 

The new name of that object appears throughout the Model 

Explorer and the model.  

Note: Any unique name rules that you select for your model are 

enforced when you rename an object in the Model Explorer. 
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Select Unique Name Rules 

Unique name rules are a set of options that define how to 

respond when you have a duplicate entity or table name in the 

data model. 

To select unique name rules 

1. Click Names on the Tools menu, then click Model Naming 

Options on the submenu. 

The Model Naming Options dialog opens. 

2. Click the Duplicate Names tab. 

Select the options you want to apply. 

3. Click OK. 

Your changes are saved and the Model Naming Options 

dialog closes. 
 

The Go to Diagram Option 

When you right-click an entity, table, or view in the Model 

Explorer and click the Go To Diagram option from the shortcut 

menu, you can quickly display that object in the Diagram 

Window. 
 

Object Properties 

Each object in a data model has many properties. The easiest 

way to add or modify object properties is in the object property 

editor. 

Using the Model Explorer, you can open the Property editor for 

that object type. You can do this in one of two ways: 

■ Right-click on the object and click Properties. 

■ Select the object and click the Property Editor button from 

the Model Explorer toolbar. 
 



Workplace Panes 

 

54  Implementation Guide 

 

When the Property Editor opens, you can accept or change the 

default properties. When you close the editor, the properties are 

saved with the object. 

Regardless of the method you choose to add or edit an object or 

its properties, the Model Explorer and the data model are always 

in sync. While you are still in the design phase, the names of 

objects in your model may change frequently. 

Note: Object properties also migrate through relationship lines. 

In other words, objects can inherit properties from their parent 

objects. 
 

Object Moving, Copying, and Deleting 

Just as you can move, copy, and delete attributes and columns in 

the Diagram Window, you can also move, copy, and delete most 

objects in the Model Explorer. 

After you move, copy, or delete an object, all of the instances in 

the model that reference that object are updated automatically. 
 

Add a Domain in the Model Explorer 

In the Model Explorer, the Model view lists all of the domains for 

the current model, which include all of the default domains as 

well as any that you created. 

To add a domain in the Model Explorer 

1. Right-click a domain type (blob, string, number, and so on). 

A shortcut menu opens. 

2. Click New. 

An edit box opens with a default domain name. 

Note: The selected domain type is assigned as the parent. 
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3. Enter a name for the domain in the text box and press Enter 

The new domain appears according to the sort order that you 

specify (either alphabetically or hierarchically). 

Note: To switch the sort order of the Domains from hierarchical 

to alphabetical, right-click on the Domains folder in the Model 

view, and select the sort option that you prefer. 

For more information about domains, see the “Working with 

Data Models” chapter. 
 

Add a Model Source in the Model Explorer 

When you work with design layers, it may be important to link a 

model with its model source so that you can identify the 

historical parent of a model. After you link a data model to its 

source, you can synchronize the two models to selectively apply 

changes to one or the other. 

To add a model source in the Model Explorer 

1. Right-click the Model Sources Folder, then click New from 

the shortcut menu.  

The Add Model Source wizard opens. 

2. Follow the steps in the Add Model Source wizard to finish 

adding the model source. 
 

3. Click Add to complete the process and close the wizard. 

The source objects are added to your target model, and 

models are linked. As you continue to work with the models, 

all the changes you apply to the model and the model source 

are tracked. 

For more information about adding model sources, see the 

“Working with Design Layers” chapter. 
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Model View 

The primary purpose of the Model view is model exploration and 

to function as an alternative launching point for object and 

property editors. It lists all of the object types that appear in the 

current data model based on the model type and the target 

server. 
 

For example, if the model type is Logical, the Model Explorer 

does not include physical objects such as a view. Similarly, if the 

model type is Physical, the Model Explorer does not include 

logical objects. If the target server is Oracle, then additional 

objects specific to Oracle display, such as Clusters. 
 

Other objects that do not display are: 

■ Minor objects that are handled completely by the editors of 

the parent object. For example, a Valid Value object is 

created, destroyed, and edited by the Validation Rule 

editors. 

■ An object that represents configuration information that is 

stored by an CA ERwin DM process, and is not actual model 

data, such as a Complete Compare Option Set. 
 

Subject Area View 

The Subject Area pane displays model objects sorted by subject 

area. You can expand each subject area to see a list of the 

members as well as any stored displays, which appear in folders 

below the Subject Area to which they belong. 

The purpose of the Subject Area view is to provide a filtered view 

of the model so that unnecessary tree information is minimized, 

which is especially helpful when you are working with large 

models. 
 

By default, every data model has a Main Subject Area, which 

includes all of the objects in the model. You can create other 

subject areas to divide the model into smaller manageable parts. 
 



Workplace Panes 

 

Chapter 3: Understanding the Workplace  57  

 

At the top of the Model Explorer is a drop-down list where you 

can select the subject area that you need. When you select the 

subject area, the contents of the tree control in the Model 

Explorer filters so that only those objects that are contained 

within the selected subject area, or those that are global, are 

shown. 
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For example, you see that tables are categorized as tables, and 

views categorized as views, unlike the display of subject area 

objects in the Model tab view. Relationships are filtered to show 

only those visible on the diagram if both endpoints are present in 

the subject area. You can expand the tree for the subject area to 

see the subject area members. 

Note: Global objects that do not relate to the selected subject 

area are not displayed, such as subject area objects or model 

source objects. 
 

Create a New Subject Area 

You can create a new subject area in the Model Explorer. 

To create a new subject area 

1. Click the Model tab. You must be in the Model view to create 

a new subject area. 

2. Right-click the Subject Areas node and click New on the 

submenu. 

A text box opens at the bottom of the list. 
 

3. Enter the name of the new subject area in the box, and click 

outside the text box. 

The new subject area is named. 

To add members to a new subject area, drag entities or tables 

from the Main Subject Area into the new subject area. 

Note: Subject area members just reference the objects in the 

Main Subject Area, so changes automatically apply to an object 

in every subject area in which it is a member. 
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Action Log 

The Action Log works in real time so you can make modeling 

decisions during your current session rather than having to wait 

until you save the model to review changes. The Action Log lets 

you determine the best way to work. 

Note: To work with the Action Log, select the Action Log Pane 

option from the View menu. 
 

As you work on the graphical view of a model in the Diagram 

Window, you can view the transaction information in the Action 

Log. As you make changes to your model, the Action log is 

updated in real time. For example, if you create an entity in your 

model, the Action Log reflects this change. 

Changes are only viewable in the Action Log during your current 

modeling session. Each new session begins with an empty Action 

Log. When you close the model, the Action Log clears. Before 

closing your model, you can generate a report that lets you view 

all the changes made during the current session.  
 

The type of objects that appear in the Action Log is based on the 

display mode you are using. If you are working with a logical 

model, then only logical objects appear. If you are working with 

a physical model, then only physical objects appear. 

The Action Log lets you search for every transaction and filter by 

type of change so that you can easily find a specific transaction 

or a set of transactions. This feature is particularly helpful when 

working with large models. 
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Action Log Panes 

The Action Log has two panes, Display and Summary, with 

corresponding tabs. Select the Details tab to see every change 

(transaction) made to a model, or select the Summary tab to see 

the net result of changes made to a model. 

Note: A transaction is a single unit of work that is not divisible 

into smaller components. The Action Log lets you navigate 

through the transaction tree using the Details pane or the 

Summary pane. 
 

Details Pane 

The Details pane shows all the changes you make to a model 

during the current session. The Details pane is the default view 

when you launch the program. Changes appear in the Details 

pane with the most recent transaction at the top of the tree, and 

the first transaction at the bottom of the tree. You can either 

expand or collapse each transaction. 
 

The toolbar on the Details pane lets you reverse a transaction, 

find a transaction, view property details, and undo and redo to a 

selected transaction while working in the current session.   
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Summary Pane 

The Summary pane displays the net result of changes made to 

the model during the current session. It provides a filtered view 

of all the actions you perform on the model during the current 

session so that unnecessary tree information is minimized, which 

is especially helpful when you are working with large models. 
 

The Session Summary node is the top-level node in the tree. All 

changes you make to the model at the object level and property 

level appear below the Session Summary node in the tree. 

 
 

The Summary pane is similar to the Details pane except for the 

following differences: 

■ While the top-level nodes in the Details pane are 

transactions, the Summary pane has only one top-level node 

with changes appearing below it. 

■ The Extended Find and Filter feature is only available in the 

Summary pane. 

■ The Reverse, Undo to Selected Transaction, and Redo to 

Selected Transaction options are not available in the 

Summary pane. 
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Action Log Tasks 

In addition to viewing the detail and summary transactions, the 

Action Log provides a range of useful features that help you 

easily perform the following actions: 

■ Locate text within a transaction, object, or property using 

the Find feature. 

■ Use the Extended Find and Filter feature to locate, filter, and 

report on the results of your search. This feature is available 

only in the Summary pane. 
 

■ View old and new details relating to a property transaction 

using the Property Details feature. 

■ Reverse a transaction. This feature is available only in the 

Details pane. 

■ Undo a group of sequential transactions. This feature is 

available only in the Details pane. 

■ Redo a group of sequential transactions. This feature is 

available only in the Details pane. 
 

Action Log Shortcut Menu 

When you right-click an object in the Details pane the Action Log 

shortcut menu opens. This shortcut menu lists the options 

available based on the actions you performed prior to opening 

the shortcut menu. These options include: 

■ Undo to this point (or Redo to this point) 

■ Reverse 

■ Collapse (or Expand) 

■ Expand Transaction(s) 

■ Collapse Transaction(s) 

Note: A shortcut menu is not available on the Summary pane. 
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Locate Text Using the Find Feature 

The Action Log Find dialog lets you search for specific text at the 

transaction level, object level, or property level. This option is 

available on both the Details and Summary panes. 

 

By default, the search includes the entire tree, starting from the 

current selection point. If there is no current selection point, 

then the top of the tree is used as the starting point. If the search 

did not start at the top node, the search wraps to the beginning 

of the tree after reaching the end. 

To locate text using the Find feature 

1. Click Find on the Action Log toolbar. 

The Find dialog opens. 
 

2. Enter the text you want to search for in the Find what text 

box. 

3. (Optional) Select the Transaction, Object, or Property check 

box to narrow your search. 

Note:  Since there are no transaction nodes in the Summary 

pane, the Transaction search option is not applicable to that 

pane. 
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4. (Optional) Select one of these check boxes to refine your 

search: 

■ Match case check box if you want to search on 

case-sensitive text 

■ Match whole word check box if you want to search for the 

entire text string 

Search up check box if you want to search for the text from 

the bottom up 
 

5. Click Find Next. 

The next occurrence of text displays. 

6. Click Cancel when you are finished searching. 

The Find dialog closes. 
 

Action Log Metamodel Filter 

The Action Log captures all changes made to a model during a 

modeling session. The longer the session, the larger the log 

becomes. You can specify object types and property types to be 

filtered out, which affects the way modeling events are displayed 

in the Action Log. These objects are not removed from the Action 

Log, they are only filtered from the view. The Metamodel filter is 

always present on the Action Log toolbar. You can display a 

category list of objects and properties.  

The Save button saves the settings to a file called 

ActionLog.config in the C:\Documents and 

Settings\user\Application Data\CA\CA ERwin Data Modeler 

directory. This file can be copied to another machine to use the 

same filter settings. 
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Select Object and Property Types Displayed in the Action Log 

You can select the object types and property types you want to 

see displayed in the Action Log. 

To select the object and property types displayed in the 

Action Log 

1. Click the Metamodel Filter icon on the Action Log Toolbar. 

The Action Log Metamodel Filter dialog opens. 

2. By default, all objects and properties are selected initially. 

Select Clear All to clear all of the objects and properties or 

clear only the objects and properties you choose to view. 

The object and property types selected are displayed in the 

Action Log for all future transactions. 
 

Use Extended Find and Filter 

The Extended Find and Filter feature lets you set find and filter 

criteria, view property changes, and use the reporting function of 

the Data Browser. This feature is available only on the Summary 

pane of the Action Log. To open the Extended Find and Filter 

dialog, click the Extended Find/Filter button on Action Log 

toolbar. 
 

When the Extended Find and Filter dialog opens, it provides a 

snapshot of the Summary pane and lets you filter the 

information that displays so you can easily find the information 

you want to report on. Use the Report button on the toolbar to 

open the Data Browser dialog, where you can generate several 

different reports for the information that displays. 

To use the Extended Find and Filter option 

1. Click Extended Find and Filter on the Action Log toolbar in 

the Summary pane. 

The Extended Find and Filter dialog opens. 

2. Click Find on the toolbar. 

The Find Criteria dialog opens. 
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3. Select which Properties, Categories, and Classes you want to 

find. These options let you filter the information that 

displays. 

4. Click Find to start the search. 

The Find Criteria dialog closes. 
 

5. Click the Find Next button on the Extended Find and Filter 

toolbar to find the next occurrence of what you are searching 

for. 

6. Click Close. 

The Extended Find and Filter dialog closes. 
 

View Property Details 

When you want to view the old and new properties for a property 

transaction, use the Property Details feature. 

To view property details 

1. Select a property node. 

 

Note: You may need to expand the transactions in the 

Details pane or Summary pane before you can select the 

property node. 
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2. Click the Property Details button. 

The Property Change Details dialog opens, showing the 

original value of the property along with the current value of 

the property. 

3. Click Close when you are finished. 

The dialog closes. 
 

Undo a Transaction 

To undo the last change that you made to your model, use the 

Undo button on the Toolbar or click Undo on the Edit menu. This 

feature undoes one change at a time, and is reflected in the 

Action Log by a dimmed transaction. 
 

Redo a Transaction 

To redo a transaction that you made to your model, use the Redo 

button on the Toolbar or click Redo on the Edit menu. This 

feature restores one change at a time. 
 

Reverse a Transaction 

The Reverse feature in the Action Log lets you perform an 

opposite action on most entries that appear during the current 

modeling session. When you reverse a transaction, the model 

reflects the changes made to the Action Log. This feature is only 

available on the Details pane, and does not sequentially reverse 

actions. 
 

For example, if the Details pane displays Created [Entity] 

object:'Entity_5'(id=5) and you select the transaction and click 

Reverse, a Delete on Entity_5 is implied.  

Depending on how complex your model is, when using the 

Reverse feature, an attempt is made to restore the model to its 

best state. Use the Activity Log to determine whether your 

transaction has been properly reversed. 

Important! Reverse applies to the entire transaction even if you 

select only the object or property level node. 
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To reverse a transaction 

1. Click the Details tab in the Action Log. 

The Details View appears. 

2. Select a node in the tree containing an action that you want 

to reverse, and click Reverse on the Action Log toolbar. 

The opposite action occurs. 

Note: You cannot perform a reverse action on the topmost 

node in the tree. Use the Undo feature instead. You also 

cannot reverse the transaction in which the model was 

created - this transaction is marked with the pin icon. 
 

Undo and Redo to Selected Transaction 

The Undo to Selected Transaction feature in the Action Log lets 

you undo an entire range, or a sequential group, of transactions 

at the same time. Conversely, the Redo to Selected Transaction 

feature lets you restore a sequential group of transactions. 

Note:  To undo to a selected transaction or redo to a selected 

transaction, you must be in the Details pane in the Action Log. 
 

As you create transactions on your model, each one moves the 

previous transaction down the tree in the Action Log, with the 

first transaction always appearing at the bottom of the tree. 

When you want to undo a range of consecutive transactions, the 

transactions above, including the one you select are undone. To 

redo a range of transactions, the transactions below, including 

the one you select are redone. 

Important! After performing an undo to selected transaction, 

you will not be able to redo these transactions once you perform 

a new action, since the new action clears the redo stack. 
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Undo a Group of Sequential Transactions 

When using the Undo to a Selected Transaction feature, the 

transactions are undone in sequential order, starting with the 

transaction you select and ending with the latest transaction at 

the top of the tree. 

To undo a group of sequential transactions 

Note: For this exercise, you need to create transactions in the 

model so that you can undo them. 

1. Open a data model. 
 

2. Create an entity named Customer and add the following 

attributes: 

■ Street Address 

■ City 

■ State 

■ ZIP Code 

The transactions are recorded in the Action Log. 
 

3. (Optional) In the Action Log, expand all the transactions by 

clicking the plus sign next to each one. 

4. Right-click the Create Attribute transaction that is second 

from the bottom of the tree. 

A shortcut menu opens. 
 

5. Click Undo to this point. 

Note: Instead of right-clicking the transaction and opening 

the shortcut menu, select the transaction and then click the 

Undo to a Selected Transaction button on the Action Log 

toolbar to perform the same action. 

All the transactions from the one you selected up to the top 

of the Action Log tree are dimmed, and are removed from 

the model in the Diagram Window. 

Important! Do not close your model yet. Closing your model 

now will end the current session of the Activity Log and you will 

not be able to redo the transactions you just undid. 
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Redo a Group of Consecutive Transactions 

When using the Redo to a Selected Transaction feature, the 

transactions are restored in sequential order starting with the 

transaction you select and moving down the tree until all 

dimmed transactions are restored. 
 

To redo a group of consecutive transactions 

1. Right-click the transaction that is the starting point for the 

redo action in the Action Log tree, Details pane. 

The shortcut menu opens. 

Note: Instead of right-clicking the transaction and opening 

the shortcut menu, select the transaction and then click the 

Redo to a Selected Transaction button on the Action Log 

toolbar to perform the same action. 
 

2. Click Redo to this point. 

All the transactions that were previously undone are now 

restored in the Action Log as well as in the model in the 

Diagram Window. 

3. Save your model. 
 

Undo/Reverse Comparison 

You can undo or reverse changes you make to your model. The 

following table summarizes the differences between the three 

available features, and suggests when it is appropriate to use 

each one: 

 

Feature Toolbar When to Use 

Undo Standard 

toolbar 

When you want to undo the last, single action you took. 

This feature is similar to the Microsoft Windows undo feature; it lets 

you undo the last action taken. 

Reverse Action Log 

toolbar 

When you want to perform an opposite action that is not the last 

action you took in the current modeling session. 

This feature applies to the entire transaction even if you select only 

the object or property level node. 
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Feature Toolbar When to Use 

You can use the Undo button to undo a reverse action made in error. 

For some transactions, you can also reverse a reverse action. 

Note that you cannot perform a sequential reverse using this feature. 

Undo to 

selected 

transaction/ 

Undo to this 

point 

Action Log 

toolbar 

When you want to undo sequential transactions performed in the 

current modeling session. 

This feature lets you undo a range, or sequential grouping, of 

transactions at one time. 

You can perform a redo to selected transaction to the same group of 

transactions or a smaller set of the consecutive transactions in the 

group. You can use this feature at any time during the current 

modeling session. 
 

Generate an Activity Summary Log 

To save the information from your Action Log, use the Activity 

Summary option. This option generates a report that shows an 

activity summary of your current modeling session. This report 

can be helpful since the Activity Log is cleared every time you 

close your model. 

To generate an Action Summary Log 

1. Click Options on the Tools menu. 

The Options dialog opens on the General tab. 
 

2. Enter the full path in the Activity Summary section of the 

dialog where you want to save the report. 

(Optional) If you select the Generate on model close check 

box, a report is generated automatically each time before 

you close the model. 

3. Click OK. 

The Options dialog closes. 

Note: The generated report is saved in comma-delimited format 

(.csv) so that it can be viewed easily in other applications such as 

Microsoft Excel. 
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Generate an Action Summary Report 

You can filter information on the Summary pane and save the 

information as a report using the Data Browser. Three types of 

Action Summary Reports are available: 

To generate an Action Summary report 

1. Click the Summary tab in the Action Log. 

The Summary pane opens. 
 

2. Click the Extended Find and Filter button. 

The Extended Find and Filter dialog displays. 

3. Click the Report button. 

The Data Browser opens. 
 

4. Expand the Action Summary reports folder and select a 

report.  

Session Summary Report 

Displays the summary of changes that take place in the 

model. 

Session Summary-Details Report 

Displays a detail list of changes in a model. 

Comparison Report 

Displays the differences between the original version of 

the model and the current version of the model. 

Click the Execute button. 

The report is generated. 

5. (Optional) You can customize the report or print it.  

Note: To save the report in .csv format, click Export on the File 

menu. 
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Property Editors 

In CA ERwin Data Modeler you use the Physical Property editors 

to work with the relational modeling features of your selected 

target database. For example, when modeling in SQL Server, 

you can create all the objects and properties for the physical 

database using editors provided on the Database menu or in the 

Model Explorer. The editors are designed with common features 

that enable you to quickly create and maintain modeling objects.  

Editors share these common features: 

■ Navigation Grid 

■ Navigation Toolbar 

■ Common Tabs and Options 
 

Property Editor Navigation Grid 

This non-scrollable region in the upper portion of the editor lists 

all objects of this type in the model, and provides access to 

frequently used properties. Properties relevant to the object 

display in separate cells, each with a text entry area, check box, 

or drop-down control for selecting available values. 

 

You can adjust the amount of space allocated to the navigation 

Grid by moving the splitter bar up or down. Columns within the 

Navigation Grid may be readjusted to be narrower or wider. 
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Property Editor Toolbar 

You can quickly access features for each editor from the toolbar. 

The toolbar includes the following options: 

 Previous 

Position the editor on the previous object in the navigation 

grid. 

 Next 

Position the editor on the next object in the navigation grid. 
 

 Sort 

Sort the objects by alphabetic or reverse alphabetic order. 

Other sort options may be available on some types of 

objects. 

 DB Sync 

Open the DB Sync wizard, where you can perform a 

database-level compare of objects in the current model with 

matching objects in another model or database. 
 

 New 

Create a new object. It becomes the current object in the 

editor. 

 Delete 

Delete the selected object. 

 Help 

Access online help for the editor. Help is editor-specific and 

includes short definitions of all the available properties. 
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Property Editor Tabs and Options 

All property editors include tabs in the lower portion of the editor 

that include specific features relevant to the editor. Other 

options enable you to undo and redo actions, and display details 

about an action. 

 
 

General Tab 

Provides the main features for the editor. When you click a 

displayed option, such as a drop-down list, additional 

features display that allow you to enter free text, or select 

the relevant value. 
 

Common Tabs 

Provides additional functionality relevant to the editor. For 

example, many editors allow you to enter definitions or 

notes. Most editors allow you to create User-Defined 

Properties. Other tabs are displayed when a link to a related 

editor is relevant. For example, in databases that allow 

modeling of security features, a Privilege tab displays that 

enables you to work with privileges. 
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Undo/Redo/Details 

Provides icons you can click to undo the last action or redo 

the previous action within the editor. Click the Details button 

to open the Advisory Message Dialog that displays details 

about the action. 
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Chapter 4: Working with Data Models 
 

This section contains the following topics: 

Domains (see page 77) 

Relationships (see page 81) 

Views (see page 87) 

Display Levels (see page 88) 

Subject Areas (see page 93) 

Index Tables (see page 96) 

Find and Replace (see page 101) 

Forward Engineering (see page 102) 
 

Domains 

A domain is a model object that you can use to assign properties quickly to an 

attribute or column. By using domains, you promote consistency because you 

can reuse a domain as many times as you like in a single or multiple data models. 

Domains also reduce the time spent on development and maintenance. If you 

change the domain, all attributes or columns associated with the domain also 

change. 
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Domain Dictionary 

The Domain Dictionary lists all the domains for the data model. You can arrange 

them hierarchically or alphabetically. The Model Explorer has the same list as the 

Domain Dictionary and can also be sorted in hierarchical or alphabetic order. 

 
 

You can create and modify both physical and logical domains using the Domain 

Dictionary. Some of the domain properties include: 

■ Domain name and column name 

■ Column datatype, default value, and valid value 

■ Domain comment or note and column comment or name 

■ User Defined Property 

Note that the tabs and options in the editor change based on whether the model 

is logical, physical, or logical/physical. 
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Inherited and Non-inherited Domain Properties 

Domains have two types of properties:  

■ Non-inheritable properties do not migrate to child domains or attributes and 

columns associated with the domain because they are properties of the 

domain itself. 

■ Inheritable properties do migrate to child domains and to the attributes and 

columns associated with the domain. 

The inheritable and non-inheritable domain name properties appear on the 

General tab for a Logical model. 
 

Attributes and Columns in Domains 

When you drag-and-drop a domain from the Model Explorer onto an entity or 

table, you can add a new attribute to an entity or a new column to a table. The 

new attribute or column inherits all the inheritable properties, including its name, 

from the domain. 
 

Drag a Domain from the Model Explorer to Your Model 

Use drag-and-drop to add a domain directly from the Model Explorer to an entity 

or table in your model. 

To drag a domain from the Model Explorer to your model 

1. With the Model Explorer, Domain tab open, click the domain you want to add 

to your model. 

The domain is selected. 

2. Drag the domain to the entity or table in your model. 

The domain is added as an attribute or column. 

Note: Depending on the Unique Naming rules that apply to the data model, 

you may be prompted to rename each attribute or column that you add 

because the domain's name is automatically assigned to each new attribute 

or column. 
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Create a New Domain 

A set of default domains are supplied that you can use as they are or you can 

modify their properties. 

To create a new domain 

1. Click Domain Dictionary on the Model menu. 

The Domain Dictionary opens. 

2. Select the parent domain, which can be any existing domain. 
 

3. Click New. 

The New Diagram dialog opens, and the parent domain that you selected is 

highlighted. 

4. Enter a name for the new domain in Logical Name or Physical Name box, and 

click OK. 

Note: In the New Domain dialog, the Logical Name and Physical Name boxes 

appear only when the model type is Logical/Physical. By default, the physical 

name is automatically assigned the same name as the logical domain, but you 

can rename the physical domain at any time. 
 

Domains and Datatypes 

A datatype is a domain property and defines the physical properties of a column 

in a database such as length (number of characters), type (alpha or numeric), 

and precision (decimal). You can also define a logical datatype, which usually 

corresponds to a physical datatype. 
 

By default, a new domain is assigned the same datatype as its parent domain. 

You can change it at any time. The available datatypes for the current model 

always appear in the list in the Domain Dictionary. 

To assign a datatype in the Domain Dictionary 

1. In the Domain Dictionary, select the domain and click the Datatype tab in the 

Logical model or the Database tab in the Physical model. 

The corresponding tab appears. 

2. Select the new datatype for the domain from the datatype list. 

3. Specify other properties for the datatype as relevant. Click OK. 

Your changes are saved and the Domain Dictionary closes. 
 



Relationships 

 

Chapter 4: Working with Data Models  81  

 

Domain Icons 

In the Model Explorer and in the Domain Dictionary, a unique icon represents 

each domain. A default icon is used for new domains, but you can choose a 

different icon to represent the domains you create. 
 

Assign or Change a Domain Icon 

You can select any icon (.bmp file) for the non-inheritable property of the domain 

itself. You can assign the same icon or select a different icon to be inherited by 

the attributes or columns associated with the domain. 

To assign or change a domain icon 

1. In the Logical model, click Domain Dictionary on the Model menu. 

The Domain Dictionary opens. Select a domain from the Domain list. 

2. In the Domain Icon drop-down list, select a new domain icon. 

The icon is assigned to the selected domain. 

Note: Click  to open the Icons editor, where you can import a bitmap file, or 

rename or delete an existing icon. 
 

Relationships 

In a data model, a relationship shows an association between two entities or 

tables. A relationship is represented as a solid or dashed line that connects two 

entities or two tables. Depending on the notation you choose, the symbols at 

either end of the line may change. 

If you prefer to work in the Model Explorer, you can see the parent and child 

relationships for each entity and table in the Model Explorer. Double-click any of 

the relationship folders to open the Relationship Editor. 
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Entity Relationships 

The following diagram shows the relationship between the CUSTOMER entity and 

the MOVIE RENTAL RECORD entity using Integration DEFinition (IDEF1X) 

notation: 

 
 

The following Entity-Relationship data model uses entities and relationships to 

represent the logical structures that will eventually become the physical tables in 

a database. A box is used with a horizontal line to depict an entity and solid or 

dashed connecting lines to depict a relationship between two entities. 
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Other Relationship Types 

In addition to identifying and non-identifying relationships, you can also create 

other relationships, as shown in the following chart: 

 

          Identifying relationship 

       Non-identifying relationship  

                               Recursive relationship 

     Many-to-many relationship 

               Supertype/Subtype relationship  
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Relationship Creation 

Many easy methods for creating a relationship are provided. The easiest way to 

create a relationship is to use the Relationship tool in the Toolbox. Depending on 

the model type (logical or physical) and the diagram notation, the relationship 

tools in the toolbar vary. 

Before you create a relationship, consider whether you want the foreign keys to 

migrate to the primary key area or the non-key area of the entity or table. 
 

Relationship Lines 

After you create a relationship line or rearrange existing lines, the line position is 

saved so that routine modeling tasks, such as switching between logical and 

physical models with the same display level, do not result in a rearrangement of 

any of the relationship lines. 

When you click a relationship line, the line is highlighted with a shadow. This lets 

you see the selected line more clearly. 
 

You can format relationship lines in your model by clicking Preferences on the 

Format menu and clicking the Layout tab. You can choose to perform the 

following actions: 

■ Clear the Allow manual layout check box to prohibit manual layout of 

relationship lines. Click this check box to allow manual reshaping of 

relationship lines. 

■ Click the Redraw All Relationship Lines button to shape all relationship lines 

automatically. 

■ You can also choose to automatically layout the currently selected 

relationship line by right-clicking the line and selecting Relationship Auto 

Layout from the shortcut menu. 
 

Relationship Editor 

After you create a relationship, you can double-click the relationship line to open 

the Relationship Editor. You can edit many of the relationship's properties 

including: 

■ Parent and child verb phrases 

■ Relationship definition 

■ Rolename 

■ Referential Integrity 

■ Cardinality 
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Verb Phrases 

A verb phrase describes how two entities are related. You can create two types of 

verb phrases: 

■ Parent-to-child verb phrase describes how the parent is related to the 

child. In the first example below, the verb phrase states that “A STORE rents 

A MOVIE.” 

■ Child-to-parent verb phrase describes how a child entity is related to a 

parent entity. In the second example below, the verb phrase states that “A 

MOVIE is rented from A STORE.” 

 

Note: You can enter parent and child verb phrases directly in the Diagram 

Window using on-diagram editing. 
 

Foreign Key Migration and Unification 

When you create a relationship between entities, the primary key attributes of 

the parent entity are automatically migrated to the child entity. The designator 

(FK) indicates the name of the migrated key attribute, also known as a foreign 

key. This migration occurs automatically in the physical model. 

If the foreign key attribute has the same name as an owned attribute in the child 

entity, the two instances are automatically unified into one attribute because it 

assumes that they are the same attribute. The process of combining or unifying 

identical attributes in an entity is called unification. 
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Rolenames 

Sometimes, unification is not the desired behavior. You may want to maintain a 

distinction between multiple attributes with the same name in an entity because 

each serves a different purpose. In this situation, you can assign a rolename, 

which is similar to an alias that you assign to a foreign key. 

 
 



Views 

 

Chapter 4: Working with Data Models  87  

 

Views 

In a physical model, you can create a view, which is really a SQL query that is 

permanently stored in the database under assigned names. Typically, a view is 

used to present specific database information for a target audience. In the 

following example, the accounting department of a video store chain presumably 

uses the CUSTOMER INVOICE view to generate a billing invoice. 

 
 

A view is really a virtual table; a view table (box) and relationship line are both 

drawn with dashed-lines. 

In the physical model, you can use view tools in the toolbox to draw the view 

table and connect the view relationship to a source table. Behind the scenes, the 

SQL query is written for the view, which you can view and edit in the Views 

Editor. 

You can use views in SQL to perform the following tasks: 

■ Create a customized presentation of the data stored in the database. 

■ Restrict access to data, allowing different users access to only certain rows or 

columns of a table. 

■ Simplify database access by creating customized structures tailored to the 

needs of individual users. A user can write a simple query on a view rather 

than a complex query on the actual database tables. 

Note: For more information on Views, see the online help. 
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Methods for Adding a View to a Model 

You can add a view using any of the following methods: 

■ Click the Entity button on the Toolbox. Then click in the Diagram Window. 

■ Reverse engineer an existing database. 

■ Copy a view from one model and paste it into another model. 

■ Right-click the Views folder in the Model Explorer and choose New. 

Note: For more information about adding a View to a model see the online help. 
 

Display Levels 

Two sets of display levels are provided, one for the logical model and one for the 

physical model. 

These display levels are useful for showing different types of information in a 

data model, particularly when different people and groups use the data model for 

their specific job in the development process. 
 

Logical Display Levels 

The Logical Display levels are as follows: 

Entity 

Displays the name of each entity in a data model inside an entity box. No 

other information displays for the entity. 

Attribute 

Displays the attributes for each entity in a data model, with the primary key 

attributes above the line and the non-key attributes below the line in an 

entity box. 
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Primary Key 

Displays the primary key attributes (those found above the line in an entity 

box) for each entity in a data model. The attributes below the line are hidden, 

but display when you switch back to the Attribute Display Level and you can 

also see them in the Attribute Editor. 

Definition 

Displays the definition for each entity in a data model. 

Icon 

Displays the bitmap, if you have assigned one to the entity. You can assign a 

different bitmap to each entity in the Icon tab of the Entity Editor. 

Note: For more information about assigning bitmaps to entities, see the 

Online Help. 
 

The following diagram uses the same entities and illustrates each of the 

logical display levels: 

Icon

Definition

Primary Key

Attribute

Entity
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Physical Display Levels 

The Physical Display levels are as follows: 

Table 

Displays the name of each table in a data model inside a box. No other 

information displays for the table. 

Column 

Displays the columns for each table in a data model, with the primary key 

columns above the line and the non-key columns below the line in a box. 
 

Primary Key 

Displays the primary key attributes (those found above the line in an entity 

box) for each entity in a data model. The attributes below the line are hidden, 

but display when you switch back to the Attribute Display Level and you can 

also see them in the Attribute Editor. 

Comment 

Displays the definition for each table in a data model. 

Physical column order 

Displays the order in which each column appears in the corresponding table. 
 

The following diagram uses the same entities and illustrates each of the physical 

display levels: 

Physical

Column

Order

Comment

Primary Key

Column

Table
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Display Options 

You are also provided with display options for entities and their relationships. 

These options are useful for showing different types of information in the logical 

model: 

■ Entity display options 

■ Relationship display options 

Use the shortcut menu to set these options. 
 

Entity or Table Display Options 

You can use the entity or table display options to view information about entities 

and tables in a data model. 

 

Note: The Format menu changes based on whether the currently displayed 

model is physical or logical. 
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Relationship Display Option 

In both the logical and physical data model, you can use the display options to 

view the relationship properties. 

 
 

Create a Stored Display 

If you want to quickly change the graphic presentation of your data model 

without resetting the display options each time, you can create a stored display 

for each set of display options. 

To create a stored display 

1. Click Stored Display Settings on the Format menu. 

The Stored Displays dialog opens. 

2. Click New. 

The New Stored Display dialog opens. 
 

3. Enter a name for the stored display, and click OK. 

The New Stored Display dialog closes. 

4. Select the display option settings by clicking the property tabs (that is, 

General, Logical, Physical, Definition, or UDP) in the Stored Displays dialog. 

5. Click OK to save the new stored display. 

The new stored display is saved and the dialog closes. 
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Stored Display Tabs 

For each stored display you create, a tab is added to the bottom of the Diagram 

Window. When you save a data model, all stored displays that are associated 

with the data model are saved. 

To see the Stored Display tabs, click the Stored Display Tabs option on the View 

menu. 
 

Subject Areas 

A subject area is a subset of objects taken from the whole pool of objects in your 

diagram. By default, a new data model includes one subject area called the Main 

Subject Area, which includes all of the objects in the data model. However, you 

can create others. 

It is important to understand that the subject areas are not copies of the data 

model, but are dynamic subsets of the data model. In other words, if you add 

members to a subject area those objects are added to the current subject area 

and the Main Subject Area. 
 

If you add an attribute or column to an existing entity or table, the new object is 

added to every subject area in which the entity or table is a member. 
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Subject Area Members 

An object that is included in a subject area is referred to as a member of a subject 

area. 

By default every object in the data model is a member of the Main Subject Area. 

A member can also belong to one or more other subject areas in the same data 

model. 
 

Subject Areas in the Logical/Physical Model 

For every subject area in a Logical/Physical model, a corresponding subject area 

is automatically created for the other model type. So, if you create a Customer 

Subject Area in logical model, a Customer Area is created in the physical model. 
 

The Subject Area Editor 

In the Subject Area Editor you can perform these tasks: 

■ Create a subject area 

■ Add members to a subject area 

■ Modify the properties of a subject area 

■ Delete a subject area 
 

Create a New Subject Area in the Subject Area Editor 

To create a new subject area in the Subject Area editor 

1. Click Subject Areas on the Model menu or click the Subject Areas button on 

the toolbar. 

The Subject Area Editor opens. 

2. Click New. 

The New Subject Area dialog opens. 
 

3. Enter a name for the new subject area, and click OK. 

The New Subject Area dialog closes. 

4. Click the Members tab and use the arrows to include the objects in the new 

subject area (on the right). 

5. Click OK. 

The Subject Area Editor closes, and the new subject area appears in the 

Diagram Window. 
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Spanning Neighborhoods 

A quick way to add members to a subject area is to click the Span Neighborhood 

icon  while using the Subject Area Editor. This opens the Spanning 

Neighborhood dialog. 

In the Spanning Neighborhood dialog, you can specify the level of ancestors and 

descendants you want to automatically include in the subject area. Ancestors are 

the parents and grandparents of an entity. Descendants are the children and 

grandchildren of an entity. 

 
 

Subject Areas in the Model Explorer 

The Model Explorer provides a quick view of the subject areas in the data model. 

You can view them in the following ways: 

■ In the Model pane, you can see the Subject Areas along with all of the other 

data model objects.  

■ In the Subject Areas pane, you can view all of the subject areas at a glance. 
 

Create Subject Areas in the Model Explorer 

To create a subject area in the Model Explorer 

1. In the Model Explorer Model pane, right-click the Subject Areas folder. 

A shortcut menu opens. 

2. Select New. 

A New Subject Area text box is added to the bottom of the Subject Areas list. 
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3. Enter a name for the new subject area in the text box. 

4. Expand the Main Subject Areas folder and decide which members you want 

to include in the new subject area. 

5. Drag those members from the Main Subject Area folder into the new subject 

area folder. 

The members now appear in both subject area folders. 

Note: All of the objects in all of the subject areas are kept track of and the data 

model is kept in sync with the contents of the Model Explorer. 
 

Index Tables 

Just as an index in a book helps you quickly find information by listing all the 

pages where a particular topic is discussed, an index in a database table points to 

all the rows where a particular column value is stored. 
 

An index table helps to quickly locate a record in a database by pointing to a 

specific column and row in a table. So, for example, to locate a customer in the 

database, an index on the CUSTOMER table references the Customer Number 

(account number). 

 
 

You can use indexes in two ways: 

■ To sequentially access the indexed file. 

■ To directly access individual records in the indexed file based on a given 

value for the indexed field. 
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Types of Indexes 

The following types of indexes are supported: 

Primary Key (PK) Index 

A primary key index is an index for the primary key columns in a particular 

table. 

You can have only one primary key index for each table, although each index 

can include multiple columns. 

A primary key index is unique, so the indexed columns cannot have duplicate 

values nor can they be null (empty). For example, a customer phone number 

must be unique in order to locate a particular customer record. 

A primary key index for each table that has one or more primary key columns 

is automatically created. 

Foreign Key (FK) Index 

A foreign key index is an index for one or more foreign key columns in a 

particular table. A foreign key index is automatically created for each set of 

foreign key columns that migrate through a relationship.  
 

Alternate Key (AK) Index 

A unique index that provides an alternative unique index in addition to the 

primary key index. For example, to locate a customer quickly, the primary 

key index may include only the customer account number. As an alternative, 

the alternate key index may include the customer phone number column, 

which must be a unique number associated with a customer record. 

Inversion Entry (IE) Index 

A non-unique, or inversion entry index lets you quickly access records using 

values that are not unique, such as EMPLOYEE last name. Duplicate values in 

the inversion entry index are allowed. 
 

In a Logical/Physical model, if you create an index in the physical model, the 

corresponding key group in the logical model is automatically created. A key 

group is a logical modeling tool that identifies relationships between entities that 

are implemented as foreign keys. You can also use key groups to identify 

potential primary keys or alternate keys for use in the physical model. 
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Unique and Non-Unique Indexes 

Imagine a database for a video rental chain. It probably has hundreds of 

thousands of customer records. However, when it is time to check out a video, it 

is important for each customer record to be quickly located for better customer 

service. 

If the video store clerk knows the customer account number, the customer's 

record is found quickly because the Primary Key index references a unique 

customer number. 
 

Often the customer account number is not available. But, a customer record is 

found quickly if the video store database has another unique index that points to 

the Customer Last Name and Customer Phone columns. 

 
 

Alternatively, the video store may also want to look up a customer record by last 

name, even though the search may produce multiple records. 

In this case, a non-unique index may be created on the CUSTOMER table that 

points to the Customer Last Name column alone. 
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The Index Editor 

In the physical model, you can use the Index Editor to perform the following 

tasks: 

■ Create, rename, or delete an index 

■ View the indexes for a table 

■ View the properties of an index 

■ Use the Members tab to view all the available columns in the table and those 

columns already assigned to the index 

Depending on the target database, other index properties may be available. 

Note: By default, the Primary Key index is automatically created. It is unique 

and includes all primary key columns. 
 

Create an Index in the Index Editor 

Only one Primary Key index can apply to a table, although you can create 

multiple AK (unique) or IE (non-unique) indexes. 

To create an index in the Index Editor 

1. Right-click a table in the diagram and click Indexes. 

The Index Editor opens. 

2. Click New. 

The New Index dialog opens. A default index name is assigned, which you 

can accept or change. 
 

3. Select the Unique option to create an AK index or clear the Unique option to 

create an IE index. 

4. Click OK. 

The New Index dialog closes. 

5. In the Index Editor, select the index columns from the Available Columns list 

and use the Arrow button to move them to the Index Members list. 

6. Click OK. 

The index is saved and the dialog closes. 
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Create an Index in the Model Explorer 

You can use the Model Explorer to create indexes. 

To create an index in the Model Explorer 

1. In the Model tab of the Model Explorer, click Tables to expand the folder. 

2. Right-click the Indexes folder. 

A shortcut menu opens. 

3. Select either New Unique Index or New Non-Unique Index. 

A new folder with a default name is added to the Indexes list. 
 

4. Right-click the new Index folder. 

A shortcut menu opens. 

5. Click Properties. 

The Index Editor opens. 

6. Select the index columns from the Available Columns list and use the Arrow 

button to move them to the Index Members list. 

7. Click Close. 

You changes are saved and the dialog closes. 
 



Find and Replace 

 

Chapter 4: Working with Data Models  101  

 

Find and Replace 

You can use the Find and Replace feature to globally search for anything that is 

exposed in the model (including all string properties) and optionally replace with 

the text specified. You can use features such as matching case, wild cards, and 

search direction. This gives modelers the ability to make changes across large 

models to ensure consistent metadata. 

Note: The Find and Replace feature does not replace Find functionality already 

implemented elsewhere in the program (i.e. Model Explorer, Action Log, Data 

Browser, Complete Compare). 

To use the Find and Replace option 

1. Click Find on the Edit menu. 

The Find and Replace dialog opens.  

2. Enter the text you want to find and select from the following options: 

Match Case 

Searches text based on case. When cleared, the case is ignored to 

determine match. 

Match whole word 

Searches for the entire text string to determine match. 

Match against expanded values 

When selected, macros are expanded first then the match is determined 

on the expanded value. Table and view names are macros by default, 

unless they are specifically overridden. 

Wildcard 

Selects DOS or SQL wildcards to determine match. For example, use the 

asterisk (*) wildcard to search for a string of characters ("c*r" finds 

"customer" and "car"). 

Search direction 

Selects which direction within the model to search the text-- forward or 

backward. The default is Forward. 

Select the Replace check box if you want to replace the text found, and click 

Find to start the search.  

If the text is found, it appears below in the Found object and property pane. 

You can click Replace to replace the text found with the new text in the 

Replace field. 

Note: You can also directly edit the text in the Found object and property 

pane if the property is not marked as Read-only. If you edit the text in the 

property pane and click Replace, then the text in the property pane is used as 

the replacement text and not the text in the Replace with field. 
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If the search text is not located, a message states that no matches were 

found.  

3. Click Find Next to repeat the last search you specified and find the next 

occurrence of the text. 

The next occurrence is selected. The search terminates when it reaches the 

end of the model. You will be prompted that there are no more matches and 

if you like to restart the search from the beginning of the model. 
 

Forward Engineering 

Forward engineering is a process that generates the physical database schema 

from the data model. Use the Forward Engineering feature to design and create 

your database without writing a single SQL CREATE TABLE or CREATE INDEX 

statement. 
 

When you generate a schema, you can choose to generate: 

■ Tables 

■ Triggers 

■ Stored procedures 

■ Indexes 

■ Constraints 

■ Physical storage objects 

■ Other database features supported by your target DBMS 
 

Using forward engineering, you can choose to generate a script file, which you 

can use to update the database using a database administration tool, or you can 

directly connect to the database catalog. Either way, most of the work is done for 

you by generating the script for your target server. 
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Before you forward engineer, you can view the schema, which is a text-based 

representation of the database objects that will be created in the database from 

the script. The data definition language (DDL) specific to the target database is 

used to write the script. Each time you add an object or property to your data 

model, the script file is automatically updated to reflect the change to the data 

model. 
 

Preview Schema Generation 

To preview schema generation 

1. Click Open on the File menu, and choose a logical/physical model you 

previously saved. 

Your model opens in the main workplace. 

2. Use the Model Type Indicator to switch the Physical model.  
 

3. Click Forward Engineer Schema Generation on the Tools menu. 

The Schema Generation dialog opens. 

4. Click Preview. 

The Schema Generation Preview dialog opens, similar to the following 

example: 

 

The Preview Schema screen is similar to a text editor. 
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5. Edit the schema by typing directly in the editor or use the toolbar at the top 

of the editor to perform other common text processing functions. 

6. Click Save to save your changes, or click Generate to generate the schema. 

Click close to close the Preview window. 

When you close the Preview window, you return to the main Forward 

Engineer dialog. 
 

Change Schema Generation Options 

You can view and set schema generation options by category. The target server 

you select determines the options that appear in the editor. 

To change the schema generation options 

1. Select Forward Engineer, Schema Generator from the Tools menu. 

The Schema Generation Editor opens. The left panel lists all the categories 

and the right panel lists all the options for the selected category. 
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2. Make your selections in the right panel of the Options tab, or click the 

Summary tab to view the default options. 

 
 

3. Click OK when you are finished. 

The Schema Generation Editor closes. 
 

Additional Schema Generation Options 

A full range of options is available for generating a schema. Use these additional 

options for refining your output: 

Check Model 

Creates a Model Validation report before you forward engineer your model. 

The report checks for corrupt objects and reports other errors associated 

with correct forward engineering. To run the report click Forward Engineer, 

Check Model on the Tools menu. 

Using Option Sets 

Lets you save the selections you make in the Options tab to an external XML 

file, or you can save the selections with the model. Click Save As to save your 

current option set. You can also share option sets with other users. If you 

want to use an option set you created earlier, click Open to select the XML 

file. 
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Filtering Tables 

Lets you filter out selected tables for the schema generation when you click 

the Filter button. By default, all tables in your model are included in the 

schema generation. A selection dialog opens that lets you move selected 

tables out of the list of tables included in the schema generation. 

Setting an Owner Override 

Lets you set a global name override, or a name override for other physical 

objects relevant to your target server, such as tables, views, and triggers. 
 

Generate the Schema 

You can preview your schema as many times as you want. When you are satisfied 

with the content of the schema, you can generate it to your target server. 

To generate the schema 

1. Start the schema generation process using one of these methods: 

■ From the Preview dialog, click Generate. 

■ From the main Schema Generation dialog, click Generate. 

The <database> Connection dialog opens. 
 

2. Enter the required connection criteria. Click Connect. 

The schema generation process begins. 

As the schema is generated, you receive status information. When you select 

the Stop If Failure check box in the dialog, you can choose to Continue or 

Abort the generation. 

 

Note: To fix an error found during generation, click Abort and then return to the 

Schema Preview dialog, where you can find and correct the source of the error. 
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Save the Script File 

You can save or print your script file. You may want to save the script as a report 

that contains all the queries, and success or failure messages for your schema. 

To save the script file 

1. Click Report at the bottom of the <database> Schema Generation dialog. 

The Save As dialog opens. 

2. Enter a file name in the File Name box, and click Save. 

The Save As dialog closes. 

3. Click OK. 

The <database> Schema Generation dialog closes. 
 

Generate Alter Scripts 

The Schema Generation functionality includes the capability to quickly generate 

alter scripts. When you make changes to your model you can synchronize them 

with your database or script file. Use the Schema Generation/Alter Script tool to 

do this. 

To generate the alter script to your database 

1. Open a physical model and alter it in some way, for example, by adding a 

new table with some columns. 

2. Click Alter Script/Schema Generation on the Tools menu. 

The Alter Script Schema Generation dialog opens. 
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3. Click Preview to review the changes to your schema, and then click 

Generate. 

Note: If you are not connected to your target server, you are prompted to 

make the connection before the schema generation starts. 

4. Click Close on the File menu when you are finished working with the Alter 

Script option.  

The Close dialog opens. 

5. Select the Save As .erwin file option and click OK. 

You model is saved and closed . 

Note: Alter Script functionality is also included in the Complete Compare Wizard. 

As you work in the Resolve Differences dialog of the wizard, you can generate an 

alter script when you click the appropriate icon on the toolbar. For more 

information about Complete Compare, see the “Working with Data Design 

Features” chapter of this guide. 
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Chapter 5: Working with Data Design 

Features 
 

This section contains the following topics: 

Reverse Engineering (see page 109) 

How to Use the Metadata Integration Wizard (see page 115) 

Complete Compare (see page 120) 
 

Reverse Engineering 

You can create a data model by reverse engineering, which is a process that 

takes advantage of an existing database to speed the design of a new data model 

and the subsequent delivery of new systems. The process of reverse engineering 

saves considerable time because the work of creating a new data model directly 

from the database is done for you. 

When you have an existing database from which you want to create a data 

model, you can reverse engineer the database schema, which is converted into a 

graphical representation of the database structures in a new model.  
 

The following diagram illustrates the reverse engineering process: 
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Information in your database or script file is captured, including: 

■ Tables 

■ Columns 

■ Relationships 

■ Triggers 

■ Stored procedures 

■ Validation rules 

■ Physical storage properties 
 

Database Connection Overview 

CA ERwin Data Modeler provides a gateway to your physical database using the 

Database Connection dialog. You use this dialog to enter connection criteria. 

Once the connection is established, you work directly with the physical catalog as 

you use CA ERwin Data Modeler modeling tools. 
 

Review the basic requirements for establishing database connection before you 

attempt to connect to a database. 

■ Verify that the database you plan to work with is supported by CA ERwin Data 

Modeler. The current list of supported databases and versions appears in the 

CA ERwin Data Modeler Release Notes, and in the ERwin Data Modeler - 

Target Server dialog. 
 

■ Select the database and version in the ERwin Data Modeler - Target Server 

dialog. Click Choose Database on the Database menu in the physical model 

view to open this dialog. The database that you select in this dialog is used to 

display connection parameters on the <Database> Connection dialog. 

■ Install the appropriate client database software on the machine you want to 

connect from (and which is running CA ERwin Data Modeler). You must use a 

direct physical connection to the database, not a gateway or proxy 

connection. 
 

■ If your target server is SQL Server, Oracle, or Teradata, you can use 

Windows Authentication to connect. Before you use this connection option, 

check with your Database Administrator to be sure Windows Authentication 

is set up for your Windows account. 

■ Verify your User Name and Password information if you plan to use the 

database connection option. 

■ Know other details about database parameters/values needed to connect, 

for example, the server and database name, the connection string, the 

alternate catalog, and so on as is appropriate for your target server. 
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Template Selection 

Whether you reverse engineer from a script or directly from a database, you can 

select a Physical or a Logical/Physical template. When you select a template, 

consider the design layer hierarchy and where the data model that you create by 

reverse engineering fits in the hierarchy. For example, you may want to begin 

with a physical model and then derive other models from that source. Or, you 

may want to reverse engineer a logical/physical model and split that model into 

separate logical and physical models. You can then use either model as a source 

for other models in the design layer hierarchy. 
 

Options for Reverse Engineering 

Additional steps in reverse engineering involve: 

■ Choosing the database objects and properties that you want to import 

■ Selecting physical database options 

■ Specifying whether you want to infer primary keys or relationships from 

indexes 

■ Setting case conversion options 

The options and the object list vary depending on the database or SQL file that 

you intend to reverse engineer. 
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Set Model Type, Template, and Database For Reverse Engineer 

The first step to reverse engineer a database or script file is to indicate the model 

type, template and database. These choices affect the options that are displayed 

on the Set Options dialog. 

To set model type, template, and database for reverse engineer 

1. Click Reverse Engineer on the Tools menu.  

The Select Template dialog opens. 

2. Complete the following fields: 

New Model Type 

Specifies the model type for your new model. You can choose 

physical-only, or logical/physical. 

Create Using Template 

Specifies the template for your new model. This field has the following 

options: 

Remove  

Removes a selected template from the list. You cannot delete the default 

template file. 

Browse File System  

Browses your file system to select the template that you want to use for 

the new model. 

Browse CA ERwin MM  

Displays the CA ERwin Model Manager Open dialog where you can select 

the template that you want to use for the new model. This option is only 

available when you are connected to CA ERwin Model Manager. 

Target Database 

Specifies the target SQL or Desktop DBMS and version for the new 

model. 

3. Click Next.   

The Set Options dialog opens, where you select options for reverse 

engineering specific objects and properties. 
 



Reverse Engineering 

 

Chapter 5: Working with Data Design Features  113  

 

Set Options for Reverse Engineer 

After you select the model type, template, and database, you set options to 

reverse engineer specific objects. 

To set options for reverse engineer 

1. Click Reverse Engineer on the Tools menu.  

The Select Template dialog opens. 

2. Select the new model type, template, and target database, then click Next. 

The Set Options dialog opens. 

3. Complete the following fields: 

Reverse Engineer From 

Select to reverse engineer from a database or script file. If you choose 

script file, click Browse to select the file. 

Items to Reverse Engineer 

Displays the default option set, which includes all the objects and 

properties for the selected target server. You can create and save a new 

option set based on your requirements. Select or clear an object or 

property from the object tree to include or exclude it from the reverse 

engineer. 

Reverse Engineer System Objects  

Select to reverse engineer system and user tables, or only user tables. 

This field is only available when you reverse engineer from a database.  

Table/Views In Owner: 

Select to reverse engineer tables and views by ownership. This field is 

only available when you reverse engineer from a database. This field has 

the following options: 

All 

Reverse engineer all tables and views in the database, regardless of the 

owner. 

Current 

Reverse engineer only those tables or views owned by the current user 

as entered in the <Database> Connection dialog. 

Owners (comma separated)  

Filter the tables or views that are reverse engineered to the tables or 

views owned by the owner name or names (separated by commas) 

specified in this box. 

In 
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Opens the Filter By Table Container dialog to select one or more 

TABLESPACEs or databases that you want to reverse engineer.  

Infer 

Indicate if you want to infer primary keys and relationships during 

reverse engineer. This field includes the following options: 

Primary Keys  

Infer primary key columns for tables based on defined indexes. 

Relations  

Infer relationships between tables based on either primary key column 

names or defined indexes, based on the Indexes and Names options. 

Indexes  

Infer relationships from the table indexes. When you click this button, 

the relationship between two tables is inferred only if the primary key 

columns of the parent table are in an index in the child table. 

Names  

Infer relationships from the primary key column names. When you click 

this button, a relationship is inferred between two tables if all of the 

primary key columns of the parent are in the child table. 

Note: If the target database or DDL script file supports primary key and 

foreign key declarations, you do not need to use the Primary Keys, 

Relations, Indexes, or Names options. 

Case Conversion of Physical Names 

Select a choice for case conversion of physical names. You can convert 

names to lower or upper case, or select 'None' to preserve the case 

exactly as it appears in the script file or database.  

Case Conversion of Logical Names 

Select a choice for case conversion of logical names. You can convert 

names to lower or upper case, or select 'None' to preserve the case 

exactly as it appears in the script file or database. Select 'Mixed' to 

preserve mixed-case logical names. 

Include Generated Triggers 

Specify whether or not ERwin-generated triggers are loaded during the 

reverse engineer process. This option is linked to the "Automatically 

Create RI Triggers " setting in the Model Properties dialog, RI Default 

tabs. When you choose to Automatically create RI triggers, the triggers 

are treated as model objects and can be forward-engineered into a 

model, database, or script file. You can include or exclude these triggers 

when you reverse engineer.  

4. Click Next. 
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The database or script is processed and appears as a new model in the main 

workspace. 

Note: When you reverse engineer from a database, you are prompted to connect 

to the database. If processing errors occur, a dialog displays that allows you to 

evaluate, display details for, and save the error message.  
 

How to Use the Metadata Integration Wizard 

You can load a wide variety of models generated by other sources into a data 

model. Technology from Meta Integration Technology, Inc. is embedded with CA 

ERwin Data Modeler to provide integration capabilities with about 100 

industry-leading metadata products in the form of a wizard. 

There is a different wizard depending on what you need to do. To convert data 

from another application into a format supported by CA ERwin Data Modeler, use 

the Import from External Format wizard. To convert data from an CA ERwin Data 

Modeler model to a format supported by another application, use the Export to 

External Format wizard. 

You use the Import from External Format wizard to do the following: 

■ Select the source data and other configuration parameters for the import in 

the Source page. 

■ Select the import configuration parameters for the data model data in the 

Destination page. 

■ Click the Finish button to complete the import process. 

You use the Export to External Format wizard to do the following: 

■ Select the source data and other configuration parameters for the export in 

the Source page. 

■ Select the export data and configuration parameters for the export in the 

Destination page. 

■ Click the Finish button to complete the export process. 

When you invoke either wizard for the first time, all fields are populated with 

default values. When you invoke either wizard again, the fields are populated 

with the values you entered previously. 

For a list of supported bridges, see Appendix B of the CA ERwin Data Modeler 

Implementation Guide. 
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Set Options for Import from External Format 

Set the options and parameters you require in the Import from External Format 

wizard to convert data from another application into a format supported by CA 

ERwin DM. 

1. Select Import, From External Format from the File menu to open the Import 

From External Format wizard at the Overview page. 

2. Read through the overview information if necessary. You can clear the check 

box so that when you launch the wizard, it starts at the Source page instead 

of the Overview page. 

3. Complete the following fields on the Source page: 

Type 

Select a source type from which you want to import from the dropdown. 

This list is populated with the currently available bridges. 

Location 

Specify the location of the source file that you want to import. You can 

either enter the file name and location in the box, or click the  button 

to open the Open dialog to search for and select the file. If you do not 

have a file and location specified, the page is invalid and the Finish 

button is disabled. 

Validation 

Specify the type of validation that you want to perform on the import 

from the dropdown list. 

Parameters 

Edit the parameter values for the selected model source type within the 

grid as needed. You click on a parameter and then enter a value in the 

Value column. Required parameters have a red flag. If you do not enter 

a value for a required parameter, the page is invalid and the Finish 

button is disabled.  

4. Complete the following fields on the Destination page:  

Location 

Displays the location that you selected on the Source page. This is the 

location to which the imported file will be saved. The same file name is 

used but the file extension will be that of an CA ERwin DM model. If a file 

by this name already exists, then the import appends a number to the 

file name. For example, if you already have a file name of test.erwin, the 

import creates test1.erwin, and so on. You must have a location specified 

in the Location field, or you will not be able to complete the import 

process. Click the  button to open the Save As dialog to change the 

location of where the model will be imported and saved. 

Open Model 



How to Use the Metadata Integration Wizard 

 

Chapter 5: Working with Data Design Features  117  

 

The Open Model check box is selected by default. You select this check 

box to open the CA ERwin DM model you specified in the Location field. If 

you do not select the check box, the model is still saved, but it is not 

loaded into CA ERwin DM. 

Parameters 

Edit the parameters for creating the *.erwin or *.xml file as needed. You 

click on a parameter and then enter a value in the Value column. 

Required parameters have a red flag. If you do not enter a value for a 

required parameter, the page is invalid and the Finish button is disabled. 

5. Click the Finish button to start the conversion process. 

There is a tip text area located at the bottom of each page that displays helpful 

information about the active (selected) field. 
 

Disabled Location Field for Certain Import Bridges 

For certain import bridges, the Metadata Integration requires multiple input files 

to complete the import, rather than a specific location of one source file. When 

this is the case, the Location field on the Source page of the Metadata Integration 

Import Wizard is disabled. You must provide a bridge parameter in the 

Parameters grid that will specify the directory name of where the input files are 

located. 

The import bridges to which this applies is shown in the following list: 

■ CA COOL:Biz 5.1  

■ CA COOL:Enterprise (ADW) 2.7  

■ CA COOL:Xtras Mapper (TerrainMap for DB2)  

■ CA Gen 4.1a to 7.5  

■ Meta Integration Repository (MIR) XMI multimodel content  

■ Microsoft SQL Server Analysis Services 7.0 to 9.0 (via DSO)  

■ Microsoft SQL Server Reporting Services (File)  

■ MicroStrategy 7.0 to 8.1  

■ Telelogic (Popkin) System Architect 10.4 to 11.x (Encyclopedia)  

■ Telelogic (Popkin) System Architect 7.1 to 11.x (File)  

■ Visible IE:Advantage 6.1 
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Set Options for Export to External Format 

Set the options and parameters you require in the Export to External Format 

wizard to convert data in an CA ERwin Data Modeler model to a format supported 

by another application. 

1. Select Export, To External Format from the File menu to open the Export to 

External Format wizard at the Overview page. 

2. Read through the overview information if necessary. You can clear the check 

box so that when you launch the wizard, it starts at the Source page instead 

of the Overview page. 

3. Edit the parameters for exporting the *.erwin file as needed on the Source 

page. You click on a parameter and then enter a value in the Value column.  

Note: The export process will not complete unless you have saved the model 

before you start the export process. 

4. Complete the following fields on the Destination page: 

Type 

Select a destination type to which you want to export from the 

dropdown. This list is populated with the currently available bridges. 

Location 

This is the location to which the exported file will be saved. The same file 

name is used, however if a file by this name already exists, then the 

export appends a number to the file name. For example, if you already 

have a file name of test.dsx, the export creates test1.dsx, and so on. You 

must have a location specified in the Location field, or you will not be able 

to complete the export process. Click the  button to open the Save As 

dialog to change the location of where the model will be exported and 

saved. 

Parameters 

Edit the parameter values for the selected destination type within the 

grid as needed. You click on a parameter and then enter a value in the 

Value column. Required parameters have a red flag. If you do not enter 

a value for a required parameter, the page is invalid and the Finish 

button is disabled.  

5. Click the Finish button to start the conversion process. 

There is a tip text area located at the bottom of each page that displays helpful 

information about the active (selected) field. 
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Disabled Location Field for Certain Export Bridges 

For certain export bridges, the Metadata Integration requires multiple output 

files to complete the export, rather than a specific location of one file. When this 

is the case, the Location field on the Destination page of the Metadata Integration 

Export Wizard is disabled. You must provide information for the Directory 

parameter in the Parameters grid that will specify the directory name of the 

location of the output files. 

The export bridges to which this applies is shown in the following list: 

■ CA Gen 4.1a to 7.5 

■ IBM DB2 Data Warehouse Edition / Rational Data Architect  

■ IBM Rational Data Architect (RDA)  

■ Informatica Metadata Manager  

■ IRI CoSORT RowGen Data Definition File  

■ IRI CoSORT SortCL Data Definition File  

■ Meta Integration Repository (MIR) XMI multimodel content  

■ MicroStrategy 7.0 to 8.1  

■ Oracle Data Integrator- Beta  

■ Telelogic (Popkin) System Architect 10.4 to 11.x (Encyclopedia)  

■ Telelogic (Popkin) System Architect 7.1 to 11.x (File) 
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Complete Compare 

One of the most powerful tools CA ERwin DM provides is Complete Compare. It 

helps you easily compare and synchronize the object properties between a data 

model and its related database or another data model. 

The Complete Compare technology includes these features: 

Work with open models in real time 

When you select a model, database or script file, it opens as a model in the 

workplace and stays open during the compare process. Changes made to the 

models during compare are automatically made to the open models. You can 

save your models when you end the compare session, or use other features 

to update the database or replace the script file. 

Quickly perform simple or complex comparisons 

Screens in the non-sequential wizard allow you to quickly perform a simple 

compare, or set up the parameters for a complex compare. You move 

through the wizard using a navigation tool displayed in a static explorer 

window. You can use preset defaults and click Compare once to start the 

compare process. 
 

Save an entire compare session to an external (CCS) file 

You can save your compare session in a Complete Compare Session (CCS) 

file. You can then reload the saved session to instantly restore your previous 

selections, including model choices, and object and property filters. 

Customize Options Sets 

Customize the list of objects and properties you want to participate in the 

compare by creating an Option Set in the Type Selection dialog. You can save 

the Option Set as an external file, or with one or both of the models that 

participate in the compare. 

Search compare results 

Use the Find functionality in the Resolve Differences dialog to search the list 

of displayed differences. 

Create reports 

Use the Report functionality in the Resolve Differences dialog to prepare a 

custom report of your Complete Compare session. 
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The Complete Compare Wizard 

You use the Complete Compare Wizard to carry out four basic steps in the 

Complete Compare process: 

■ Select the models, script file, or database to compare. 

■ Select objects and properties to include in the compare process, and choose 

filter options. 

■ Resolve differences. 

■ Save your models. 
 

How Model Selection Works 

Select the models, script file, or database for the compare. Some of the typical 

compare scenarios you can use are: 

■ Compare your active data model open in the workspace with a model saved 

as an *.erwin file. 

■ Compare a data model with a script or database. 

■ Compare two databases or two scripts. 

■ Compare two unrelated models. 
 

Click Complete Compare, Compare on the Tools menu. The Right Model selection 

dialog opens by default. 
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You can work with models already open in the workplace, or you can use the 

Complete Compare wizard to open a model, or reverse engineer a database or 

script file. 

■ Select from the “Load From” choices to open a new *.ERWIN file, or compare 

to a database or script file. When you select the Database/Script option, the 

Reverse Engineer dialog opens, which allows you select specific options. If 

you have a connection to CA ERwin Model Manager, you can open a model 

from a library. 

■ Move the focus in the Open Models in Memory list to choose a model already 

open in the workspace. 
 

It is easy to navigate the panes of the Complete Compare Wizard - click the name 

of the pane in the static explorer area in the wizard to display that pane. 

 

Since the wizard is non-sequential, you can select as many or as few options as 

your want, and start the compare process at any time. 
 

After you select the Right Model, click Left Model in the navigation pane to open 

the Left Model Selection dialog. Select a model, database, or script file for the 

"Left Model" in the compare. 

Note: You can use the preset defaults for all the other options in the Complete 

Compare wizard. To accept the defaults and start the compare process, click the 

Compare button after you select the right and left models. 
 

Load a Model as Read-Only 

On either the Right Model Selection or Left Model Selection pane of the Complete 

Compare wizard you can select the "Set selected model as read-only" check box. 
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When you select the check box, the model is loaded as read-only. When you work 

with the model in the Resolve Difference dialog, you cannot make changes to it. 

Making one of the models read-only in a compare session creates a "one-way" 

compare scenario - you can move objects and properties from the model to the 

other model, but you cannot make changes to the read-only model. 
 

Allow Demand Loading 

When you work with a script file or database in Complete Compare, you can use 

the Allow Demand Loading check box to load only the names of top-level objects 

(tables, views, materialized views). This enables Complete Compare to load the 

database quickly since it is only comparing names at this point. 

When you align or perform an action on a partially loaded object in the Resolve 

Differences pane of the Complete Compare Wizard, the properties are fully 

loaded in order to complete the compare action. 

You suppress this default when you clear the Allow Demand Loading check box. 

Clear the Allow Demand Loading check box if you plan to work with the model 

you reverse engineered from the database or script file after using Complete 

Compare. 

 

If you do not clear Allow Demand Loading, the resulting model will only be 

partially loaded and will be missing the substructure of various object, tables, 

views, and so on. 

Allow Demand Loading is useful when you compare a small model or a small 

subject of objects to a large database. When you compare an entire large model 

to a large database, use of Allow Demand Loading is not appropriate. 

Note: When working with DB Sync, to optimize performance, demand loading is 

turned on by default. 
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Type Selection Compare Levels 

You can refine the compare process by applying filters and selecting the specific 

objects and properties you want to participate in the compare. 

Click Type Selection in the navigation pane to open the Type Selection dialog. 

You use features in this dialog to access type filtering options. 

 

You can choose from three Compare Levels, provided as check boxes near the 

top of the Type Selection pane. The default selection is based on the kind of 

models you selected for your left and right models. For example, if are working 

with a Logical/Physical model, you can select to include both the logical and 

physical level. If you are working with a logical-only model, all check boxes but 

Logical Level are grayed out. 

Logical Level 

Includes objects on the logical level 

Physical Level 

Includes objects on the physical level. 

Database Level 

Includes objects on the database level, and excludes some physical modeling 

properties such as graphic fonts, colors, drawing objects, and so on.  

Note: Check boxes can appear with a check (selected) or without a check (gray 

or empty). When a check displays in the box, it indicates that all the objects and 

properties lower on the tree are also selected. When the box is gray, it indicates 

that not all of the objects and properties lower on the tree are selected. An empty 

check box means that nothing is selected. 
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Refine the Criteria for Object Comparison 

You can further refine the criteria for object comparison between the left and 

right models. 

Use the Left Object Selection and Right Object Selection panes of the Complete 

Compare wizard to filter out specific objects for each model. 

I 

In the Choose Objects Using Sets window you can apply preset choices for 

common filter selections. For example, to filter by subject areas, triggers or 

ownership criteria. Filter out specific objects by clearing the check box next to the 

object name. The selected objects displayed in the Selected Object pane changes 

based on the kind of compare your are performing. For example, if your left 

model has been reverse engineered for Complete Compare, you can choose from 

selection sets that allow you to perform a complete compare on new objects, 

system objects, or matching objects. Choose from the following options: 

Choose Objects Using Sets  

Select this check box to use preset options for selecting objects sets, such as 

Subject Areas, Triggers, or objects by owner. The available sets appear in a 

tree in the wizard. Clear this check box if you plan to use a customized set of 

selected options from the object list. 

Selected Objects  

Displays the tree of model objects for the "Left Model". Select or clear the 

check box next to the object name.  

Hide Unselected Objects 

Select this check box to remove unselected objects from the Selected 

Objects display. This feature makes it easier to display the objects you 

selected, when you are working with a long object list. 
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After you have made choices for your left model in the Left Object Selection 

dialog, click Right Object Selection in the navigation pane to make choices for 

right model. 
 

Filter By Owner Name 

You can select to filter objects by owner in both the Left Object Selection pane 

and Right Object Selection panes of the Complete Compare wizard. When you 

indicate an owner name, the Selected Objects pane is automatically updated to 

reflect the appropriate list of owned objects. 

To filter by owner name 

1. Open the Complete Compare wizard to either the Left Object Selection or 

Right Object Selection pane. 

The pane includes a Choose Objects Using sets box, with an Object Tree. 

2. In the "Owned By' portion of the Object tree, select the check box for Owner 

List (case-sensitive) or Owner List (case insensitive), then right-click the text 

box.  

A Configure button appears. 

3. Click the Configure button. 

The DB Owner dialog opens. 

 

4. Enter your owner list and click OK. 

The Owner List is updated with the names you entered, and the Selected 

Objects tree is updated based on owner criteria. 

 
 



Complete Compare 

 

Chapter 5: Working with Data Design Features  127  

 

Advanced Options 

Additional filter options are available in the Advanced Options pane, for example 

to filter by table owner, or to apply a case-sensitive compare: 

 

The advanced options include: 

Auto-Dispose Database/Script Models 

When working with a database or script file in the compare wizard, select 

this check box to automatically close the model created from the 

database or script, when you end the compare session. The option to 

save the model is not displayed. 
 

Auto-Resolve Missing UDPs 

In some cases, the Type Resolution box appears when Complete 

Compare detects missing UDPs or property differences for common 

UDPs. You can select to skip the Type Resolution popup box when all the 

differences are due to missing UDPs. When you select this check box, all 

missing UDPs are automatically copied to the target model. 
 

Case-Sensitive Compare 

Perform a case-sensitive compare. This option affects both the alignment 

of objects in the object tree and the equality of property values in the 

property pane. When the option is cleared, case is ignored for the 

purposes of alignment and equality testing of text property values. 
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Database ID 

Match by Database ID. This option is available for Informix, Sybase, and 

SQL Server database servers only. When you select this option, objects 

are aligned based on the DB ID property if one is present. 

Object ID 

This option is available for the DB2 database server only. When you 

select this option, objects are aligned based on the Object ID property if 

one is present on the object. 
 

Display Unified Attributes 

Select this check box to simplify the display of foreign-key attributes in 

the Resolve Differences dialog. When selected, a Unified Attributes group 

object is used to display all unified attributes (role-named or not) of the 

same unified set of attributes.  

Any attributes that are aligned to the attributes under the Unified Group 

object appear as part of the Unified Group object, even if they are not 

unified attributes. 

The Unified Attributes group object carries the unified name if all the 

attributes under it are part of the same unified set. If not, the name 

consists of a comma-delimited list of names of all the attributes under it. 
 

Exclude Unaligned Objects in the Left Model 

Select or clear this check box to exclude or include unaligned model-level 

objects from the left model in the Resolve Differences dialog. Use this 

option as a filter to make it easier to distinguish between changes in a 

model subset you are working with (such as a subject area or submodel) 

and a larger model of with the subset is a part. 

Exclude Unaligned Objects in the Right Model 

Select or clear this check box to exclude or include unaligned model-level 

objects from the right model in the Resolve Differences dialog. Use this 

option as a filter to make it easier to distinguish between changes in a 

model subset you are working with (such as a subject area or submodel) 

and a larger model of with the subset is a part. 

Display Only Aligned Objects 

You can select to display only aligned model-level objects in the Resolve 

Differences dialog by selecting both the Exclude Unaligned Objects in the 

Left Model and Exclude Unaligned Objects in the Right Model check 

boxes. 

Ignore Code Comments 

Select this option to exclude blocks of comments from the body of a 

trigger, before including it in the compare process. This enables 

Complete Compare to recognize that a trigger has not changed, if the 

only difference is in the comment text attached to the trigger. 
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Prefix Owner 

Match by prefix table owner. When you select this option, objects are 

aligned based on both the name and owner name property. 

Transform Show As Target (Uncheck for Source) 

Select this check box to use the target view of transformed objects. Clear 

the check box to show the source view. 
 

Select Active Subject Area 

Specifies that you want to select the active subject area by default in the 

Object Selection pane. This simplifies the subject area selection, 

especially in models that contain a large number of subject areas. 

Using Name Matching 

Match by object name. When you select this option, relationship, index, 

and index members are aligned based on name, in addition to the normal 

criteria used to align these objects. 
 

Tablespace in Database 

This option is available for the DB2 database server only. When the 

option is set, objects are aligned based on both the IN_TABLESPACE and 

IN_DATABASE properties if present on the object. 
 

Include Only Generated Objects 

Each editor for a physical object includes a 'Generate' check box, which is 

selected by default. The 'Generate' check box  indicates that you want to 

generate SQL for this object during forward engineering. When working 

with a database-level compare, the 'Include Only Generated Objects' 

check box is selected by default. If you clear this check box, the compare 

session will also include those objects for which you cleared the 

'Generate' check box in the property editor. 
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Resolve Differences 

The most important step in the Complete Compare process is comparing 

differences and determining how to resolve them. The Resolve Differences dialog 

is a side-by-side display that shows the: 

■ Differences between the models, databases, or script files you selected for 

display in the left and right panes. 

■ Intended resolution for each difference. 

 
 

The toolbars give you quick access to all the compare options. You can reposition 

the five toolbars along the top of the dialog. Hold your mouse over an icon to 

display a tooltip for that feature. When you select a row in the object or property 

view area, the relevant toolbar options become active. 
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Resolve Differences Dialog 

Use the options in the Resolve Differences Dialog to compare the model in the left 

pane with the model in the right pane and resolve the displayed differences. You 

can view the differences on the object level, or more detailed property level. You 

can search the text of the comparison lists, and you can generate a report of the 

differences. 

Standard Toolbar (see page 132) 

Perform a specific action on a selected item in the list of differences. For 

example, you can copy an item from one model to the other, match or 

unmatch items, and generate a report. 

Impact Analysis Toolbar (see page 133) 

Invoke additional functionality as you resolve differences. You can view the 

Impact Analysis dialog and the Message Log, and generate an alter script for 

either the left or right model. 

Known Differences Toolbar (see page 134) 

Mark known differences and work with snapshots. You select rows that you 

do not want to display in the Resolve Differences dialog, and save the list for 

retrieval in a future Complete Compare session. 

Standard Filters Toolbar (see page 135) 

Filter the display of differences in order to refine the compare process.  

Navigation Toolbar (see page 136) 

Navigate the list of known differences, search for an item, and expand or 

collapse the trees. 

Object View 

Displays a list of differences between the models in an object tree. The status 

of the comparison is illustrated by an icon. For example, icons are displayed 

to show a conflict between objects, a resolved conflict, and so on.  

Property View 

Displays the properties for the selected object in the Object View pane.  

Explain 

Opens the Explanation dialog that displays alignment information for the 

selected row. 

Status Bar 

Displays the compare status of the current compare row. For example, "The 

left and right items are not equal". 
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Resolve Differences Standard Toolbar 

The following lists the buttons that you can use in the Resolve Differences 

Standard toolbar and describes the purpose for each button.  

 Copy item to the left 

Moves any items that do not match, from the right model to the left model. 

 Copy item to the right 

Moves any items that do not match, from the left model to the right model. 

 Match two items 

Matches two items. Use this feature to override automatic matching. You first 

select an object, click the match icon, then click an object or property with 

which to match the first object. The items then appear on the same line in the 

Object View. 

 Unmatch two items 

Unmatches any items that have been matched. 

 Undo 

Undoes the last operation. 

 Redo  

Redoes a previous undo operation. 

 Show Report 

Opens the Report Dialog to generate a report of the differences between the 

left and right models. 

 Help 

Opens online help for the Resolve Differences dialog. 
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Resolve Differences Impact Analysis Toolbar 

The Resolve Differences Impact Analysis and Reporting Toolbar includes 

shortcuts to the following options: 

 Action Log 

Displays a read-only version of the Action Log. The two-pane window tracks 

the actions made in the Resolve Differences dialog. You can use the Find 

feature to search through long lists of transactions. Click the report icon to 

open the Data Browser and create a report on the change differences. 

 Message Log 

Displays advisory messages in the Message Log dialog if you encounter these 

messages as you work in the Resolve Differences dialog.  

 Left Alter Script/Schema Generation 

Generates an alter script for the model in the left pane for a compare session 

that includes a database or script file. The Schema Generation Alter Script 

dialog opens, which guides you through the alter script generation. 

Note: Schema generation is not available when you resolve differences 

between a VSTS Database Edition project and a CA ERwin DM model. 

 Right Alter Script/Schema Generation 

Generates an alter script for the model in the right pane for a compare 

session that includes a database or script file. The Schema Generation Alter 

Script dialog opens, which guides you through the alter script generation. 

Note: Schema generation is not available when you resolve differences 

between a VSTS Database Edition project and a CA ERwin DM model. 
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Resolve Differences - Known Differences Toolbar 

Use features on the Known Differences toolbar to mark known differences and 

work with snapshots. The Known Differences toolbar includes shortcuts to the 

following options: 

 Save Known Differences Into a Snapshot 

Save known differences as a snapshot. The Save Snapshot dialog opens, 

where you can set options for saving the snapshot. 

 Load Known Differences From a Snapshot 

Load a saved snapshot to your current Resolve Differences session. The Load 

Snapshot dialog opens, where you can select the snapshot you want to load. 

 Mark/Unmark a Row as a Known Difference 

When you select a row, and then click Mark Known Difference, you hide the 

selected rows in the Resolve Differences display.  

Click a row, or press Crtl+click to select multiple rows, then click the Mark 

Known Difference icon. You can save marked rows as a snapshot when you 

click Save Snapshot after you mark known differences. 

 Show Known Difference Items 

Click this button to display known differences you hid using the Mark Known 

Differences option. This option is disabled when a snapshot is not active, or 

you have not marked rows as a known difference. 

 Show Differences that have changed since the last loaded Snapshot 

If you loaded a snapshot, you can click this button to display the rows (either 

the left or the right) for which the property value has changed since the 

snapshot was saved. 
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Resolve Differences - Standard Filters Toolbar 

The standard filter buttons allow you to change the display of differences in order 

to refine the compare process. You can select any combination of filters. To show 

only the differences between the models, cancel the selection for the "Show 

Equal" and "Show Resolved Items" buttons and select the three remaining 

buttons.  

 Show Equal Items 

Indicates that you want to display objects and properties that are the same 

in both models. 

 Show Resolved Items 

Indicates that you want to display property and object rows that were 

resolved into equal rows during your Resolve Differences session. When you 

click this icon, the rows are marked with the change indicator color and the 

change indicator symbol in the status column. 

 Show Not Equal 

Indicates that you want to display all of the differences between the objects 

and properties in both models. This filter is selected by default when the 

Resolve Differences dialog opens. 

 Show Unaligned Objects on the Right 

Indicates that you want to display objects that do not exist in the right 

model, but are present in the left model. This filter does not affect property 

rows. This filter is selected by default when the Resolve Differences dialog 

opens. 

 Show Unaligned Objects on the Left 

Indicates that you want to display objects that do not exist in the left model, 

but are present in the right model. This filter does not affect property rows. 

This filter is selected by default when the Resolve Differences dialog opens. 
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Resolve Differences Navigation Toolbar 

The following lists the buttons that you can use in the Resolve Differences 

Navigation toolbar and describes the purpose for each button. 

 Go to Previous Difference 

Highlights the previous object or property difference. 

 Go to Next Difference 

Highlights the next object or property difference. 

 Find an Item 

Searches for an object or property. 

 Find Next Item 

Searches again, using the search parameters already established. 

 Expand all 

Expands the lowest branch of the comparison tree. 

 Collapse all 

Collapses the deepest level of the comparison tree. 
 

Comparison Results 

The Complete Compare process presents the results of the compare in an object 

view and property view table. Items that do not match are tagged with the  

"Not Equal" icon. If a property is missing from one of the models, the cell displays 

cross hatches. You can scan the table of differences by using the scroll bar on the 

right of the table, or clicking the  "Next Difference" or  "Previous 

Difference" icon on the toolbar. 
 

Resolve Actions 

You resolve differences by synchronizing properties in your left and right model. 

To do this, you simply move objects or properties from one model to the other. 

When you select the row you want to work with, click the  Left or  Right 

button on the main toolbar, or click the smaller version of the same icons in the 

compare row. 

When items in the compare row match, no differences are displayed. The cross 

hatches disappear when the object properties match. 
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Save a Complete Compare Snapshot 

While you work in the Complete Compare Resolve Differences dialog, you can 

mark a row as a "known difference" and save your selections as a snapshot. 

When you mark a row as a known difference, you remove it from the list of 

differences displayed in the Resolve Differences dialog, effectively filtering it out 

of the compare scenario. 

Before you can save a snapshot of known differences, you first select the rows 

you want to include in the snapshot, then click the Mark Known Difference icon. 

To save a Complete Compare snapshot 

1. Click Complete Compare, Compare on the Tools menu. 

The Complete Compare Wizard opens. 

2. Make your selections in the Complete Compare wizard for the left and right 

model, and click Compare. 

The Resolve Differences Dialog opens. 

3. Select the rows you want to include in the snapshot, and click the Mark 

Known Difference icon  in the Resolve Differences Dialog. 

When you mark a row as a known difference the row and all dependent rows 

disappear from the display. 

4. Click the Save Snapshot icon . 

The Save Snapshot dialog opens. 

5. Complete the following fields: 

Left Model/Right Model 

You can save the snapshot with either or both models. The left model is 

selected by default. 

Snapshot Name 

Displays a name for the snapshot. To overwrite an existing snapshot, 

select it from the drop-down list. 

Description 

Displays an optional description for the snapshot. 

6. Click OK. 

The Save Snapshot dialog closes. 
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Load a Complete Compare Snapshot 

You can load a snapshot of known differences you saved previously. When you 

load a snapshot you apply the known differences established in the snapshot to 

your current compare session. The known differences identified in the snapshot 

are removed from the Resolve Differences dialog display. 

To load a Complete Compare snapshot 

1. Click Complete Compare, Compare on the Tools menu. 

The Complete Compare Wizard opens. 

2. Make your selections for the right and left model in the Complete Compare 

wizard and click Compare. 

The Resolve Differences Dialog opens. 

3. Click the Load Snapshot icon  . 

The Load Snapshot dialog opens. 

4. Select a snapshot from the list and click OK. 

The saved snapshot is loaded and the Resolve Differences display refreshes. 
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Manage Model Snapshots 

You use features in the Manage Model Snapshots dialog to work with snapshots 

you created during a Complete Compare session.  

Note: Since a snapshot is saved with the model, open the model that contains 

the snapshot before you begin this procedure. 

To manage model snapshots 

1. Click Complete Compare, Snapshot on the Tools menu. 

The Manage Model Snapshots dialog opens. 

2. In the Name list, select a snapshot with which you want to work. 

The dialog is populated with information from the saved snapshot. The 

following features appear in the dialog: 

Delete 

Deletes the selected snapshot. 

Left Model/Right Model 

Displays the path (read-only) for the model with which the snapshot is 

saved. 

Description 

Displays the description of the snapshot. Use the tools above the text 

entry area to cut, copy, paste, or edit text. 

3. Click OK. 

Your changes are saved and the dialog closes. 
 

Generate an Alter Script 

You can generate an alter script based on the changes made during your 

compare session. For example, if you are working with a database you reverse 

engineered to a model, you can generate an alter script that includes the 

changes made during the compare session. 

To generate an alter script 

1. Click the Left Alter Script  or Right Alter Script  icon in the Resolve 

Differences dialog. 

The Alter Script Schema Generation dialog opens. 

2. Follow the prompts to preview, print, save, and generate the schema. 
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Save Your Models 

When you start the Complete Compare wizard, your models remain open in the 

workplace. As you work in the Resolve Differences dialog, your open models are 

updated in "real-time." 

To save your models 

1. Click Finish in the Resolve Differences dialog to end your compare session. 

Note: You can make additional changes to the options in the wizard and 

compare again, or you can close the wizard. 
 

2. Click Close in the Complete Compare Wizard to close the wizard. 

Note: If the models that you compared were already open in the workplace, 

the models remain open. Use the standard Save options to save your work 

before closing the models. 

The Close Models Prompt opens when you work with models loaded from a 

file, or from a database or script file. 

3. Clear the check box for models you want to keep open in the workplace. If 

you select models to close, when you click OK, the Close dialog displays for 

each model, allowing you to save your changes. 

Note: If you are working with a database or script file reverse engineered using 

the Complete Compare wizard, you have several options to save your work. You 

can save the changes in a new model, you can generate an alter script to update 

the database, or you can save the changes in a new script file. 
 

Additional Complete Compare Functionality 

The power and versatility of the Complete Compare tool includes many additional 

features. Three important ones are: 

■ Create a Customized Option Set 

■ Save Your Complete Compare Session 

■ Create a Complete Compare Report 
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Manage Complete Compare Option Sets 

When you compare models, databases, or script files, a collection of all the 

objects and properties for your target server are displayed in a default option set 

on the Type Selection dialog. If you are working with a Logical/Physical model, a 

separate default option set is available for logical and physical objects. 

The option set consists of a hierarchical tree of objects and properties. You can 

select or clear a check box before each object or property name to create a 

customized list (for example, to exclude drawing objects from the compare). You 

can collapse or expand the different nodes of the property tree. 

Two default option sets are provided: 

Standard Default Option Set  

This option set filters out many objects and properties from the selection 

tree. It excludes "physical-only" object types, and includes a minimal set of 

property types. Use this default for standard compares where it is not 

necessary to include all objects and properties in the compare process. 

Advanced Default Option Set  

This option set includes all objects in the selection tree, except those that are 

assigned generated values during forward or reverse engineering. Use this 

default option set for advanced compares, in which you want all objects to 

participate in the compare process. 

You can create a customized option set and save it for future use. The option set 

can be saved with the left or right model, or as an external XML file. 
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Save a Complete Compare Option Set 

Two default option sets (Standard and Advanced) appear in the Complete 

Compare Type Selection dialog. You can save a complete compare option set 

customized with a different set of objects and properties. 

To save a complete compare option set 

1. Click Complete Compare, Compare on the Tools menu. 

The Complete Compare Wizard opens. 

2. Select the models, database, or script file you want to compare. Click Type 

Selection in the navigation pane. 

The Type Selection pane opens. 

3. In the Complete Compare Type Selection pane, make changes to the 

displayed option set by selecting or clearing the check boxes in the object 

property tree. Click the Save As icon. 

The Save As dialog opens. 

4. Select a destination and enter a name for the option set: 

Choose from the following destination options in the "Save To" box: 

■ XML file - Saves the option set to an external XML file. 

■ Left Model - Saves the option set with the model in the left pane of the 

current Complete Compare session. 

■ Right Model - Saves the option set with the model in the right pane of the 

current Complete Compare session. 

Enter a name for the option set in the Location/Option Set Name box: 

■ For an XML file, click  to name the file and select a location for the 

saved file. 

■ For an option set saved with the model, enter the Option Set name in the 

text box. 

Click OK. 

Your option set is saved. 
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Save a Complete Compare Session 

You can save all of the selections you make in the Complete Compare wizard, to 

a CCS (Complete Compare Session) file. The session file retains all compare 

criteria made in each pane of the wizard, including exact model names and 

locations, option sets, and so on. You can open the session at a later time and 

repeat the compare process using the same selections.  

This feature saves you time when you compare the same models, databases, or 

script files over time. For example, you can track the differences between 

generated DDL and its related data model over time by reusing a Complete 

Compare Session each time your model or DDL changes. 

To save a Complete Compare session 

1. Click Complete Compare, Compare on the Tools menu. 

The Complete Compare wizard opens.  

2. Use the panes in the Complete Compare wizard to select the compare 

criteria.  

Note: you cannot save a Complete Compare session until you make a 

selection for at least the right and left pane of the Complete Compare wizard. 

3. Click Save Session. 

The Save As dialog opens. 

4. Enter a name for your session. Click OK.  

Your session is saved as a new file with the *.CCS (Complete Compare 

Session) extension. 

Note: If you move or change the name of either model included in a saved 

Complete Compare session, you cannot load that session again. 
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Create a Complete Compare Report 

You can create a summary report for the differences displayed in the Resolve 

Differences pane of the Complete Compare Wizard. You can use the report to 

track changes to your models over time. The report includes a summary of the 

differences displayed in the Resolve Differences pane. 

To create a complete compare report 

1. Click the Show Report  icon on the Standard Toolbar of the Resolve 

Differences dialog. 

The Report Dialog opens. 

2. Choose one of the following formats in which to display the report: 

■ Default Internet Browser (*.HTML) 

■ Microsoft Word Document (*.doc) 

■ Microsoft Excel Workbook (*.xls) 
 

3. Click OK. 

The report opens in the selected viewer. 

Note: You can access online documentation for all the features available in the 

Complete Compare Wizard. The online help also contains more examples and 

procedures for other compare scenarios not covered in this Guide. Click the Help 

button on the Complete Compare wizard to open online help. Click Index in the 

Help dialog to search the online help index. 
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Chapter 6: Report on Your Data Model 
 

This section contains the following topics: 

The Report Template Builder (see page 145) 

The Data Browser (see page 151) 

The Query Tool (see page 170) 

Use Crystal Reports With CA ERwin Data Modeler (see page 174) 
 

The Report Template Builder 

You can use the Report Template Builder to easily and quickly create reports 

about your model. You can create reusable report templates and export results in 

txt (.csv), HTML, RTF, and PDF formats. You can view and save your reports to 

share with others using a web browser. You can also import components from 

reports created in the Data Browser to the Report Template Builder. 
 

The reporting user interface uses two main components: 

Report Templates Dialog 

Lets you quickly run a report on your open model using an existing template. 

Report Template Builder 

Lets you design a new report template and set customization options. 

You can run a report from either the Report Templates Dialog, or the Report 

Template Builder. 
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The Report Templates Dialog 

When you click the Report Builder on the Toolbar, or choose Report Builder on 

the Tools menu, the Report Templates dialog opens. 

Use the features on this dialog to run a report on your current model using an 

existing template. 

Available Templates 

Lists existing report templates in the current path. 

New 

Opens the Report Template Builder dialog where you can create a new report 

template and specify the content, format, and properties of the report. 

Edit 

Opens the selected report template in the Report Template Builder. 

Run 

Generates the selected report template to the output type you select (see 

Output Type below). 

Browse 

Opens a dialog where you can change the path. 

Output Type 

Select HTML, RTF, TEXT, or PDF as the output type (see Run above). 
 

Generate a Preformatted Report 

Before you create a new report template, you can run one of the preformatted 

reports available. 

To generate a preformatted report: 

1. Click the HTML Entity Primary Key.rtb report in the Available Templates 

pane. 

The description for the report displays in the Report Template Definition 

pane, and the output type automatically displays as HTML for this report 

template. 

2. Click Run to create the report. 

The report is created and your web browser automatically opens to display 

the HTML report. 
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New Report Template 

When you click the New button in the Report Templates dialog, the Report 

Template Builder dialog opens. This is where you specify the content, format, 

and properties of the report. 
 

Create a Report Title and Set Export Format 

When you create a new report, you should begin by assigning the report title and 

confirming the choices for generating a table of contents, and specifying the 

output format. 

To create a report title and set the export format 

1. In the Report Template Builder, select Document Untitled at the top of the 

Report Layout pane, and click the Properties button on the toolbar. 

The Properties dialog opens. 
 

2. Select the Has Table of Contents check box if you want the report to contain 

a table of contents. 

Note: This applies to HTML and RTF reports only. 
 

3. Select the export format. When you generate the report, the following 

report-viewing software is automatically launched: 

HTML 

Opens your browser. 

RTF 

Opens the local copy of a word processor, for example, Microsoft Word. 

TEXT 

Opens the required program for .CSV (Comma Separated Values) files, 

for example, Microsoft Excel. 

PDF 

Opens the Adobe Acrobat Reader to display the report. You can also save 

the report in PDF format. 

Note: You can specify export format details in the Export tab of the 

Properties dialog. 
 

4. Click the Title tab in the Properties dialog, and enter a title for the report 

template. You can also specify font and color options, and add macros to the 

text to add information such as the current model name and current date. 

The title options appear. 

5. Click the Header and Footer tabs in the Properties dialog to set header and 

footer text, fonts, and colors. 
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6. Click the Definition tab to enter the report template definition or any other 

information. The text you enter appears in the Definition box in the Report 

Templates dialog. 

7. Enter “Basic Report on Model:" directly over the Document Title, and be sure 

to place a space at the end of the title before performing the next step. 
 

8. Ensure that the Model name macro is selected and then click the Add Macro 

button. 

The macro is inserted into the Document Title field in the Properties dialog. 

The model's name will be appended to the report title. 

Note: Additional macros are available in the drop-down list. 

9. Select the Export tab of the Properties dialog and verify that HTML is the 

report output type. 

If HTML is not report output type, choose HTML from the Export As list. 
 

10. Select Picture Reports as Pop-Up Windows in the HTML Export Properties 

group box. This option creates pop-up links for the graphical elements in 

your HTML report output. 

11. Close the Properties dialog. 

The Report Template Builder pane opens. 

Note: If you prefer, you can keep the Properties dialog open while you create 

a report template. Just move the dialog to the side to give you more room to 

work. 
 

Add Sections to the Report Template 

You can quickly you can add report sections and report columns to your report 

template. A report section is a model object that has properties to report on. For 

example, Attribute, Domain, and Relationship are available report sections. 

To add a report section in the report template, double-click the section name in 

the Available Sections pane, or select the section then click the right-arrow 

button. Each section you add to the report template displays in the Report Layout 

pane with the default display columns. 
 

To add report sections to the report template: 

1. Open the Report Template Builder. 

2. Select Picture in the Available Sections pane, and click the right arrow. 

This section is added to the Report Layout pane. 
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3. Select Entity (in Logical Section) in the Available Sections pane, and click the 

right arrow. 

This section is added to the Report Layout pane. 

 
 

4. Double-click the Entity section in the Report Layout pane. 

The Properties dialog opens. The Property Tree for Entity includes all the 

properties you can select for this object. 

 

5. Click the plus sign to expand the Entity tree, and select the Name and 

Definition check boxes. 
 



The Report Template Builder 

 

150  Implementation Guide 

 

6. Click the plus sign to expand the Attribute tree, and select the Name check 

box. 

7. Close the window to return to the Report Template Builder. 

The properties you selected are now included in the Report Layout. 

8. Click Save on the Report Template Builder toolbar. 

Your report template is saved. 
 

Section Properties 

You can define additional properties to sections you have added to your report 

layout. Double-click anywhere in a section to open the Properties dialog with 

options for that section. 

For example, when you double-click the Entity section in the Report Layout pane, 

you can click the Section tab to display options to change the section name, and 

define fonts and colors. You can also set the section layout as hierarchical or 

tabular, and align the section name left, centered, or right. 
 

Table Properties 

When you create a report section, the Report Template Builder automatically 

creates a corresponding Table that lists the section columns. You can use the 

Properties dialog to change columns and to apply table properties such as the 

table name, fonts, and colors. 

For example, when you double-click the Entity Table item in the Report Layout 

pane, the Properties dialog opens. 

Select the Table tab to display options to change the table name, and define fonts 

and colors. You can also align the table name left, centered, or right. 
 

Report Template Preferences 

You set global preferences for your reports using the Preferences dialog. You can 

set the following report template preferences: 

■ General defaults that include specifying the text for the %Author and 

%Organization macros. 

■ Color and font defaults for the Title, Sections, Tables, Columns, Column cells, 

Headers, and Footers. 
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■ Export format defaults (HTML, RTF, PDF, and Text) and related properties. 

■ Specify a graphics file and URL to display on the first page of HTML reports. 

You can also use the Preferences dialog to apply formatting changes to existing 

report templates. 

To open the Preferences dialog, click Preferences on the Edit menu. 
 

Generate a Report 

After you have made the selections for you report layout, and have set report 

properties and preferences, you can generate a report. Select a report output 

from the Report Layout pane, then click the Run icon in the Report Template 

Builder toolbar to run the report. The report generates the selected output 

format and automatically starts the related application. 

■ For HTML output, the Report Template Builder generates HTML complete 

with links to diagram object properties. This is true for hierarchical, tabular, 

and picture reports. 

■ For RTF output, the Report Template Builder generates RTF output to MS 

Word complete with TOC field codes (if selected), title page, headings, and 

page breaks. 
 

■ For PDF output, the Report Template Builder uses the formatting preferences 

for RTF reports, but launches the Adobe Acrobat Reader to display the report. 

You can also save the report in PDF format. 

■ For TEXT output, the Report Template Builder generates text output to MS 

Excel. 
 

The Data Browser 

The Data Browser is a versatile and highly-customizable tool for browsing and 

generating reports on models and database information. 

If you are using the Data Browser without a connection to CA ERwin Model 

Manager, the Data Browser provides a set of predefined report types (categories) 

for models. Each report type contains a set of related options that you can 

include or exclude in your report. Some report types also provide built-in filtering 

and sorting options. You select a report category and use it as the basis for 

creating a report that includes only the options you want. Once you create the 

report, it appears in a reporting folder so you can print the report again. 
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The Data Browser shows the result set generated by the report, and adds a result 

set icon ( ) to the tree control under the report icon. You can then use the Data 

Browser features to customize the content and change the appearance of the 

result set. 

You can also use the Data Browser to search for and find the information you 

want in a result set. You can specify a search expression, which can include 

strings, numbers, or dates, for one or more columns so that the Data Browser 

finds only the result set rows that satisfy all the search expressions. You can find 

a change of value in a column and hide result sets rows that do not match the 

search. 

If you are using the Data Browser with a connection to CA ERwin Model Manager, 

the Data Browser provides two sets of predefined reports organized in a folder 

tree under two folders called General and MM Reports <MartName>. 
 

Standard Data Browser Reports 

The Data Browser includes a set of standard reports that you can use to report on 

your current model. The Standard report file (Standard.erp) resides in the install 

folder, by default, c:\Program Files\CA\ERwin Data Modeler\Reports. 

■ Entity reports 

■ Attribute reports 

■ Column reports 

■ Domain reports 

■ Model validation reports 

■ Subject area reports 

■ Table reports 

■ Stored procedure reports 

■ Relationship reports 

■ View reports 
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Create a Report 

You can use the Options tab in the Report Editor to specify the information you 

want to include in a report. The options you select become columns in a result set 

generated by the report. A pencil icon next to an option indicates that the 

corresponding column in the generated result set is editable. 

To create a report 

1. Click Data Browser on the Standard toolbar. 

The Data Browser opens. 

2. Click New report or folder on the toolbar. 

The New Object dialog opens. 
 

3. Double-click on the report item. 

The Reports dialog opens. 
 

4. Select the following options: 

Name  

Displays the name of the report. 

Category 

Displays type of report you want to generate. The options in the list 

change based on whether you click Logical or Physical. 

Logical 

Filters the Category list to show only those reports available for the 

logical model. 

Physical 

Filters the Category list to show only those reports available for the 

physical model. 

Option tab 

Edit  

Displays all report options in the Options list. 
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Show Selected Only 

Displays only the currently selected report options in the Options list. 

Show Selected  

Expands only folders in the Options list that contain selected items. 

Unselected items in these folders are also shown. 

Collapse All  

Closes all open folders except the first folder. 

Clear All  

Clears all previously selected options. 

Options  

Displays the information you can include in a report. The options 

available depend on the report type selected in the Category list. Expand 

or collapse each folder to select three possible types of options: 

Check box options 

Select the check box next to an option to include that information in the 

report. A pencil icon next to an option indicates that the corresponding 

column in the generated result set will be editable. 

Filter options 

Click the plus sign next to a Filter By folder to view the filtering options. 

Click one or more of the filter buttons to include only rows in the report 

that satisfy the filter options you select. 
 

Sort By options 

Click the plus sign next to a Sort By folder to view the sorting options. 

Click on one of the Sort By buttons to sort the report rows using the 

option you select. 

Definition tab 

Displays a definition for the report. 

Note tab 

Displays a note for the report. 
 

5. Click OK. 

The report is added to the tree control in the main Data Browser window. 

6. Click  Execute report. 

The report is run against the active model. 
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Edit a Report 

You can use the Options tab in the Report Editor to specify the information you 

want to include in a report. The options you select become columns in a result set 

generated by the report. A pencil icon next to an option indicates that the 

corresponding column in the generated result set will be editable. 

Important: When the report is run from the Entity/Table level asking for 

attribute/column names, and if some of the attributes/columns are marked as 

logical or physical only, or even if there is a difference between the number of 

displayed attributes and columns because of any transform, the report shows the 

displayed attributes and columns but the attributes and columns will not 

necessarily correspond to each other in the same line. This gives the appearance 

of mismatched attributes and columns, but the report is behaving as expected. If 

you want to see which attribute matches which column, then you need to run the 

report at the Attribute/Column level. 

To edit a report 

1. Click Data Browser on the Standard toolbar. 

The Data Browser opens. 

2. Expand the folder that contains the report you want to edit, select the report 

you want to edit, and click Edit properties on the tree control toolbar. 

The Report Editor opens. 
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3. Edit the reporting options from tree control: 

Options 

Select the check box next to an option to include that information in the 

report. A pencil icon next to an option indicates that the corresponding 

column in the generated result set will be editable. 

Filter options 

Click the plus sign next to a Filter By folder to view the filtering options. 

Click one or more of the filter buttons to include only rows in the report 

that satisfy the filter options you select. 

Sort By options 

Click the plus sign next to a Sort By folder to view the sorting options. 

Click on one of the Sort By buttons to sort the report rows using the 

option you select. 

Definition 

Edits the definition for the report. 

Note 

Edits the note for the report. 

Click OK. 

The report is updated. 
 

4. Click Execute report. 

The report is run against the active model. 
 

Generate a Report Using the Data Browser 

When you generate a Data Browser report, the Data Browser shows the result set 

generated by the report in the Result Set pane on the right side of the dialog. A 

result set icon is added to the tree control under the report icon. The following 

naming convention is used for reports: <Report Name> (<Time>, <Number of 

Rows>). 

To generate a report using the Data Browser 

1. Click Data Browser in the Standard toolbar. 

The Data Browser opens. 

2. Expand the folder that contains the report you want to generate, and 

double-click the report icon. 

The report is generated. The result set is displayed for the report in the 

Result Set area of the Data Browser window and a result set icon is added 

under the report in the tree control. 
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3. Edit the result set: 

■ Double-click an editable cell. A cell is editable when the cursor changes 

to a pencil when you drag the cursor over the cell. All editable cells in the 

select row change to editable text boxes. 

■ Edit the text in the cell. 

■ Click Save on the Data Browser toolbar to save your changes to the 

.erwin model. 

4. Customize the result set.  
 

Report (ERP) Files 

During installation, the setup program saves a standard Reports file 

(Reports.erp) in the same directory as the program files. The Reports file 

contains the names and definitions of predefined reports that are supplied, and 

the customized reports and report folders that you create. The Reports file 

contains the following information: 

■ The name of each report in the file, which includes a description of where the 

report is located in the folder hierarchy. 

■ The definition of each report, which includes the selected options that define 

the content and structure of the report. 

■ Formatting information for a report, if applicable. 

■ Definition text for a report, if applicable. 

■ Note text for a report, if applicable. 

The CA ERwin DM Reports list is created in the Data Browser based on the 

content of the .erp file. In addition, the Data Browser provides options on the 

Reports menu that you can use to create new .erp files, open different .erp files, 

and save the active .erp file using a different name. 

The name of the active .erp file is displayed as an extension to the Reports folder 

name in the tree control, for example, CA ERwin DM Reports [Myreports.erp]. 

The name of the active .erp file is also stored in the [REPORTS] section of the 

Erwin.ini file. Each time you open the Data Browser, the Erwin.ini file obtains the 

last selected Reports file, then it reads the Reports file and populates the Data 

Browser tree control. 

When you open a model created in an earlier version of the program, any named 

reports stored with the model are imported into a new folder called Reports from 

<model name> under the CA ERwin DM Reports folder and are automatically 

included in the Reports file. 

A backup copy of the default Reports file (Reports.erp) called REPORTS.ERK is 

kept, which you can use to restore the default set of reports, if necessary. 
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Control Duplicate Reports in the Data Browser 

When you create a report using the Data Browser, any duplicate items are 

automatically eliminated from the report. For example, you can run the 

preformatted report for Entity Name and Definition listed under Entity Reports in 

the CA ERwin DM Reports tree. The output displays only unique attribute names, 

while it does not list duplicate attribute names.  

You can change the report output by using features provided on the Report 

Format dialog to revise the report output to include duplicate entries. 

To control duplicates reports in the data browser 

1. Open a model that includes duplicate items. For example, open a model that 

has duplicate attribute names.  

The model displays. 

2. Click Data Browser on the Tools menu. 

The Data Browser dialog opens.  

3. Run a report that includes the duplicate item from your model and click 

Report format options. For example, if you have duplicate attribute names in 

your model, run the Entities/Attributes report found under Entity Reports on 

the CA ERwin DM Reports tree in the upper left pane of the Data Browser 

dialog. 

The Report Format dialog opens. You can also open this dialog when you 

right-click on the newly generated report in the Entities/Attributes tree and 

select the Edit report format option. 

4. Click the column that you want to use to display the duplicate items from the 

Column Options tab of the Report Format dialog. For example, click the 

Entity/Attribute Name column. With the selected column highlighted, click 

the Heading... button.  

The Column heading popup dialog opens. 

5. In the Column heading popup dialog, insert an exclamation point before the 

column heading name and click OK. For example, change the column 

heading Entity Attribute Name to !Entity Attribute Name.  

Your changes are saved and the Column heading popup dialog closes. 

6. Click OK in the Report format dialog.  

In the main Data Browser dialog, the duplicate items now appear in the 

column you selected for display. 

Note: When you run another report in the same category, the program defaults 

are again applied and no duplicate items appear. You must reset the report 

format for each report you create.  
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How Icons Identify the Data Browser Tree Control 

The tree control displays the Data Browser reports and result sets as an indented 

outline based on their logical hierarchical relationship. The caption bar above the 

tree control shows the currently selected root node of the tree. 

The meaning of each tree control symbol is shown below: 

■  Report Folder 

■  Report 

■  Editable Report 

■  Result Set 

■  Report View 

Shortcut menus are provided to perform functions on the objects displayed in the 

tree control. 
 

Display a History of Generated Result Sets 

Use the Result Set History dialog to display a list of all the result sets generated 

in the current session in chronological order. When you double-click on a result 

set in the Result Set History dialog, the result set displays in the Result set area 

in the Data Browser main dialog, and the icon for that result set is highlighted in 

the tree control. This is an easy way to locate the result set icon that corresponds 

to a result set. 

To display a history of generated result sets 

1. Click Data Browser on the Standard toolbar. 

The Data Browser opens. 

2. Click Display browse history. 

The Result Set History dialog opens. 
 

3. Select the result set you want to view and click the Display button.  

The Data Browser displays the selected result set and selects the result set 

icon in the tree control. 

4. Click Close. 

The dialog closes. 
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Customize a Result Set View 

You can change the formatting of the result set displayed in the Data Browser, 

including: 

■ The order in which columns are displayed. 

■ The appearance of each column (visible or hidden, bold, grayed). 

■ The column headings. 

■ The order in which the rows are displayed. 

■ Whether or not certain rows are displayed. 

■ The icons associated with report values. 

Once you have made your changes and you are satisfied with the way the results 

are presented, you can save them in a named report view. The report view 

appears in the tree control, and you can generate it just like a predefined report. 

This means that the work of developing an effective presentation needs to be 

done only once. A single report can have many views, and you can switch 

between views without regenerating your result set.  
 

Report Format Options 

The Report Format dialog includes two tabs. Use the options to select column 

format options and sort options. 

Columns Options Tab 

Use the features in the Columns Options tab to select specific columns you 

want to appear in your result set, and change the order and appearance of 

columns. 

Sort Tab 

Use the features in the Sort tab to customize your view of the result set by 

sorting on columns, or changing the order of sorted columns, or both. 
 

Select the Columns to Include in the Result Set 

You can use the Column Options tab in the Report Format dialog to select only 

the columns that you want in the result set. 

To select the columns to include in the result set 

1. Click Data Browser in the Standard toolbar. 

The Data Browser opens. 

2. Double-click on a report. 

The result set displays. 
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3. Click Report format options. 

The Report Format dialog opens. 

4. Click the Column Options tab, and select the Visible option in the Option list. 

Select the check box next to each column that you want to appear in the 

result set and click OK.  

The Data Browser redisplays the result set, which now contains only the 

columns you specified. 
 

Sort a Result Set on One or More Columns 

You can use the Sort tab in the Report Format dialog to customize your view of 

the result set. You can sort the result set on one or more column (ascending or 

descending) and change the order of the sorted columns. 

To sort a result set on one or more columns 

1. Click Data Browser in the Standard toolbar. 

The Data Browser opens. 

2. Double-click on a report. 

The result set displays. 
 

3. Click Report format options. 

The Report Format dialog opens. 

4. Click the Sort tab and select the check box next to the column in the Columns 

list box that you want to sort in the result set.  

The Data Browser displays the column you select in the Sort Columns list. By 

default, each new sort column is automatically assigned an ascending order 

sort type indicated by the  symbol next to the column. Repeat this step for 

each column that you want to sort. 
 

5. Optionally, select a column in the Sort Columns list and click the Ascending 

or Descending button to change the sort order type for the selected column. 

Repeat this step for each column that you want to sort. Click OK.  

The Data Browser displays the result set with the sort order you specified. 

Note: You can sort on any column in the result set regardless of whether it is 

displayed or not. A sort column can contain any type of data, such as numbers, 

strings, or dates. String sorting is independent of case. 
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Assign an Icon to a Result Set Value 

You can use the Icons dialog to assign an icon to a result set value so that each 

occurrence of the value is easily identifiable in a result set. Icons enhance your 

view of a result set and you can incorporate them into a report view. The Data 

Browser provides a set of predefined icons for this purpose. You can also specify 

the position of the icon (left, right, or centered) relative to the value. 

To assign an icon to a result set value 

1. Click Data Browser on the Standard toolbar. 

The Data Browser opens. 

2. Double-click on a report. 

The result set displays. 
 

3. Click Associate icons with result set values. 

The Icons dialog opens. 

4. Select the icon positioning option you want in the Style box, and drag the 

icon you want from the Icons list to a value in the currently displayed result 

set.  

The Data Browser assigns the icon you selected to each occurrence of the 

value in the result set. 

Note: To change the icon assigned to a value, drag the new icon to the value in 

the result set. 
 

Find Result Set Rows that Match the Specified Search Criteria 

You can use the Find in Result Set dialog to quickly find information in a result 

set. You can customize your search to find and mark the first row in the result set 

that satisfies your search conditions or all rows in the result set that satisfy your 

search conditions. 

To find result set rows that match the specified search criteria 

1. Click Data Browser on the Standard toolbar. 

The Data Browser opens. 

2. Double-click on a report. 

The result set displays. 
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3. Click Find in result set. 

The Find in Result Set dialog opens. 

4. Select the column on which you want to search and enter the search criteria 

in the String or Number Expression box. Use the text below the box as a 

guideline for the permitted expression syntax.  

After you specify an expression, a binocular symbol displays next to the 

column in the list. 
 

5. Define search expressions on other columns by choosing any of the following 

options: 

Find First  

Finds the first result set row that satisfies all of the search expressions 

you have defined for selected columns. The Data Browser displays a 

match symbol ( ) next to the first row where the column values match 

the search expressions. 

Find Next 

Finds the next result set row that satisfies the search expressions defined 

for the selected columns, click Find next in result set. 

Find All 

Finds and marks all result set rows that satisfy the search expressions 

defined for the selected columns. The Data Browser displays a match 

symbol ( ) next to all rows where the column values match the search 

expressions. 

To clear the search expression for a column, select the column, then click the 

Clear button. 
 

Find a Change of Value in a Result Set Column 

You can use the Find in Result Set dialog to quickly find information in a result 

set. You can customize your search to find and mark the rows in the result set 

where the value in a column changes from the previous value. 

To find a change of value in a result set column 

1. Click Data Browser on the Standard toolbar. 

The Data Browser opens. 

2. Double-click on a report. 

The result set displays. 
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3. Click Find in result set. 

The Find in Result Set dialog opens. 

4. Select the column in which you want to find a value change and the Find 

Value Changes check box and click Find First.  

The Data Browser displays a match symbol ( ) next to the first row where 

the selected column value changes. 
 

5. Select any of the following options: 

Find Next 

Finds the next change of value in the selected column. 

Find All 

Finds and marks all rows where the selected column value changes. The 

Data Browser displays a match symbol ( ) next to all rows where the 

column value changes. 
 

Hide Result Set Rows that Do Not Match Search Criteria 

You can use the Find in Result Set dialog to quickly find information in a result 

set. You can customize your search to hide all the rows in the result set that fail 

to satisfy your search conditions. 

To hide result set rows that do not match search criteria 

1. Click Data Browser in the Standard toolbar. 

The Data Browser opens. 

2. Double-click on a report. 

The result set displays. 
 

3. Click Find in result set. 

The Find in Result Set dialog opens. 

4. Select the column on which you want to search, enter the search criteria in 

the String or Number Expression box. Use the text below the box as a 

guideline for the permitted expression syntax.  

After you specify an expression, a binocular symbol displays next to the 

column in the list. 
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Optionally, repeat to define search expressions on other columns. 

5. Select the Hide Unmatched check box and optionally, select the 

Collapse/Expand check box to display the result set in outline and detail 

form. Click the Find All button.  

The Data Browser displays only rows that match the search criteria. If you 

selected the Collapse/Expand check box,  displays next to each matched 

value. Click  to view the unmatched values. 
 

Save a Data Browser Report 

You can save a report in a new reports file. 

To save reports in a new reports file 

1. Click Data Browser in the Standard toolbar. 

The Data Browser opens. 

2. On the Reports menu, select Save Report File As. 

The Save As dialog opens. 

3. Select a drive and directory, select a name for the Reports file, and click 

Save. 

The Reports File is saved with an .erp extension. 
 

Save a Report View 

After you make formatting changes to your result set, you can save them as a 

named report view, which functions exactly like a predefined report. The report 

view icon appears in the tree control under the report or the editable report on 

which it is defined, and you can generate it by double-clicking it. Report views 

also display in the Most-Recently Used list in the toolbar and in the Available 

Reports display for a result set row. You can even drop a result set row on an 

eligible report view to run the report. 
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A report view includes all result set format changes, including column ordering, 

heading changes, sorting options, icon assignments, and search criteria. You can 

define several report views for the same report. You can even switch between 

report views for the same result set without re-generating the report, simply by 

dragging the result set icon and dropping it on the report view you want to see. 

To save a report view 

1. Click Data Browser in the Standard toolbar. 

The Data Browser opens. 

2. Double-click on a report. 

The result set displays. 
 

3. Customize the report format and click Save view. 

The Save Report View dialog opens. 

4. Enter a name for the report view in the View Name box and optionally, if you 

want to include one or more parameters as part of the report view, select the 

check box next to each parameter you want to include. Enter a description of 

the report view in the Description box and click OK.  

The Data Browser saves the report view with the name you specify and adds 

a report view icon to the tree control under the report from which the view 

was generated. 
 

Print a Result Set 

You can print a result set.  

To print a result set 

1. Click Data Browser in the Standard toolbar. 

The Data Browser opens. 

2. Double-click on a report. 

The result set displays. 

3. Click Print on the File menu. 

The Print Result Set dialog opens. 

4. Work with the available printing options, then click OK. 

Your result set prints. 
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Set Print and Page Layout Options 

You can use the Print Result Set dialog to select the page range, the area of the 

result set to be printed, the number of copies, the output format, and the page 

width overflow options.  

To set print and page layout options 

1. Click Data Browser in the Standard toolbar. 

The Data Browser opens. 

2. Double-click on a report. 

The result set displays. 
 

3. On the File menu, select Print. 

The Print Result Set dialog opens. 

4. Select the print options you want.  

Page Setup 

Specifies layout, font, and text options for printing a result set. 

Print Preview 

Previews each page in a result set before you print it.  

Printer 

Opens the standard Windows Print Setup dialog. 
 

5. Click OK. 

The print and page layout options are set. 
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Page Setup Dialog Options 

You can use the Page Setup dialog to specify layout, font, and text options for 

printing a result set. The Page Setup dialog includes the following tabs: 

Layout  

Sets the style of the grid lines, the size of each margin, the page orientation, 

and the position of the image area on the printed page. A graphic in the lower 

right corner of the tab provides a visual indication of the page layout and 

highlights in red text the currently selected page setup parameter. 

Fonts  

Sets the font, size, and features of the various text elements such as column 

headings, in the result set printout. You can use fonts to enhance the 

appearance of a result set and make it easier to view and understand. 

Text  

Customizes the appearance of a result set printout by changing the default 

headers, footers, page numbers, and titles that appear on the printed result 

sets. 
 

Export a Result Set 

You can use the Export from Data Browser dialog to export a result set generated 

by the Data Browser to a comma-separated values (CSV) or HyperText Markup 

Language (HTML) file. You can also export a result set to RPTwin or another 

application that supports Dynamic Data Exchange (DDE), such as Microsoft 

Word.  

To export a result set from the Data Browser 

1. Click Data Browser on the Standard toolbar. 

The Data Browser opens. 

2. Double-click on a report. 

The result set displays. 
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3. On the File menu, click Export. 

The Export from Data Browser dialog opens. 

4. Select one of the following options in the Export format list: 

HTML 

Generates an HTML file. The resulting output can be displayed in any 

Web browser or imported into another application such as Microsoft 

Word or Excel. 

DDE 

Outputs the result set to another application that supports Dynamic Data 

Exchange (DDE) such as Microsoft Word. 

CSV 

Generates a comma-separated values (CSV) file. The resulting output 

can be imported by most spreadsheet applications including Microsoft 

Excel. 

RPT Win 

Outputs the result set to RPTwin. 

BRS File 

Outputs the result set to a BRS File. 
 

5. Select one of the available options in the Presentation group box: 

Tabular 

Exports the result set in a tabular format similar to the manner in which 

the result set is displayed on screen.  

Tabular with duplicates 

Exports the result set in a tabular format in which all values display, 

including those that are duplicated.  

Master-detail 

Exports the result set as a mix of headings and subtables. The Data 

Browser uses the relationships between model components to determine 

which values are printed in headings and which values are printed in 

tables.  

Indented 

Exports the result set as a mix of headings and lists. The Data Browser 

uses the relationships between model components to determine how the 

values are indented. 

Item per line 

Generates a result set as a list with one item on each line.  
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6. Select one of the following options in the Export to group box: 

File 

Exports the result set to a file. 

Clipboard 

Exports the result set to the Clipboard. This option is not available if you 

select DDE or RPTwin as the export format. 

7. Click Export. 

The result set is exported. 
 

Exit the Data Browser 

When you exit the Data Browser, any report views you create for future sessions 

are saved. However, report result sets are not saved. If you want to save your 

result sets for the next session, you must explicitly move them to a new folder.  

To exit the Data Browser, click Exit on the Data Browser File menu. 
 

The Query Tool 

The Query Tool provides an easy way to execute SQL SELECT queries against a 

model in CA ERwin Data Modeler or against a database catalog. You can execute 

a query against the objects and properties in the model, the metadata defining 

those objects and properties, and the action log that records the changes that 

are made to your model during the modeling session. 

You can create new queries or paste text from another source (such as a *.sql 

file) into a query. 

You can save a query to a .*qry file for later execution. Query results can be 

saved to a *.csv (comma-separated values) file. 

Although the Query Tool provides a built-in query interface in CA ERwin Data 

Modeler, you can also use any third-party reporting tool that has ODBC capability 

to query CA ERwin Data Modeler modeling data.  

Note: For more information on using CA ERwin Data Modeler's ODBC data 

sources with a third party tool, see the ODBC Reporting Guide, which is located in 

the Doc subdirectory of your CA ERwin Data Modeler installation. 
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Create a Query 

You can create a query (SELECT statement) by entering text directly in the Query 

box, or by pasting text from another source.  

To create a query 

1. Click Query Tool on the Tools menu. 

The Query Tool opens. 

2. Enter your query in the Query box, or click the paste button on the toolbar to 

paste a query from another source.  

Your query is ready for execution. Use other features in the Query Tool to 

execute and save the query. 

Note: Before you can execute a query you must be connected to ERwin ODBC or 

to a database. 
 

Open a Query 

You can work with queries you saved to a *.qry file in a previous session, or you 

can optionally use a *.sql, or Microsoft SQL Server Query file. 

To open a query 

1. Click Query Tool on the Tools menu. 

The Query Tool opens. 

2. Click the Open Query icon on the toolbar. 

The Open dialog opens. 

3. Select a *.qry or *.sql file and click open. 

The query text opens the Query box and is ready for execution. 

Note: Before you can execute a query you must be connected to ERwin ODBC or 

to a database. 
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Save a Query 

After you have created a new query or made changes to an existing query in the 

Query Tool, you can save your query to a *.qry file for future use. 

To save a query 

1. Click the Save Query icon on the toolbar in the Query Tool. 

The Save As dialog opens. 

2. Select a file name and location for your query, then click Save. 

Your query is saved and the Save As dialog closes. 

3. Click Close. 

The Query Tool closes. 
 

Execute a Query 

You can execute a new or saved query against the model or against a database 

catalog.  

Use the following process to execute a query: 

■ Open the Query Tool from the Tools menu. 

■ Create a new query or open an existing query (*.qry) file. 

■ Connect to ERwin ODBC or to a database. 

■ (Optional) Select the option to restrict row count and enter a number to 

indicate the number of rows by which to restrict results. 

■ Click the Execute  icon on the toolbar. 

After your query executes, the results display in the Results box. Use other 

features in the Query Tool to save the query or save your result set. 
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Execute a Query Against a Database 

You can run your query against a database catalog. To do this, you connect to the 

database from the Query Tool and then execute your query. 

Follow this process to run a query against a database: 

■ Open the Query Tool from the Tools menu. 

■ Create a new query or open an existing query (*.qry or *.sql) file. 

■ Click the Connect  icon on the toolbar. 

■ Enter the database-specific connection criteria in the Connect dialog.  

■ (Optional) Select the Restrict row count to check box and enter a number to 

limit the number of rows returned. 

■ Click the Execute  icon on the toolbar. 

After your query executes, the results display in the Results box. Use other 

features in the Query Tool to save the query or save your result set. 

Note: You cannot be connected to ERwin ODBC and a database at the same time 

in the Query Tool. If you are connected to ERwin ODBC, the (database) Connect 

icon is dimmed. Click the Disconnect  icon on the toolbar to disconnect your 

ERwin ODBC connection before you attempt to connect to a database. 

Important! Before you can make a database connection, the appropriate 

database client software must be installed. Read the Database Connection 

Overview (see page 110) for more information. 
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Execute a Query Against ERwin ODBC 

To run a query against the current CA ERwin Data Modeler model, you must first 

activate the ODBC connection. The connection may already be active, if you 

selected the option to start the ODBC driver on the Integrations tab of the 

Options dialog. 

To connect to ERwin ODBC 

1. Click Query Tool on the Tools menu. 

The Query Tool opens. 

2. Open a query (*.qry or *.sql) file or create a new query. 

Query text displays in the Query box and is ready for execution. 

3. Click the Connect to ERwin ODBC  icon on the toolbar. 

The ODBC connection is established. The Disconnect  icon becomes 

active. Use other features in the Query Tool to execute and save the query 

and result set. 
 

Use Crystal Reports With CA ERwin Data Modeler 

You can use Crystal Reports to query the CA ERwin DM metadata and build 

reports on an open model. Use this process to create a report: 

■ Start CA ERwin DM and open the models you want to report on. This ensures 

that the data source is loaded and available to Crystal Reports when you 

begin.  

■ Start Crystal Reports and identify ERwin or ERwin_Current as the current 

data source. You can do this when you create a Blank Report or work with the 

Report wizard. A user name and password are not required to access the 

ERwin data source - you can leave these fields blank and click Finish. 

Note: If you see a "Logon failed" message, it is probably because you do not 

have CA ERwin DM open. When you start CA ERwin DM, it loads the data sources 

and makes them available to Crystal Reports. 

■ Build your report from ERwin schema objects. For example, work with 

modeling data using the M0 Schema, metadata using the M1 schema, the 

EM0 schema, the EM1 schema, or the AL schema.  

For more information on the schemas, see the ODBC Reporting Guide, Chapter 3. 

For detailed information about the CA ERwin DM metadata, see the Metadata 

Reference Guide. Both guides are available from the Start menu, and are 

installed to the \Doc folder where you installed CA ERwin DM. 
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Chapter 7: Working with Design Layers 
 

This section contains the following topics: 

Design Layers (see page 175) 
 

Design Layers 

A design layer is a single data model or set of data models used for a particular 

purpose in the application development processes. Each design layer is part of a 

hierarchy of two or more design layers. 
 

In the simplest view of design layer hierarchy, the first design layer is a logical 

data model that captures the business requirements for an application. Then in a 

second design layer, those business requirements are transformed into database 

implementation rules in a physical data model. A generic physical model may be 

created using generic ODBC as the target database. A third design layer may 

represent different physical implementations of the same data model, but on 

different target server platforms. 
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Design Layer Hierarchy 

Generally, in a design layer hierarchy, different model types are used for a 

distinct purpose in the application development lifecycle. However, you must be 

able to develop and link related models in different design layers. Within each 

design layer, you must be able to make and record design decisions that 

transform the structure from one layer to another. Finally, you must be able to 

maintain the links between the models in different design layers and to 

synchronize changes made in different layers while maintaining the appropriate 

structures in each. The combination of linking models in different design layers 

using model sources and applying transforms within a model provide the 

capability to create a successful hierarchy. 
 

For example, a logical model may represent business requirements and rules. 

From that model, a generic physical model may be derived, in which physical 

constructs are designed for a generic database. Once the generic physical model 

is considered stable, you can derive from it multiple database specific models. In 

this way, the generic physical model becomes the standards model. 

A variety of features are necessary to support the separation of model types and 

to keep related models linked and in sync. 
 

Who Creates Design Layers 

Typically, the application development process involves many groups in an 

organization such as Standards Administrators, Business Analysts, Data 

Modelers, Data Administrators, and Database Administrators (DBA) who create 

design layers. 

Your application development requirements and methodology determine how 

many people or groups are involved in the process in your organization. 
 

The First Design Layer:  The Conceptual Logical Data Model 

CA ERwin DM delivers a superior approach to visualizing database structures and 

facilitating the design of Logical and Physical data models. This structured, 

systematic approach to information management and application development 

begins with a conceptual Logical model, the first of several design layers to 

capture your specific business requirements (including generic entities and 

supertype/subtype structures). 
 

The Second Design Layer:  The Generic Physical Model 

You use the generic physical model to establish the structure of the tables and 

columns and to create the generic naming needed to represent your business 

application. But, in the physical generic data model, the objects and properties 

are independent of a database. Other database-specific data models can be 

derived from a generic physical data model. 
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The Third Design Layer:  Database-specific Physical Models 

You can create a database-specific physical design layer that will be used for your 

database implementation. Each application can run on several database 

platforms; a final design layer is needed for database-specific data models. 
 

Enterprise Model Hierarchy 

In another example, the conceptual data model may instead be an 

enterprise-level data model, which establishes the standards for all applications 

across the organization. The enterprise-level data model may be Logical and 

include all of the approved standards for entities and attributes that the 

organization supports. The next design layer may have multiple Logical data 

models for multiple business applications, such as an Order Entry application and 

a Sales Commission application. 
 

While these are very different types of applications, it is likely that they share 

some common entities such as EMPLOYEE and CUSTOMER. The enterprise-level 

model may include both of these entities along with others that may not be 

selected for either of these application-specific models. In this hierarchy, the 

next design layer may be a generic Physical model for each application. If each 

application runs on several database platforms, a final design layer is needed for 

database-specific data models. 
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Data Warehouse Hierarchy 

A data warehouse requires additional layers for models of the entire warehouse 

and data marts. Options in the physical model for dimensional notation and for 

features related to data movement (data source information, data 

transformation rules) are provided that let you optimize for warehouse models. 

 
 

New Design Layers 

Many features support design layer architecture such as Split L/P Model, Derive 

New Model, Add Model Source, Link Model Source, and Sync with Model Source. 

All of the design layer features are wizard-driven, which means that you are 

guided through a series of dialogs to select the appropriate options and enter the 

necessary information. 
 

Split a Logical/Physical Data Model 

If you want to separate a logical/physical model into two models - a logical-only 

and a physical-only - you can use the Split L/P Model option, which is on the Tools 

menu. 

When you split a model, you are prompted to save the separate logical and 

physical data models with different names. When you save the new models, the 

logical model becomes the source of the physical model, which is necessary for 

synchronizing changes between the two model types. The original 

logical/physical model is preserved with its original name. 

To split a logical/physical data model 

1. Open a logical/physical model you saved previously.  

2. Click Split L/P Model on the Tools menu. 

The Split Model/Logical Save As dialog opens. 
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3. Save the logical side of the model with a new name. 

The Split Model/Physical Save As dialog opens. 

4. Save the physical side of the model with a new name. 

Note: If you are using CA ERwin Model Manager on the same computer, and 

have established a connection to the database, you can choose to save your 

new models to the CA ERwin MM database. 

The new logical and physical models, and the original logical/physical model 

remain open in the main workplace. 
 

The Derive New Model Wizard 

Whether you have a logical/physical model or a logical-only or physical-only 

model, creating a new model is easy. Rather than copying objects from one 

model to another or create a new one, the Derive New Model wizard takes a 

step-by-step approach to help you derive a new model from a model source. The 

original model is used as the source for the new model. When you work on the 

separate models, the changes to each model can be synchronized at any time. 
 

Derive a New Model 

Use the Derive Model Wizard to derive a new model from an existing model and 

transition from one design layer to another. 

Note: You must save your model before you derive a new model from it. 
 

To derive a new model 

1. Open an existing model, then click Derive New Model on the Tools menu. 

The Derive New Model wizard opens on the Target Model pane, and identifies 

your current model as the source model for the derive action. 
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2. Select the following options, and click Next: 

■ In the New Model Type group box, select Logical, Physical, or 

Logical/Physical. 

■ In the Create Using Template box, accept the default template, or 

browse for a template. 

■ Select a target database and version from the drop-down lists. 
 

Note: Because the wizard is non-sequential, you can start the derive process 

at any point when you click Derive. You can also customize the derive 

process using features on the other panes. For example, you can set the 

compare level, and select specific objects to derive. You can also use a 

customized option set of objects and properties. You can apply more object 

filters in the Object Selection pane, and indicate how transforms are handled 

during the derive process in the Options pane. 
 

The Type Selection pane of the wizard opens. 

 
 

3. Accept or edit the remaining defaults, and click Derive. 

Your new derived physical model appears in the main workplace. 
 

The Model Source 

A model source is the parent model that is linked to another model for the 

purpose of synchronizing changes. Hidden identifiers are automatically assigned 

to objects in the model source and the linked model. Changes made to both 

models are tracked using the object identifier. Then, you can synchronize the 

changes even if the object's name changes. 
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Sometimes building a design layer hierarchy requires linking two models that 

already exist rather than deriving a new model from an existing model. For 

example, you may have a generic model that you want to designate as the model 

source to other database-specific models. In this case, you can add the generic 

model as the model source to the database specific model. When you add a 

model source, you designate the objects and properties that you want the model 

source to contribute to the target model. 
 

Add a Model Source 

To add a model source, click Add Model Source on the Tools menu. The Add 

Model Source wizard uses a step-by-step approach to help you specify the 

objects that you want to add to the target model. The objects are added to the 

target model and links the objects so that you can later synchronize any changes. 

You can add multiple model sources if you want objects to be contributed by 

multiple models. After you add a model source, you can use the Model Sources 

Properties dialog to view and edit information about the model source. Choose 

Model Sources on the Model menu to open the Model Sources Properties dialog. 
 

The Link Model Source Wizard 

If you want to simply match existing objects in two models, creating a link 

between the objects, use the Link Model Source tool. Unlike the Add Model 

Source, Derive Model, and Sync with Model Source features, the Link Model 

Source tool creates no new objects in the target model. However, you can 

maintain or update linked objects using the Sync with Model Source tool. 

To link your current model to a source model, choose the Link Model Source 

option on the Tools menu. The wizard presents all the options you need for 

selecting a source model and creating the links. 

Regardless of which method you choose to build a design layer hierarchy, the 

ability to link models and synchronize changes between models is critical. 
 

Model Source Properties 

Whether you add a model source by splitting a model, deriving a model, adding 

a model source, or linking a model, CA ERwin DM keeps track of the model source 

and manages the links between the model and its source objects. 
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When you add a model source, a new object is created in the Model Explorer. 

Right-click the model source name in the Model Explorer and click Properties to 

open the Model Sources Properties dialog. Use features in this dialog to view 

general information, add a description, add user-defined properties, and change 

the model source naming rules. 

Note: You can also access the Model Source Properties dialog when you click 

Model Sources on the Model menu. 
 

The Sync with Model Source Wizard 

A relationship between a model and its source can be created as the result of 

splitting a logical/physical model, deriving a model adding a model source, or 

linking a model. Once a model has a model source, the changes to the objects 

that were contributed by the model source are automatically tracked. At any 

time, you can use the Sync with Model Source wizard to import and export 

changes between a model and its source. 

The Sync with Model Source wizard takes you step-by-step through the process 

of selecting the types of objects and changes that you want to compare and 

synchronize. You can also define case conversion and maximum length rules for 

logical and physical model objects, and specify a file to enforce naming standards 

in the target model. The result is a side-by-side list of changes that were applied 

to either the source and/or the target model. 

Whether you import or export changes, the models and the Model Sources 

Properties dialog are updated with the date of the synchronization. 
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Transforms 

A transform is a method by which you can apply and maintain a record of a 

design decision, which is a decision to change objects or properties within a 

design layer. When applied, a transform changes a set of objects from one state 

to another for the purpose of refining, normalizing, or denormalizing a model. 

The main advantages of using transforms include: 

Automation 

The refinement of the logical and physical model are simplified. You can use 

wizards to automatically apply design layer changes, instead of manually 

applying changes. 

Traceability 

Historical information for each model object that the transform creates is 

maintained. You can trace the history of transformed objects. 

Preservation of object properties 

The properties of the transformed objects are preserved. (You do not have to 

manually reenter the information.) 
 

Transform Wizards 

For each transform, a wizard is used to perform the transform steps. As you go 

through the wizard, you select options and respond to prompts. 

Before applying the transform, the wizard shows you the results that you get 

when the transform is complete. 

When you click Finish on the last page of the wizard, the participating objects are 

transformed into their new state and a record of the transform is added to the 

Model Explorer under Transforms. 
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Transform Toolbar 

The Transform Toolbar provides a set of tools to apply transforms. The model 

type and the objects that you want to participate in the transform determine 

which tools are available on the Transform Toolbar. Supported transforms 

include: 

 Many to Many 

 Supertype-Subtype Identity 

 Supertype-Subtype Rollup 

 Supertype-Subtype Rolldown 

 Vertical Partition 

 Horizontal Partition 

 Roll-Down Denormalization 

 Roll-Up Denormalization 

 Column Denormalization 
 

The toolbar also includes options to: 

 Show Transform Source Objects 

 Show Transform Target Objects 

 Reverse All Transforms 

 Resolve All Transforms 

In most cases, when you select the objects that you want to transform, the 

appropriate tools on the Transform Toolbar become available. For example, to 

apply a Supertype Subtype Rollup transform you must first select the 

supertype/subtype symbol. 
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How a Transform Works 

The Many-to-Many transform is probably the best example to demonstrate the 

transform process. To use this transform, you must have two entities connected 

by a many-to-many relationship. Often, to resolve this type of relationship, an 

association entity is added between the two original entities and connected to 

each with an identifying relationship. By using the Many-to-Many transform, the 

many-to-many relationship is automatically dissolved and replaced with an 

association entity and two identifying relationships. 
 

After selecting the many-to-many relationship line for the objects you want to 

transform, click the toolbar button to open the Many-to-Many transform wizard. 

Then, you simply respond to a series of questions that determine how the 

transform is applied. The wizard clearly lays out the post-transform results. 

When the transform is finished, the participating objects are transformed. 

 
 

Transform Default Options 

You can change the transform default options. In the example of the 

Many-to-Many transform wizard described above, by default the association 

table is named by combining the name of the two tables participating in the 

transform. As you work with the transform wizard, you have the option to change 

the default name of the association table that replaces the many-to-many 

relationship. 

Some transforms wizards include the option Reflect Changes Back to Source 

Objects. If you select this option, any change that you apply to the target 

(transformed objects) applies to the source objects as well. 
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Transform Name Options 

Every transform is assigned a default name that describes it. You can change the 

default name in the wizard or later in the Model Explorer (right-click the 

transform name in the Model Explorer to open a dialog that enables you to 

modify the properties). You can also add a note or a comment. 
 

Expected Transform Results 

Two important events occur when a transform is applied. The first is that the 

physical appearance of the participating objects changes to reflect the purpose of 

the transform. The second is more subtle, a record of the transform is added to 

the Model Explorer under the Transforms node of the object tree. 
 

Note: You can also understand the before and after state of the transform in 

terms of the Source display and Target display. 
 

Transforms and the Model Explorer 

Each time you apply a transform, the Model Explorer is updated with a new item 

on under the Transforms folder. The transform is identified by the name you 

assigned it in the transform wizard, or with a default name. Right-click the 

transform name to open the Modify Properties for Transform dialog. You use this 

dialog to modify any aspect of the transform from basic options (name, 

definition, UDPs) to specific parameters (such as partition criteria). 
 

Source or Target Display Options 

You can select to display either the source or target objects for a transform in 

your model. The display options vary slightly, if you are working in a 

logical/physical model, a logical-only model, or a physical-only model. The 

following defaults are used for new transforms: 
 

You can choose to display either the source or target objects in any model type 

for any transform. 
 

You can change the display for just one transform using the shortcut menu on the 

Model Explorer. Right-click the transform name and select either Show Target 

Objects or Show Source Objects. 
 

You can change the display for all the transforms in your model by selecting 

Show Transform Source Objects or Show Transform Target Objects from the Edit 

menu, or when you click the option on the Transforms Toolbar. Your display 

choice is reflected with a check next to the option on the Edit menu, and a change 

in the color contrast for the item on the Transforms Toolbar. Your choice is also 

saved with the model. 
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For Logical/Physical models you can use options on the Model Properties Dialog, 

General tab to set transform options. You can set a default to show transform 

source objects in the logical model, and target objects in the physical model. 

Options are also available to control how Many-to-Many and Supertype-Subtype 

relationships are resolved when you apply these transforms in a Logical/Physical 

model. 
 

Resolve and Reverse Transforms 

Two methods are provided for undoing a transform. You can resolve or reverse a 

transform. When you resolve a transform, the target model objects that the 

transform creates are preserved but the source objects are deleted.  

To resolve a transform, in the Model Explorer right click the transform name. 

From the shortcut menu, choose Delete and Resolve Transform. 

Note: If you have a model source linked to the model in which the transform was 

applied, the link between the transformed objects and the source objects in the 

model source is broken when the transform is resolved. 
 

When you reverse a transform, the source objects are preserved and the 

transform and the model objects that the transform creates are deleted . 

To reverse a transform, in the Model Explorer right click the transform name. 

From the shortcut menu, choose Delete and Reverse Transform. 

Note: If you want to reverse or resolve all the transforms in your current model, 

click the Reverse all Transforms or Resolve All Transforms icon on the Transforms 

Toolbar. 
 

Preserve Model History 

You can save historical information for your model, entities, attributes, tables 

and columns. Using the History feature, you can track meaningful changes to 

derived and transformed models, as well as routine information about the 

creation and revision dates of your models. 
 



Design Layers 

 

188  Implementation Guide 

 

Set History Options 

To set history options 

1. Click Model Properties on the Model menu. 

The Model Properties dialog opens. 

2. Select the History Options Tab. 

3. Select or clear the history options for the model objects whose history you 

want to preserve. 

You can save historical information for the following events: 

■ When you create a logical model and add entities and attributes. 

■ When you create a physical model and add tables and columns. 
 

■ When you derive a physical model from a logical model and create tables 

and columns in the derived physical model. 

■ When you split a logical/physical model into independent logical and 

physical components. 

■ When you apply a transform. 

■ When you reverse engineer a database or script file and create tables 

and columns in the new model. 

■ When you add a model source that contributes tables and columns to a 

model. 

■ When model objects are imported using Complete Compare, or via the 

API. 

4. Click OK. 

The Model Properties dialog closes. 
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Chapter 8: Naming and Datatype 

Standards 
 

This section contains the following topics: 

The Model Naming Options Dialog (see page 189) 

The Naming Standards Editor (see page 190) 

Check Name Compliance in a Model (see page 192) 

Name Hardening Wizard (see page 193) 

Datatype Standards (see page 196) 
 

The Model Naming Options Dialog 

There are a wide-range of naming standard features that can help you develop 

new standards or implement existing standards in your modeling environment. 

To manage naming standards, use the features available in the Model Naming 

Options dialog, and the Naming Standards Editor. 

Click Names on the Tools menu, then select Model Naming Options to open the 

Model Naming Options dialog. 

You use the features in this dialog to define the naming standards for the current 

data model. Some of the available features are described below. 

Specifying Case and Length Rules 

You specify the case and length rules for each model type on both the Logical 

and Physical tabs in the Model Naming Options dialog. 

Default settings are applied. However if you do specify the case and length 

for an object, when you close the Model Naming Options dialog, all object 

names are immediately changed to match your preferences. 

Mapping Logical and Physical Names 

You set name mapping preferences on the Name Mapping tab. By default, a 

macro is applied to define the object name, but you can replace the default 

macro by opening the macro toolbox. You can also specify that the attached 

glossary file (.nsm) be the source of the name and abbreviation for some 

objects. 

You can also supply a Prefix and/or a Suffix to the default object name and 

define how special characters and spaces in a logical name map to a physical 

name. 
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Specifying Duplicate Name Rules 

On the Duplicate Names tab, you can specify your preferences for how 

duplicate entity and table names are handled in a model. The preference 

options include: 
 

Allow 

Permits duplicate names. 

Rename 

Renames the duplicate name by appending to the end of the name a 

forward-slash to indicate that the name has been used in the model and 

a number to indicate how many times (for example, MOVIE_COPY/2). 

Ask 

Gives you the opportunity to keep the duplicate name or enter another 

name. 

Disallow 

Requires you to change the duplicate name to a unique name. 
 

Attaching a Naming Standards File 

On the General tab, you can specify the name of the Naming Standards file 

that you want to attach to this model. 

When you attach a naming standards file to a data model, the standards and 

conventions defined in the file are automatically applied. You can also use the 

file to check compliance of the names of objects in the model, which is similar 

to a spell checker in a word processing application. The naming standards file 

is used as a dictionary and compares the names in the data model to the 

names in the dictionary. When it finds a discrepancy, you decide whether to 

ignore or replace the non-compliant name. 
 

The Naming Standards Editor 

Click Names on the Tools menu, then click Edit Naming Standards to open the 

Naming Standards Editor. 

You use the features in the Naming Standards Editor to specify separate naming 

standards for logical and physical objects. 
 

In the Glossary tab on the Naming Standards Editor, you can either import an 

existing names glossary or build one from scratch. You can define how these 

standards are implemented, and create entries including business terms, and 

abbreviations, that are relevant to your business. Naming standards information 

is saved in a naming standards file (*.nsm). For each model in which you use 

naming standards, you must attach a naming standards file. You can apply a 

naming standards file to multiple models. 
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Object Name Syntax 

The syntax of logical and physical object names can be classified into the 

following parts: 

Prime Word 

Describes the subject area of the data such as Account, Employee, and 

Customer. 

Class Word 

Designates the major classification of data that is associated with a model 

object such as Date, Amount, Rate, Number, Code, or Name. 

Modifier (or qualifier) 

A word that further defines or distinguishes the prime and class words. For 

example, you can use the modifier Last to further define the Name class word 

or the modifier Corporation to further define the Employer prime word. You 

can specify up to two modifiers. 
 

When you click the Logical or Physical tab in the Naming Standards Editor, you 

see a list of pre-defined objects in the first column. For each object type, you can 

use the additional columns to specify the syntax for each part of the object's 

name. So, for example: 

■ For Entities, the first part is typically a Prime Word, such as EMPLOYEE. 

■ For Attributes, the first part is typically a Prime Word followed by at least one 

Modifier such as Employee Address. 

■ For Domains, the first part is typically a Class Word, such as Number. 
 

Object Names Glossary 

The Glossary consists of logical and physical object names. You can import an 

existing glossary or create one from scratch by typing object names and 

abbreviations directly into the editor. You can also specify the syntax parts 

associated with a particular object type (i.e., prime, modifier, and class). 
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Save a Naming Standards File (.nsm) 

After you define the naming standards, you need to save it in the Naming 

Standards editor to attach it to models. 

To save a Naming Standards file 

1. Click Save As on the File menu. 

The Save As dialog opens. 

2. Enter the file name, select NSM as the file type, and click Save. 

Your file is saved and the dialog closes. 
 

Check Name Compliance in a Model 

After you attach a naming standards file, you can use it to check the names in the 

data model. It works like a spell checker in a word processor. 

To check name compliance in a model 

1. Select Names from the Tools menu, and click Check Standards Compliance. 

The Check Name Standards Compliance dialog opens. 

2. Select the objects whose names you want to check for conformance. Also, 

check the box if you want to check word order and position conformance. 
 

3. Click Start. 

The name checking process begins, and when it finds a non-conforming 

name, it presents the name in the Non-conforming Name box. 

4. Select to either ignore or replace the non-conforming words. 
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Name Hardening Wizard 

The Name Hardening Wizard provides a way to override inheritance of names 

and block name changes or resets within a model. Using the wizard, you can 

select the object types and object instances for which you must harden logical 

names or physical names, or both, within the model instead of using the 

inherited name values.  

You can harden names in this wizard for the following object types: 

■ Attributes/Columns 

■ Default value 

■ Domains 

■ Key groups/Indexes 

■ Relationships 

■ Entities/Tables 

Note: See the information about entity name hardening in the Type 

Selection section. 

■ Validation rules 

The wizard also includes the flexibility to specify whether to override name 

inheritance for all object instances of the selected object types, a subset of those 

object instances, or a specific object instance using the various pages of the 

wizard. The wizard contains four pages: 

Overview 

Contains an overview of the Name Hardening Wizard. 

Type Selection 

Displays the available object types that you can select for which you want to 

override inheritance such as Attributes, Default Values, and Domains. To 

make object type selection easier, you can right-click anywhere on this page 

to display a context menu where you can select either the Select All or Select 

None option. The options you select on this page are reflected in the next 

page of the wizard, the Object Selection page.  

Note: While you are able to select the Entity check box in the Type Selection 

page in a logical model, name hardening can only be enabled in the physical 

model. Logical entity names are not inherited names; they are set on the 

entity object. Therefore, they do not change and there is no need to harden 

them. 

Object Selection 
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Specifies the model objects or groups of model objects (collection nodes) for 

which you want to override inheritance. When you have transitioned to this 

page from the Type Selection page, all the selections that you made on the 

Type Selection page are listed and selected on this page. 

The collection nodes have check boxes that summarize the state of the 

objects under that node (subordinate objects). The check boxes for the 

collection nodes have three states. If none of the subordinate objects are 

selected, the check box for that collection node is not selected. If all the 

subordinate objects are selected, then the check box for that collection node 

is selected. If some of the subordinate objects are selected, then the check 

box for that collection node is selected, and is also shaded. Clicking the 

collection node check box allows toggling of the selection of the entire set of 

subordinate objects. In addition, you can right-click anywhere on this page 

to display a context menu where you can select either the Select All or Select 

None option. Any selections you make to the Selection Sets section on this 

page are immediately reflected in the Selected Objects section. 

Action 

Reflects the current name hardening settings for the selected objects. The 

Logical and Physical columns indicate the status of the objects and the 

Selected Objects column lists their fully qualified names, for example, 

instead of simply 'a,' an attribute name would be 'OwnerName.E/1.a.' Also, 

each object has a check box for selection; if you want to override inheritance, 

or harden, select a check box for the object; clear a check box for an object 

for which you want to unharden the name. When you unharden an object 

name, the same name you used in the hardening process remains, however, 

now you can edit or reset that name (editing or resetting of hardened names 

is not allowed).  

Note: Unhardening an object name does not automatically restore 

inheritance, it only allows the names to be reset or changed. 

Note: If you prefer, you can select all the objects directly on the diagram, launch 

the wizard, and go directly to the Action page. The objects you select on the 

diagram populate the Type Selection and Object Selection pages. 
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Override Name Inheritance 

You can select the object types and object instances for which you need to set 

logical and physical names within the model instead of using the inherited name 

value, or for which you need to block name changes. 

To override name inheritance 

1. Click Names, Name Hardening from the Tools menu. 

The Name Hardening Wizard opens. 

2. In the left pane, click Type Selection. 

The Type Selection page opens. 

3. Select the object types for which you want to override inheritance, then click 

Object Selection. 

The Object Selection page opens. 

4. Select the model objects for which you want to override inheritance, then 

click Action. 

The Action page opens. 

5. Select the check box for each item for which you want to override 

inheritance, then click Finish. 

Inheritance is overridden for each item you selected, and the Name 

Hardening Wizard closes. 
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Unharden Object Names 

If you used the Name Hardening Wizard to set the names of selected object types 

or object instances (or both) in order to remove inheritance, you can unharden 

the names of those selected object types and object instances using the Name 

Hardening Wizard as well. When you unharden an object name, the same name 

you used in the hardening process remains, however, once the unharden process 

is complete, you will have the ability to edit or reset that name (editing or 

resetting of hardened names is not allowed). 

Note: Unhardening an object name will not automatically restore inheritance, it 

only allows the names to be reset or changed. 

To unharden object names 

1. Click Names, Name Hardening from the Tools menu. 

The Name Hardening Wizard opens. 

2. In the left pane, click Type Selection. 

The Type Selection page opens. 

3. Select the object types that you want to unharden, then click Object 

Selection. 

The Object Selection page opens. 

4. Select the model objects that you want to unharden, then click Action. 

The Action page opens. 

5. Select the check box for each item for which you want to unharden the 

names, then click Finish. 

The name for each object that you selected is unhardened, and the Name 

Hardening Wizard closes. 
 

Datatype Standards 

A datatype is a predefined set of characteristics for an attribute or column that 

specifies field length, acceptable characters, and optional and required 

parameters. For example, the datatype char(18) specifies that the column can 

store up to 18 alpha and numeric characters. 
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By default, a datatype is applied to every attribute in a logical model and to every 

column in a physical model. In the logical model, the datatype is determined by 

the domain from which the attribute inherits its properties or from the datatype 

that you assign. In the physical model, the datatype is determined by the default 

value specified by the target server or the datatype that you assign. Considering 

the large quantity of attributes or columns a data model usually has, it can be 

quite tedious to manually assign and maintain consistency of datatypes. For this 

reason, there are several tools that help you with this task. 
 

The Datatype Standards Editor 

Use the Datatype Standards Editor to edit the default datatype mapping for your 

logical and physical models. For physical models, you can edit the default 

datatype that is automatically attached to each column. For logical models, you 

can add logical datatypes and assign the datatypes to the attributes in the logical 

model. 
 

To open the Datatype Standards Editor, click Datatypes on the Tools menu and 

then click Edit Datatype Standards. The Datatype Standards Editor opens: 

You define the datatype mapping standards by specifying how logical datatypes 

map to the available datatypes for your target server. If you have database 

applications running on multiple server platforms, you can map datatypes for all 

of the target servers. Datatype mapping information is saved in a datatype 

standards file (*.dsm). For each model in which you use datatype standards, you 

must attach a datatype standards file. If you open a model and you have not 

attached a datatype standards file, the default datatype mapping is used. 
 

Create a Datatype Mapping List 

You use the Insert New Mapping feature in the Datatype Standards editor to map 

a datatype from one target server to another. You also use this feature to add a 

new datatype. 

To create a datatype mapping list 

1. In the Datatype Standards Editor, click Insert New Mapping on the Mapping 

menu. 

2. Click the down arrow on the From list, and select the target server from 

which you want to map. 
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3. Click the down arrow on the To list and select a target server to which you 

want to map. 

The From and To columns are populated with the default mappings for the 

selected target servers. Notice that the datatype row at the bottom of the list 

is blank. 

4. Click in the blank cell at the bottom of the From list and enter a new datatype 

name. 

5. Click the blank cell at the bottom of the To list and select the datatype that 

you want to assign from the drop-down list. 
 

Save a Datatype Mapping File (.dsm) 

After you define the datatype standards, you need to save it in the Datatype 

Standards editor to attach it to models. 

To save a datatype mapping file (.dsm) 

1. From the File menu, choose Save. 

The Save As dialog opens. 

2. Enter the file name, select DSM from the file type list, and click Save. 

The file is saved and the dialog closes. 
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The Model Datatype Options Dialog 

You can define your datatype mapping standards once and apply them to 

multiple data models. When you click Datatypes on the Tools menu and then click 

Model Datatype Options, you can specify the datatype mapping file that you want 

to apply to the current model. 

 
 

Attach a Datatype Standards File to a Model 

To activate datatype mapping in your model, you open a data model and attach 

the datatype standards file to the model. 

To attach a datatype standards file to a model 

1. Click Datatypes on the Tools menu, then click Model Datatype Options. 

The Model Datatype Options dialog opens. 

2. Click Use File, then click the Browse button to locate the file that you want to 

attach. 

The Set Location dialog opens. 
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3. Select the file to attach, and click Set. 

The Set Location dialog closes. 

4. Click OK. 

The editor closes and the datatype standards file is attached and applied to 

the current model and all models derived from the current model. 
 

Datatype Standards Reuse 

After you define and save your datatype standards, you can reuse the files by 

attaching them to other models. 

While it may take some time to establish and implement these standards across 

your enterprise, CA ERwin DM helps you take the initial steps and supports your 

ongoing efforts to maintain standards. 

You can enforce consistency in all of your data models, databases, and 

applications. 
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Appendix A: Third-Party 

Acknowledgements 
 

Meta Integration Technology, Inc. 

CA ERwin Data Modeler's metadata import/export capabilities are powered by 

Meta Integration® Model Bridge (MIMB), copyright 1997-2009. 

Meta Integration is a registered trademark of Meta Integration Technology, Inc. 

in the United States. 
 

Apache Software Foundation 

Portions of this product include software developed by the Apache Software 

Foundation. The Apache software is distributed in accordance with the following 

license agreement. 

Apache License 

Version 2.0, January 2004   

http://www.apache.org/licenses/  
 

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION  

1. Definitions.  

"License" shall mean the terms and conditions for use, reproduction, and 

distribution as defined by Sections 1 through 9 of this document.  

"Licensor" shall mean the copyright owner or entity authorized by the copyright 

owner that is granting the License.  

"Legal Entity" shall mean the union of the acting entity and all other entities that 

control, are controlled by, or are under common control with that entity. For the 

purposes of this definition, "control" means (i) the power, direct or indirect, to 

cause the direction or management of such entity, whether by contract or 

otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding 

shares, or (iii) beneficial ownership of such entity.  
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"You" (or "Your") shall mean an individual or Legal Entity exercising permissions 

granted by this License.  

"Source" form shall mean the preferred form for making modifications, including 

but not limited to software source code, documentation source, and 

configuration files.  

"Object" form shall mean any form resulting from mechanical transformation or 

translation of a Source form, including but not limited to compiled object code, 

generated documentation, and conversions to other media types.  

"Work" shall mean the work of authorship, whether in Source or Object form, 

made available under the License, as indicated by a copyright notice that is 

included in or attached to the work (an example is provided in the Appendix 

below).  

"Derivative Works" shall mean any work, whether in Source or Object form, that 

is based on (or derived from) the Work and for which the editorial revisions, 

annotations, elaborations, or other modifications represent, as a whole, an 

original work of authorship. For the purposes of this License, Derivative Works 

shall not include works that remain separable from, or merely link (or bind by 

name) to the interfaces of, the Work and Derivative Works thereof.  
 

"Contribution" shall mean any work of authorship, including the original version 

of the Work and any modifications or additions to that Work or Derivative Works 

thereof, that is intentionally submitted to Licensor for inclusion in the Work by 

the copyright owner or by an individual or Legal Entity authorized to submit on 

behalf of the copyright owner. For the purposes of this definition, "submitted" 

means any form of electronic, verbal, or written communication sent to the 

Licensor or its representatives, including but not limited to communication on 

electronic mailing lists, source code control systems, and issue tracking systems 

that are managed by, or on behalf of, the Licensor for the purpose of discussing 

and improving the Work, but excluding communication that is conspicuously 

marked or otherwise designated in writing by the copyright owner as "Not a 

Contribution."  

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of 

whom a Contribution has been received by Licensor and subsequently 

incorporated within the Work.  
 

2. Grant of Copyright License. Subject to the terms and conditions of this 

License, each Contributor hereby grants to You a perpetual, worldwide, 

non-exclusive, no-charge, royalty-free, irrevocable copyright license to 

reproduce, prepare Derivative Works of, publicly display, publicly perform, 

sublicense, and distribute the Work and such Derivative Works in Source or 

Object form.  
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3. Grant of Patent License. Subject to the terms and conditions of this License, 

each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, 

no-charge, royalty-free, irrevocable (except as stated in this section) patent 

license to make, have made, use, offer to sell, sell, import, and otherwise 

transfer the Work, where such license applies only to those patent claims 

licensable by such Contributor that are necessarily infringed by their 

Contribution(s) alone or by combination of their Contribution(s) with the Work to 

which such Contribution(s) was submitted. If You institute patent litigation 

against any entity (including a cross-claim or counterclaim in a lawsuit) alleging 

that the Work or a Contribution incorporated within the Work constitutes direct or 

contributory patent infringement, then any patent licenses granted to You under 

this License for that Work shall terminate as of the date such litigation is filed.  
 

4. Redistribution. You may reproduce and distribute copies of the Work or 

Derivative Works thereof in any medium, with or without modifications, and in 

Source or Object form, provided that You meet the following conditions:  

 (a) You must give any other recipients of the Work or Derivative Works a copy of 

this License; and  

 (b) You must cause any modified files to carry prominent notices stating that 

You changed the files; and  

 (c) You must retain, in the Source form of any Derivative Works that You 

distribute, all copyright, patent, trademark, and attribution notices from the 

Source form of the Work, excluding those notices that do not pertain to any part 

of the Derivative Works; and  
 

 (d) If the Work includes a "NOTICE" text file as part of its distribution, then any 

Derivative Works that You distribute must include a readable copy of the 

attribution notices contained within such NOTICE file, excluding those notices 

that do not pertain to any part of the Derivative Works, in at least one of the 

following places: within a NOTICE text file distributed as part of the Derivative 

Works; within the Source form or documentation, if provided along with the 

Derivative Works; or, within a display generated by the Derivative Works, if and 

wherever such third-party notices normally appear. The contents of the NOTICE 

file are for informational purposes only and do not modify the License. You may 

add Your own attribution notices within Derivative Works that You distribute, 

alongside or as an addendum to the NOTICE text from the Work, provided that 

such additional attribution notices cannot be construed as modifying the License.  

 You may add Your own copyright statement to Your modifications and may 

provide additional or different license terms and conditions for use, reproduction, 

or distribution of Your modifications, or for any such Derivative Works as a whole, 

provided Your use, reproduction, and distribution of the Work otherwise complies 

with the conditions stated in this License.  
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5. Submission of Contributions. Unless You explicitly state otherwise, any 

Contribution intentionally submitted for inclusion in the Work by You to the 

Licensor shall be under the terms and conditions of this License, without any 

additional terms or conditions. Notwithstanding the above, nothing herein shall 

supersede or modify the terms of any separate license agreement you may have 

executed with Licensor regarding such Contributions.  

6. Trademarks. This License does not grant permission to use the trade names, 

trademarks, service marks, or product names of the Licensor, except as required 

for reasonable and customary use in describing the origin of the Work and 

reproducing the content of the NOTICE file.  
 

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in 

writing, Licensor provides the Work (and each Contributor provides its 

Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS 

OF ANY KIND, either express or implied, including, without limitation, any 

warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or 

FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for 

determining the appropriateness of using or redistributing the Work and assume 

any risks associated with Your exercise of permissions under this License.  

8. Limitation of Liability. In no event and under no legal theory, whether in tort 

(including negligence), contract, or otherwise, unless required by applicable law 

(such as deliberate and grossly negligent acts) or agreed to in writing, shall any 

Contributor be liable to You for damages, including any direct, indirect, special, 

incidental, or consequential damages of any character arising as a result of this 

License or out of the use or inability to use the Work (including but not limited to 

damages for loss of goodwill, work stoppage, computer failure or malfunction, or 

any and all other commercial damages or losses), even if such Contributor has 

been advised of the possibility of such damages.  
 

9. Accepting Warranty or Additional Liability. While redistributing the Work or 

Derivative Works thereof, You may choose to offer, and charge a fee for, 

acceptance of support, warranty, indemnity, or other liability obligations and/or 

rights consistent with this License. However, in accepting such obligations, You 

may act only on Your own behalf and on Your sole responsibility, not on behalf of 

any other Contributor, and only if You agree to indemnify, defend, and hold each 

Contributor harmless for any liability incurred by, or claims asserted against, 

such Contributor by reason of your accepting any such warranty or additional 

liability.  
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Appendix B: Supported Metadata 

Integration Bridges 
 

Table of Supported Bridges 

The following table lists the Meta Integration Technology, Inc. (6.0.5) bridges 

that are currently available in CA ERwin DM (as of r7.3.8 SP2): 

 

Application Mode 

Altova XMLSpy Export 

Borland Together (via UML 1.x XMI) Export 

Borland Together (via UML 2.x XMI) Import 

CA Component Modeler 3.52 (ParadigmPlus) Import/Export 

CA Component Modeler 4.x (via UML 1.x XMI) Import/Export 

CA Cool:Biz 5.1 Import 

CA Cool:BusinessTeam (GroundWorks) 2.2.1 Import 

CA Cool:DBA (Terrain for DB2) 5.3.2 Import 

CA Cool:Enterprise (ADW) 2.7 Import 

CA Cool:Xtras Mapper (TerrainMap for DB2) Import 

CA ERwin 3.x (ERX) Import/Export 

CA Gen 4.1a to 7.6 Import/Export 

CA Repository for Distributed Systems Import/Export 

CA Repository for z/OS Import/Export 

Cobol Copybook Flat Files Import 

Composite Software Composite Studio (MIR XMI) Export 

Database data definition language (DDL) Export 

Embarcadero Describe (via UML 1.x XMI) Import/Export 

Embarcadero ER/Studio Business Architect(via DM1) Import/Export 

Embarcadero ER/Studio Data Architect Import/Export 

EMC ProActivity 3.x & 4.0 Import 
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Application Mode 

Gentleware Poseidon (via UML 1.x XMI) Import/Export 

Grandite Silverrun-RDM 2.4.4 to 2.7.2 Import 

HP Knightsbridge CDMA Export 

IBM Cognos 8 BI Reporting - Framework Manager Import/Export 

IBM Cognos 8 BI Reporting - Framework Manager for ReportNet Import/Export 

IBM Cognos 8 BI Reporting - QueryStudio Import 

IBM Cognos 8 BI Reporting - ReportStudio Import 

IBM Cognos Series 7 Impromptu Export 

IBM DB2 Warehouse Manager (via CWM XMI) Import/Export 

IBM InfoSphere DataStage Import/Export 

IBM InfoSphere Warehouse / Cubing Services for OLAP Import/Export 

IBM InfoSphere Warehouse / InfoSphere Data Architect Import/Export 

IBM InfoSphere Data Architect Import/Export 

IBM Rational Rose 4.0 Import/Export 

IBM Rational Rose 6.0 (98i) to 6.5 (2000) Import/Export 

IBM Rational Rose 7.x (2000e and newer) Import/Export 

IBM Rational Rose XDE Developer (Rose MDL) Export 

IBM Rational Software Architect (RSA) (Rose MDL) Export 

IBM Rational Software Architect (RSA) (via UML 2.x XMI) Import 

IBM Rational Software Modeler RSM (Rose MDL) Export 

IBM Rational System Architect 7.1 to 11.x (File) Import/Export 

IBM Rational System Architect 10.4 to 11.x (Encyclopedia) Import/Export 

IBM Telelogic Tau (via UML 1.x XMI) Import/Export 

Informatica Data Analyzer Export 

Informatica Developer - Beta bridge Import/Export 

Informatica Metadata Manager Export 

Informatica Metadata Manager (MIR XMI) Export 

Informatica PowerCenter Export 

Informatica PowerCenter (File) Import 

IRI CoSORT (RowGen) Data Definition File Export 
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Application Mode 

IRI CoSORT (SortCL) Data Definition File Export 

Kalido DIW Import 

Meta Integration Repository (MIR) Transformations to Views XMI file Export 

Meta Integration Repository (MIR) XMI file Import/Export 

Meta Integration Repository (MIR) XMI multimodel content Import/Export 

Microsoft Office Excel Import/Export 

Microsoft Office Visio Database (ERX) Import/Export 

Microsoft Office Visio UML (UML XMI) Import 

Microsoft SQL Server Analysis Services (via DSV File) Import/Export 

Microsoft SQL Server Analysis Services 2005 to 2008 (File) Import 

Microsoft SQL Server Data Source View Import/Export 

Microsoft SQL Server Integration Services Export 

Microsoft SQL Server Integration Services (via DSV File) Import/Export 

Microsoft SQL Server Integration Services (Project) Export 

Microsoft SQL Server Integration Services (File) Import 

Microsoft SQL Server Reporting Services (File) Import 

Microsoft SQL Server Repository 2.1b (XIF) Import/Export 

Microsoft SQL Server Repository 3.x (MDC) Import/Export 

Microsoft SQL Server XML Data Reduced (XDR) Schema Import 

Microsoft Visual Studio/Modeler 2.0 (MDL) Import/Export 

NoMagic MagicDraw (via UML 1.x XMI) Import/Export 

OMG CWM 1.x XMI 1.x Import/Export 

OMG CWM Pre-1.0 XMI 1.1 Import/Export 

OMG UML 1.x XMI 1.x Import/Export 

OMG UML 2.x XMI 2.x Import 

Open Text eDOCS Data Integration (Hummingbird) Genio Import/Export 

Oracle Business Intelligence Answers Import 

Oracle Business Intelligence Enterprise Edition Import 

Oracle Business Intelligence Server Import 

Oracle Data Integrator Import/Export 
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Application Mode 

Oracle Designer Import/Export 

Oracle Hyperion Application Builder (via CWM XMI) Import/Export 

Oracle Hyperion Essbase Integration Services Import/Export 

Oracle Warehouse Builder Import/Export 

Oracle Warehouse Builder (via CWM XMI) Import/Export 

SAP BusinessObjects Crystal Reports XI (File) Import 

SAP BusinessObjects Data Integrator Import/Export 

SAP BusinessObjects Designer (File) Import/Export 

SAP BusinessObjects Desktop Intelligence (File) Import 

SAP BusinessObjects Metadata Manager (via MIR XMI) Export 

SAP NetWeaver Master Data Management (MDM) Import/Export 

SAS Data Integration Studio (via CWM XMI) Import/Export 

SAS Data Integration Studio (via MIR XMI) Import/Export 

SAS Information Map Studio (via MIR XMI) Import/Export 

SAS Management Console (via MIR XMI) Import/Export 

SAS Metadata Management (via MIR XMI) Import 

Select SE Import 

Sparx Enterprise Architect (EA) (via UML 1.x XMI) Import/Export 

Sparx Enterprise Architect (EA) (via UML 2.x XMI) Import 

Sybase PowerDesigner 7.0 (ERX) Export 

Sybase PowerDesigner CDM 6.x Import 

Sybase PowerDesigner CDM 7.5 to 15.x Import 

Sybase PowerDesigner CDM 8.0 to 15.x Export 

Sybase PowerDesigner OOM 9.x to 15.x (via UML 1.x XMI) Import/Export 

Sybase PowerDesigner PDM 6.1.x Import 

Sybase PowerDesigner PDM 7.5 to 15.x Import 

Sybase PowerDesigner PDM 8.x to 15.x Export 

Sybase PowerDesigner XSM 10.x to 15.x Export 

Tigris ArgoUML (via UML 1.x XMI) Import/Export 

Visible IE:Advantage 6.1 Import 
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Application Mode 

W3C XML DTD 1.0 Import 

W3C XML Schema 1.0 (XSD) Import/Export 

For information on how to use the metadata integration wizards, see the CA 

ERwin DM online help. 
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Index 
 

A 

action log 

action summary reports • 72 

details pane • 60 

find text • 63 

metamodel filter • 64 

overview • 59 

redo a transaction • 67 

redo to a selected transaction • 68 

report • 71 

reverse a transaction • 67 

shortcut menu • 62 

summary pane • 61 

tasks • 62 

undo a transaction • 67 

undo to a selected transaction • 68 

use extended find and filter • 65 

view property details • 66 

action summary reports 

action log • 72 

advisories pane • 47 

alter scripts 

schema generation • 107 

alter scripts, complete compare • 139 

alternate key index • 97 

attributes 

add • 27 

defined • 21 

C 

columns, defined • 21 

complete compare 

alter scripts • 139 

filter selection • 125 

identify differences • 136 

identify matches • 136 

known differences snapshot • 137 

model saving • 140 

model selection • 121 

object selection • 125 

option set customization • 141 

overview • 120 

properties selection • 125 

report • 144 

resolve differences • 130, 136 

session save • 143 

wizard • 121 

D 

data warehouse hierarchy • 178 

datatype 

assign • 80 

datatype mapping file (.dsm) • 198 

datatype mapping list • 197 

datatype mapping standards 

attach file to a model • 199 

define • 199 

reuse • 200 

datatype standards 

editor • 197 

overview • 196 

datatype standards editor 

datatype mapping list • 197, 199 

save datatype mapping file • 198 

default fonts & colors dialog • 30 

dependent entities • 20 

derive new model 

process • 179 

wizard • 179 

design layer 

conceptual logical data model • 176 

create, overview • 178 

database-specific physical data model • 177 

first design layer • 176 

generic physical data model • 176 

overview • 175 

second design layer • 176 

third design layer • 177 

working with • 176 

details pane 

action log • 60 

differences, identify in complete compare • 136 

display levels 

create stored display • 92 

logical display • 88 

overview • 88 

physical display • 90 

display options 

overview • 91 

domain 

create • 80 
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datatype • 80 

icons • 81 

inheritable properties • 79 

non-inheritable properties • 79 

overview • 77 

domain dictionary 

overview • 78 

E 

enterprise model hierarchy • 177 

entities 

add • 26 

defined • 19 

dependent • 20 

independent • 20 

name • 26 

entity relationships • 82 

export to external format • 118 

extended find and filter 

action log • 65 

F 

find and replace • 101 

find, extended and filter • 65 

first design layer • 176 

footers and headers, customize • 38 

foreign key • 22 

foreign key index • 97 

forward engineering 

change schema generation • 104 

generate the schema • 106 

overview • 102 

preview schema generation • 103 

schema generation options • 105 

H 

headers and footers, customize • 38 

hierarchy 

data warehouse • 178 

enterprise model • 177 

history, preserving model • 187 

I 

import from external format • 116 

independent entities • 20 

index types 

alternate key • 97 

foreign key • 97 

inversion entry key • 97 

primary key • 97 

indexes 

create • 99, 100 

editor • 99 

non-unique • 98 

overview • 96 

unique • 98 

inheritable properties, domains • 79 

Installation 

license agreement • 15 

prerequisites • 14 

procedure • 15 

inversion entry key index • 97 

K 

key 

foreign • 22 

non-key • 22 

primary • 22 

L 

license agreement • 15 

logical model • 18 

logical/physical model • 18 

M 

matches, identify in complete compare • 136 

metadata integration • 115 

model 

create • 25 

name • 25 

print • 36 

save • 29 

model datatype options dialog • 199 

model explorer 

add domain, overview • 54 

add model source, overview • 55 

copy objects • 54 

create a new object • 52 

delete objects • 54 

go to an object • 53 

model view • 56 

move objects • 54 

overview • 48 

property editor • 53 

rename an object • 52 

shortcut menu • 51 

subject view • 56 

toolbar • 51 
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transform • 186 

model history, preserving • 187 

model naming options dialog • 189 

model selection, complete compare • 121 

model source 

add, overview • 55, 180 

defined • 180 

link • 181 

properties • 181 

sync with model source wizard • 182 

model types 

logical • 18 

logical/physical • 18 

physical • 18 

model view 

model explorer • 56 

N 

naming standards 

define • 189 

editor • 190 

name compliance • 192 

name hardening • 193 

object name syntax • 191 

overview • 189 

non-inheritable properties, domains • 79 

non-key • 22 

non-unique index • 98 

O 

option set, customize in complete compare • 

141 

P 

physical model • 18 

primary key • 22 

primary key index • 97 

print 

customize headers and footers • 38 

model • 36 

set margins • 38 

property details 

action log • 66 

property editor • 53 

R 

redo a transaction 

action log • 67 

redo to a selected transaction 

action log • 68 

exercise • 70 

redo to this point 

exercise • 70 

relationship types 

identifying • 24 

non-identifying • 24 

other • 83 

relationships • 23, 81 

create • 28 

create, overview • 84 

entity • 82 

foreign key • 85 

lines, overview • 84 

rolenames • 86 

unification • 85 

report 

action log • 71 

action summary • 72 

complete compare • 144 

generate, report template builder • 151 

report template builder • 145 

report templates dialog • 145 

with Crystal Reports • 174 

report template builder 

dialog • 147 

export format • 147 

generate • 151 

new report • 147 

overview • 145 

preferences • 150 

report columns • 148 

report sections • 148 

report title • 147 

section properties • 150 

table properties • 150 

report templates dialog • 146 

resolve a transform • 187 

resolve differences 

complete compare • 136 

dialog • 130 

reverse a transaction 

action log • 67 

reverse a transform • 187 

reverse engineering 

overview • 109 

set options • 111 

templates • 111 

rolenames • 86 
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schema generation 

change • 104 

generate alter scripts • 107 

options • 105 

preview • 103 

procedure • 106 

script file, save • 107 

second design layer • 176 

select tool • 32 

shortcut menu 

action log • 62 

model explorer • 51 

source object, transform • 186 

spanning neighborhoods, subject area • 95 

split logical/physical model 

procedure • 178 

standards 

datatype • 196 

subject areas 

create, overview • 94 

overview • 93 

spanning neighborhoods • 95 

subject view 

model explorer • 56 

summary pane 

action log • 61 

T 

tables • 20 

target object, transform • 186 

third design layer • 177 

toolbar 

alignment • 33, 44 

drawing • 35, 43 

hide • 41 

model explorer • 51 

services • 45 

show • 41 

transform • 184 

toolbox • 46 

transform 

default options • 185 

design decision, defined • 183 

display source object • 186 

display target object • 186 

model explorer • 186 

name options • 186 

overview • 183 

resolve • 187 

results • 186 

reverse • 187 

toolbar • 184 

wizard, overview • 183 

U 

undo a transaction 

action log • 67 

undo to a selected transaction 

action log • 68 

exercise • 69 

undo/reverse comparison table • 70 

unification • 22 

unique index • 98 

unique name rules • 53 

V 

views 

adding • 88 

overview • 87 

W 

workplace panes • 46 
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